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１　はじめに

　絵画の歴史は古代から現代に至るまで，各時代の社会情
勢，価値観，科学技術の発展などを色濃く反映しながら変
遷してきた．例えば，ゴッホの『ひまわり』や葛飾北斎の

『富嶽三十六景』といった歴史的名画は，その巧みな色彩
によって，鑑賞者に力強さや儚さといった多様な感情を呼
び起こす．これは，色彩が視覚を通じて人の自律神経や内
分泌系に働きかけ，興奮や安らぎ，時には不快感や恐怖と
いった心理的効果を生み出すためであると考えられている
1),2),3)．
　人が絵画の色彩表現に明確な差異を感じるのは，異なる
作家，年代，地域の絵画を鑑賞した際である．こうした色
彩が与える印象は，これまで美術史家や評論家による豊か
な感性と言葉によって，深く魅力的に語られてきた．一方
で，科学的な視点から絵画の色彩を数値として捉え，その
特徴を比較する試みは，作品鑑賞に新たな発見をもたらす
可能性がある．感性的な解釈に定量的なデータを加えるこ
とで，画家の個性や様式の違いをこれまでとは異なる角度
から見ることができる 4)．
　そこで本研究では，画像解析ソフト「ImageJ」を用い

科学的なアプローチを用い，絵画の色彩情報を定量的に分
析・可視化することで，複数の絵画を客観的に比較・考察
することを目的とする．特に，西洋と日本の名画における
色彩分布の差異や，時代，画家による特徴を客観的なデー
タに基づいて明らかにすることを目指す． 

2　調査の背景

2.1　美術史における主観的評価の具体例
　美術史家や評論家による主観的評価が美術史に与える影
響はさまざまである．
　フランスのジャーナリストであるルイ・ルロワは，1874
年に開催された第一回印象派展でモネの作品タイトル「印
象，日の出」（図１）を揶揄し，当時の美術アカデミーの
緻密な写実性という基準から逸脱したモネの絵画的試みを
酷評した 5)．この際に侮蔑的な意味合いで使用された「印
象」という言葉が，のちに「印象派」6),7) の名称の由来となっ
た 8)．
　日本の民藝運動の創始者である柳宗悦は個人の作家が美
を意識して制作した美術品よりも，無名の職人が実用のた
めに作る日用品の中にこそ根源的な美が存在すると考えた
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　美術作品の評価は従来，鑑賞者の主観に委ねられることが多かった．本調査は，この主観的評価を補完する
客観的アプローチとして，オープンソースの画像解析ソフト「ImageJ」を用い，西洋と日本の歴史的名画に
おける色彩分布の定量的な比較分析を試みるものである．分析対象として作品制作の時期が比較的近いゴッホ，
モネ，葛飾北斎の三名の描いた作品 10 点を選定し，RGB 値の 3 次元プロット，加重平均を用いた統計的特徴
量の算出，暖色・寒色比率の算出，k-means クラスタリングによる主要色の抽出を行った．結果として，西洋
絵画では色彩が連続的に分布する一方，日本の浮世絵では複数のクラスタとして離散的に分布するという明確
な差異が確認された．この差異は，油彩と木版画という制作技法の違い，ひいては写実性と様式美をそれぞれ
追求した文化的背景を反映していると考察される．本調査は色彩の定量化が美術作品の客観的理解の一助とな
る可能性を示している．
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9)．柳の評価軸は作品の造形的な優劣や技術的な洗練度で
はなく「作り手の精神性」や「用途との結びつき」に重点
が置かれている．この独自の審美眼によって，これまで美
術として評価されてこなかった日用品に新たな価値を発見
し，民藝という文化を確立した．

 

2.2　絵画への科学的なアプローチ
　美術作品から受ける感動や印象を評論する伝統的な鑑賞
方法に対して，近年では，画像解析をはじめとする科学的
な手法を用いた作品分析が注目されている．これらは，絵
画の色彩を RGB 値といった客観的な数値データとしてと
らえるものである．また，情報科学や統計学の分野におい
ても同様に作品の分析が行われている．具体例として，小
林光夫による研究では，情報理論などを用いて絵画の色彩
構造を数理的に解析し，それが鑑賞者の感じる「色彩美」
にどう関連するかが探求されている 10)．色彩を定量化する
ことは，特定の画家が好んで用いる色の傾向や，異なる様
式間での色彩分布の違いなどを客観的視点で比較すること
を可能にする．本稿もこの考え方に基づき，伝統的な鑑賞
方法を否定するのではなく，新たな視点を加える一つの試
みとして，絵画の色彩分析を行うものである．

3　調査対象と分析手法

3.1　調査対象
　絵画の RGB 値を 3 次元空間にプロットするほか，HSV
色空間を用いて暖色・寒色の比率を算出し，k-means クラ
スタリングによって主要な色数を特定する手法を用いる．
本稿では，まず分析対象と手法を述べ，次にその分析結果
を示し，最後に美術史的背景と照らし合わせながら考察を
行う．調査対象とする絵画を以下の表 1 にまとめる．調査
対象はパブリックドメインのものを選定し，インターネッ
トからダウンロードする 11),12)．

　各絵画の内容は以下のとおりである．また，選定を行う
にあたり主観的な作品評価が含まれている．

≪フィンセント・ファン・ゴッホ≫
１．《夜のカフェテラス》（1888 年）（図 2）
　南仏アルルのプラス・デュ・フォルム広場に面するカフェ
を描いた作品．夜空の深い青色と人工光の眩い黄色の対比
が色彩の心理的効果を論じる上で適している．
２．《ひまわり》（1888 年）（図 3）
　ゴッホを代表する作品群．花瓶に挿されたひまわりは 7
点描かれている．単一色相の中に多様な明度・輝度・彩度
を駆使した表現が用いられている．
３．《星月夜》（1889 年）（図 4）
　サン＝レミ＝ド＝プロヴァンスの精神病棟で療養してい
た際に描かれた作品．夜のカフェテラスが静的な作品であ
るのに対して，この作品は動的な表現が多分に含まれてお
り，色彩表現に特徴がみられる．

≪クロード・モネ≫
１．《散歩，日傘をさす女性》（1875 年）（図 5）
　光の表現を探求したモネを代表する作品のうちの一つ．
同年の作品にラ・ジャポネーズがあるように日本文化への
リスペクトとある種の批判精神が混在する時期に描かれた
絵画．
２．《ルーアン大聖堂》（1892-1894 年）（図 6,7）
　連作より「朝の効果」「夕日」の 2 枚を取り上げる．同
じ対象を異なる時間帯で描いた作品から色彩構成を分析す
る．
３．《睡蓮と日本の橋》（1899 年）（図 8）
　モネのジャポニスムを直接的に示す作品の一つ．水面の
反射光や植物の色彩が豊かであり，他の作品と比較するう
えでの対象として優れている．

≪葛飾北斎≫
１．《神奈川沖浪裏》（1830-1834 年）（図 9）
　世界でもっとも有名な日本の絵画の一つ．ベロ藍（プル
シアンブルー）を大胆に用いた鮮やかで力強い青の階調が
最大の特徴として挙げられる．色彩が青系統に大きく偏る
ことが予想され，分析の基準点となる．
２．《凱風快晴》（1830-1834 年）（図 10）
　山肌の赤褐色と空の深青の対比が印象的な作品．神奈川
沖浪裏とは異なるカラーパレットのため，両者を比較する
ことで色彩表現の幅広さを示すことができる．
３．《駿州江尻》（1830-1834 年）（図 11）
　他の 2 作品よりも余白が多く用いられる色数も絞られた
ような印象を受ける作品．その少ない色数で細やかな草木
の表現を実現している．

 
 
 
 
 
 
 
 
 
 

 
Fig.1 Claude Monet “Impression, soleil levant” 
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が好んで用いる色の傾向や，異なる様式間での色
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各絵画の内容は以下のとおりである．また，選定
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上で適している． 
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の一つ．同年の作品にラ・ジャポネーズがあるよ
うに日本文化へのリスペクトとある種の批判精神
が混在する時期に書かれた絵画． 
２．《ルーアン大聖堂》(1892-1894 年)(図 6,7) 
 連作より「朝の効果」「夕日」の 2 枚を取り上
げる．同じ対象を異なる時間帯で描いた作品から
色彩構成を分析する． 
３．《睡蓮と日本の橋》(1899 年) (図 8) 
 モネのジャポニスムを直接的に示す作品の一つ．
水面の反射光や植物の色彩が豊かであり，他の作
品と比較するうえでの対象として優れている． 
 
<葛飾北斎> 
１．《神奈川沖浪裏》(1830-1834 年)(図 9) 
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強い青の階調が最大の特徴として挙げられる．色
彩が青系統に大きく偏ることが予想され，分析の
基準点となる． 
２．《凱風快晴》(1830-1834 年)(図 10) 
 山肌の赤褐色と空の深青の対比が印象的な作品．
神奈川沖浪裏とは異なるカラーパレットのため，
両者を比較することで色彩表現の幅広さを示すこ
とができる． 
３．《駿州江尻》(1830-1834 年)(図 11) 
 他の 2 作品よりも余白が多く用いられる色数も
絞られたような印象を受ける作品．その少ない色
数で細やかな草木の表現を実現している． 
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Fig.2 Vincent Williem van Gogh 
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Fig.3 Vincent Williem van Gogh  

“Zonnebloemen” 11) 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig.4 Vincent Williem van Gogh  
“De sterrennacht” 11) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.5 Claude Monet 

“La Promenade, la femme à l'ombrelle” 12) 
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Fig.10 葛飾北斎 

“凱風快晴” 11) 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.11 葛飾北斎 

“駿州江尻” 11) 
 
3.2 分析環境 
 本調査における画像解析は，以下の環境で実施
した．各ソフトウェアのバージョンは分析実施時
点のものである． 
<ハードウェアスペック> 
・CPU: Intel(R) Core(TM) i7-9700 CPU @3.00GHz 
・メモリ: 64GB 
・GPU: NVIDIA Quadro P2200 
<オペレーティングシステム> 
・Windows 10 Pro 
<主要ソフトウェア> 
・ImageJ 1.54p 17 February 2025 
・MATLAB R2023b 
<使用プラグイン> 
・Color Inspector 3D 
 
3.3 分析手法 
 本調査で行った画像解析のプロセスを示す． 
・前処理 
 絵画の分析範囲を定義する．本調査では額縁を
含めない絵画全体を分析範囲とする．具体的な手

順は以下の通りとなっている． 
 
1．ImageJ を起動する． 
2．タブから File > Open から調査対象の画像を選
択する． 
3．タブの下部から範囲選択ツールを用いて画像
の分析範囲を選択する． 
4．タブから Edit > Clear Outside を選択し分析範囲
を切り抜く． 
 
・色彩分析 
 色彩分析を行うにあたり，本調査ではプラグイ
ン頒布サイトから Color Inspector 3D と IJ Toolkitを
インストールして使用する．導入方法は以下の通
りとなっている． 
 
1． ImageJ のプラグイン頒布サイトから Color 
Inspector 3D と IJ Toolkit をダウンロードする． 
2．エクスプローラー内に保存されている ImageJ
のフォルダを開く． 
3．ダウンロードしたColor Inspector 3Dと IJ Toolkit
を ImageJ > Plugins フォルダに移動する． 
4．ImageJ 内で Color Inspector 3D と IJ Toolkit が使
用可能か確認する． 
 

色彩分析に必要な画像の取得方法の具体的な手
順は以下の通りとなっている． 
 
1．前処理を行う． 
2．タブから Plugins > Analyze > Color Inspector 3D
を選択する． 
3．Color Inspector 3D が起動する． 
4．Color Space を RGB に変更する．(起動時は自動
的に RGB 値の三次元プロット画面が開く) 
5．Display Modeを All Colors から Histogramに変更
する． 
6． File > Save Visualization で三次元プロット画像
と LUT リストを保存する． 
7．Color Space を HSV に変更する． 
8．File > Save Visualization で三次元プロット画像
と LUTリストを保存する．(Color Inspector 3Dでの
作業は終了) 
9．Plugins > Segmentation > k-means Clusteringを選
択する． 
10．k-means clustering の詳細設定を行う 

・Number of clusters ：3 
・Cluster center tolerance：0.00100 
・Interpret stack as 3D：blank 
・Enable randomization seed：check 
・Randomization seed：48 
・Show clusters as centroid value：check 
・Enable clustering animation：blank 
・Print optimization trace：blank 
・Send to results table：check 

11．詳細設定の後に ok を選択 
12．クラスタリングされた画像，重心値で色付け

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.6 Claude Monet 

“Rouen Cathedral Façade and Tour d'Albane 
(Morning Effect)” 12) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

 
Fig.7 Claude Monet 

“Rouen Cathedral, Facade (sunset), harmonie in 
gold and blue” 12) 
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“Le bassin aux nympheas” 12) 
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3.2　分析環境
　本調査における画像解析は，以下の環境で実施した．各
ソフトウェアのバージョンは分析実施時点のものである．
< ハードウェアスペック >
　・CPU: Intel（R）Core（TM）i7-9700 CPU @3.00GHz
　・メモリ : 64GB
　・GPU: NVIDIA Quadro P2200
< オペレーティングシステム >
　・Windows 10 Pro
< 主要ソフトウェア >
　・ImageJ 1.54p 17 February 2025
　・MATLAB R2023b
< 使用プラグイン >
　・Color Inspector 3D

3.3　分析手法
　本調査で行った画像解析のプロセスを示す．
・前処理
　絵画の分析範囲を定義する．本調査では額縁を含めない

絵画全体を分析範囲とする．具体的な手順は以下の通りと
なっている．

1．ImageJ を起動する．
2．タブから File > Open から調査対象の画像を選択する．
3．タブの下部から範囲選択ツールを用いて画像の分析範
囲を選択する．
4．タブから Edit > Clear Outside を選択し分析範囲を切
り抜く．

・色彩分析
　色彩分析を行うにあたり，本調査ではプラグイン頒布サ
イトから Color Inspector 3D と IJ Toolkit をインストール
して使用する．導入方法は以下の通りとなっている．

1．ImageJ のプラグイン頒布サイトから Color Inspector 
3D と IJ Toolkit をダウンロードする．
2．エクスプローラー内に保存されている ImageJ のフォ
ルダを開く．
3．ダウンロードした Color Inspector 3D と IJ Toolkit を
ImageJ > Plugins フォルダに移動する．
4．ImageJ 内で Color Inspector 3D と IJ Toolkit が使用可
能か確認する．

　色彩分析に必要な画像の取得方法の具体的な手順は以下
の通りとなっている．

1．前処理を行う．
2．タブから Plugins > Analyze > Color Inspector 3D を
選択する．
3．Color Inspector 3D が起動する．
4．Color Space を RGB に変更する．（起動時は自動的に
RGB 値の三次元プロット画面が開く）
5．Display ModeをAll Colors から Histogramに変更する．
6． File > Save Visualization で三次元プロット画像と
LUT リストを保存する．
7．Color Space を HSV に変更する．
8．File > Save Visualization で三次元プロット画像と
LUT リストを保存する．（Color Inspector 3D での作業は
終了）
9．Plugins > Segmentation > k-means Clustering を選択
する．
10．k-means clustering の詳細設定を行う .
　・Number of clusters ：3
　・Cluster center tolerance：0.00100
　・Interpret stack as 3D：blank
　・Enable randomization seed：check
　・Randomization seed：48
　・Show clusters as centroid value：check
　・Enable clustering animation：blank
　・Print optimization trace：blank
　・Send to results table：check
11．詳細設定の後に ok を選択

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
Fig.10 葛飾北斎 

“凱風快晴” 11) 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.11 葛飾北斎 

“駿州江尻” 11) 
 
3.2 分析環境 
 本調査における画像解析は，以下の環境で実施
した．各ソフトウェアのバージョンは分析実施時
点のものである． 
<ハードウェアスペック> 
・CPU: Intel(R) Core(TM) i7-9700 CPU @3.00GHz 
・メモリ: 64GB 
・GPU: NVIDIA Quadro P2200 
<オペレーティングシステム> 
・Windows 10 Pro 
<主要ソフトウェア> 
・ImageJ 1.54p 17 February 2025 
・MATLAB R2023b 
<使用プラグイン> 
・Color Inspector 3D 
 
3.3 分析手法 
 本調査で行った画像解析のプロセスを示す． 
・前処理 
 絵画の分析範囲を定義する．本調査では額縁を
含めない絵画全体を分析範囲とする．具体的な手

順は以下の通りとなっている． 
 
1．ImageJ を起動する． 
2．タブから File > Open から調査対象の画像を選
択する． 
3．タブの下部から範囲選択ツールを用いて画像
の分析範囲を選択する． 
4．タブから Edit > Clear Outside を選択し分析範囲
を切り抜く． 
 
・色彩分析 
 色彩分析を行うにあたり，本調査ではプラグイ
ン頒布サイトから Color Inspector 3D と IJ Toolkitを
インストールして使用する．導入方法は以下の通
りとなっている． 
 
1． ImageJ のプラグイン頒布サイトから Color 
Inspector 3D と IJ Toolkit をダウンロードする． 
2．エクスプローラー内に保存されている ImageJ
のフォルダを開く． 
3．ダウンロードしたColor Inspector 3Dと IJ Toolkit
を ImageJ > Plugins フォルダに移動する． 
4．ImageJ 内で Color Inspector 3D と IJ Toolkit が使
用可能か確認する． 
 

色彩分析に必要な画像の取得方法の具体的な手
順は以下の通りとなっている． 
 
1．前処理を行う． 
2．タブから Plugins > Analyze > Color Inspector 3D
を選択する． 
3．Color Inspector 3D が起動する． 
4．Color Space を RGB に変更する．(起動時は自動
的に RGB 値の三次元プロット画面が開く) 
5．Display Modeを All Colors から Histogramに変更
する． 
6． File > Save Visualization で三次元プロット画像
と LUT リストを保存する． 
7．Color Space を HSV に変更する． 
8．File > Save Visualization で三次元プロット画像
と LUTリストを保存する．(Color Inspector 3Dでの
作業は終了) 
9．Plugins > Segmentation > k-means Clusteringを選
択する． 
10．k-means clustering の詳細設定を行う 

・Number of clusters ：3 
・Cluster center tolerance：0.00100 
・Interpret stack as 3D：blank 
・Enable randomization seed：check 
・Randomization seed：48 
・Show clusters as centroid value：check 
・Enable clustering animation：blank 
・Print optimization trace：blank 
・Send to results table：check 

11．詳細設定の後に ok を選択 
12．クラスタリングされた画像，重心値で色付け

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.6 Claude Monet 

“Rouen Cathedral Façade and Tour d'Albane 
(Morning Effect)” 12) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

 
Fig.7 Claude Monet 

“Rouen Cathedral, Facade (sunset), harmonie in 
gold and blue” 12) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig.8 Claude Monet 

“Le bassin aux nympheas” 12) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Fig.9 葛飾北斎 
“神奈川沖浪裏” 11) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5ImageJ を用いた特定画像の色彩分布についての調査・考察



12．クラスタリングされた画像，重心値で色付けされた画
像（クラスタリングされた画像の LUT を編集することで
も同様の画像が得られる），各クラスタの RGB 値の結果
のテーブルが表示される．
13．各画像，テーブルを保存する．
14．各クラスタの構成比率を得るためにタブから Analyze 
> Histogram を選択
15．表示された Window から List を選択
16．Value と Count の値をそれぞれ各クラスタの RGB 値
の結果のテーブルに貼り付け保存する．

　以上の手順で色彩分析に使用するすべての画像が用意で
きる．
　RGB データから各色の出現頻度を重みとした RGB 成分
の加重平均値と荷重標準偏差を算出する．加重平均値は，
通常の平均値と異なり，数値の重要度や影響度を加味して
算出する平均値である．今回の分析では，各色の RGB 値
の出現頻度（ピクセル数）として計算する．加重平均値は，

（RGB の値 × その色の頻度）の合計を，すべての色の頻
度の合計で割ることで求められる．

　加重標準偏差は，色のばらつき具合を示す指標である．
加重平均値と同様に各色の出現頻度を重みとして計算す
る．加重分散の平方根を採ることで算出できる．

　HSV データから暖色，寒色，中性色の割合を取得する
た め に MATLAB を 用 い た デ ー タ 処 理 を 行 う．Color 
Inspector 3D から保存できる LUT リストは，色彩の構成
比率が小数点を切り捨てた数値で記録される．そのため，
暖色，寒色，中性色の構成比率を合計した値が 100% より
も小さくなる．本調査においては，この元データの丸め誤
差を問題ないものと判断する．使用したコードは付録に掲
載する．

4　結果

4.1　色彩分布の可視化
　各分析対象作品から抽出した全ピクセルの RGB 値を 3
次元空間にプロットした結果を，図 12 から図 21 に示す．
図の各点は個々のピクセルに対応し，原点（0, 0, 0）が黒，
対角線上の最も遠い点（255, 255, 255）が白を示す．各分
析対象作品の加重平均値，荷重標準偏差，RGB の最大値，
最小値を表 2 から表 11 に示す．

4.1.1　ゴッホ《夜のカフェテラス》（図 2）
・結果

・考察
　加重平均値をみると，R の値が最も高く，次いで G が
高く，B が最も低い．この組み合わせは黄色やオレンジ色
を示しており，全体の色彩の中心的傾向であることを意味
している．加重平均値がいずれも 128 よりも低いことから，
全体としては明るい色よりも暗い色が多い構成となってい
る．標準偏差が大きいため，色に多様性が見られる．純色
に近い鮮やかな色彩の頻度は低いことが読み取れる．

4.1.2　ゴッホ《ひまわり》（図 3）
・結果

された画像(クラスタリングされた画像の LUT を
編集することでも同様の画像が得られる)，各クラ
スタの RGB 値の結果のテーブルが表示される． 
13．各画像，テーブルを保存する． 
14．各クラスタの構成比率を得るためにタブから
Analyze > Histogramを選択 
15．表示された Windowから List を選択 
16．Value と Count の値をそれぞれ各クラスタの
RGB 値の結果のテーブルに貼り付け保存する． 
 
 
 以上の手順で色彩分析に使用するすべての画像
が用意できる． 

RGB データから各色の出現頻度を重みとした
RGB 成分の加重平均値と荷重標準偏差を算出する．
加重平均値は，通常の平均値と異なり，数値の重
要度や影響度を加味して算出する平均値である．
今回の分析では，各色の RGB 値の出現頻度(ピク
セル数)として計算する．加重平均値は，（RGB
の値 × その色の頻度）の合計を，すべての色の頻
度の合計で割ることで求められる． 

 

𝑥̅𝑥� = ∑ (𝑥𝑥� ∙ 𝜔𝜔�)����
∑ 𝜔𝜔��
���

 (1) 

 
𝑁𝑁：色の種類の総数(csv ファイルの行数) 
𝑥𝑥�：𝑖𝑖番目の色の RGB の値 
𝜔𝜔�：𝑖𝑖番目の色の出現頻度 
 
加重標準偏差は，色のばらつき具合を示す指標

である．加重平均値と同様に各色の出現頻度を重
みとして計算する．加重分散の平方根を採ること
で算出できる． 
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∑ 𝜔𝜔� ∙ (𝑥𝑥� − 𝑥̅𝑥�)�����
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 (2) 

 
𝑥̅𝑥�：加重平均値 
𝑥𝑥�：𝑖𝑖番目の色の RGB の値 
𝜔𝜔�：𝑖𝑖番目の色の出現頻度 
 

𝜎𝜎� = �𝜎𝜎��  (3) 
 

HSV データから暖色，寒色，中性色の割合を取
得するためにMATLABを用いたデータ処理を行う．
Color Inspector 3D から保存できる LUT リストは，
色彩の構成比率が小数点を切り捨てた数値で記録
される．そのため，暖色，寒色，中性色の構成比
率を合計した値が100%よりも小さくなる．本調査
においては，この元データの丸め誤差を問題ない
ものと判断する．使用したコードは付録に掲載す
る． 
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255)が白を示す．各分析対象作品の加重平均値，
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表 11 に示す． 
 
4.1.1 ゴッホ《夜のカフェテラス》(図 2) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.12 “Cafeterras bij nacht” RGB Space 

 
Table 2 “Cafeterras bij nacht” Statistics 

 R G B 
加重平均値 105.71 106.71 87.507 
加重標準偏差 58.186 45.805 54.305 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
加重平均値をみると，R の値が最も高く，次い

で G が高く，B が最も低い．この組み合わせは黄
色やオレンジ色を示しており，全体の色彩の中心
的傾向であることを意味している．加重平均値が
いずれも 128 よりも低いことから，全体としては
明るい色よりも暗い色が多い構成となっている．
標準偏差が大きいため，色に多様性が見られる．
純色に近い鮮やかな色彩の頻度は低いことが読み
取れる． 

 
4.1.2 ゴッホ《ひまわり》(図 3) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.13 “Zonnebloemen” RGB Space 

された画像(クラスタリングされた画像の LUT を
編集することでも同様の画像が得られる)，各クラ
スタの RGB 値の結果のテーブルが表示される． 
13．各画像，テーブルを保存する． 
14．各クラスタの構成比率を得るためにタブから
Analyze > Histogramを選択 
15．表示された Windowから List を選択 
16．Value と Count の値をそれぞれ各クラスタの
RGB 値の結果のテーブルに貼り付け保存する． 
 
 
 以上の手順で色彩分析に使用するすべての画像
が用意できる． 

RGB データから各色の出現頻度を重みとした
RGB 成分の加重平均値と荷重標準偏差を算出する．
加重平均値は，通常の平均値と異なり，数値の重
要度や影響度を加味して算出する平均値である．
今回の分析では，各色の RGB 値の出現頻度(ピク
セル数)として計算する．加重平均値は，（RGB
の値 × その色の頻度）の合計を，すべての色の頻
度の合計で割ることで求められる． 

 

𝑥̅𝑥� = ∑ (𝑥𝑥� ∙ 𝜔𝜔�)����
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 (1) 

 
𝑁𝑁：色の種類の総数(csv ファイルの行数) 
𝑥𝑥�：𝑖𝑖番目の色の RGB の値 
𝜔𝜔�：𝑖𝑖番目の色の出現頻度 
 
加重標準偏差は，色のばらつき具合を示す指標

である．加重平均値と同様に各色の出現頻度を重
みとして計算する．加重分散の平方根を採ること
で算出できる． 
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𝑥̅𝑥�：加重平均値 
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・考察
　加重平均値から，茶色，オレンジ，黄色といった暖色系
の色が中心的なトーンを形成していることが読み取れる．
RGB プロットからも R の領域に偏った分布が見て取れる．
加重標準偏差が R,G,B ともに 40 前後と小さい値である．
これは，使用されている色の範囲が狭く，似たような色調
の色が多くを占めていることを示す．

4.1.3　ゴッホ《星月夜》（図 4）
・結果

・考察
　加重平均値を見ると，B,G,R の順で低くなっている．こ
の関係性は，画像の中心的な色合いが青色やシアンである
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7ImageJ を用いた特定画像の色彩分布についての調査・考察



・考察
　《朝の効果》
　�　加重平均値は B の値が突出して高くなっている．絵

画全体が青色，紫色が中心的かつ支配的な色であると読
み取れる．加重平均値がいずれも 128 前後，もしくはそ
れ以上であることから全体的に明るい描写だと分かる．
加重標準偏差は加重平均値とは異なり B の値が 36.1 と
最も低い．絵画全体が青色を主体とした基調であるにも
かかわらず，その青色の種類は少なく，均一で単調であ
ることがわかる．一方，R の値が 63.6 と最も高く，絵
画の明暗を赤色成分が決定していることを示唆してい
る．つまり，赤色成分のコントラストが非常に強い絵画
であるといえる．

《夕日》
　�　加重平均値は R の値が突出している．赤，オレンジ，

茶色といった暖色系が中心的な絵画であることがわか
る．加重標準偏差はいずれも 40 から 50 台の値となって
おり，大きなばらつきがなく RGB 値のバランスが取れ
た自然なコントラストを持つことが示されている．

　�　二つの絵画は色彩の観点から見て対照的だといえる．
プロットからもわかる通り，朝の効果は青色主体，夕日
はオレンジ主体の色彩となっており，色相環の正反対に
位置する関係性を持っている．両者とも加重平均値が
128 を上回る成分が多いことから共通して明るいシーン

が描写されていることがわかる．朝の効果は主体の色の
多様性が極端に低く，赤色のコントラストが高い色彩構
成であるのに対し，夕日は全ての色が均等にばらつきを
持っており，調和のとれた色彩構成となっている．連作
という形態をもつルーアン大聖堂を制作するにあたり，
クロード・モネが風景に合わせて色彩構成を変化させて
いたことが考えられる．

4.1.6　モネ《睡蓮と日本の橋》（図 8）
・結果

・考察
　加重平均値は G の値が最も高く，次いで R，B の順で
数値が高い．この関係性から，オリーブグリーンや黄緑色，
茶色がかった緑色が絵画の中心的傾向であることが読み取
れる．加重平均値がいずれも 128 より低いことから，全体
が暗めのトーンで構成されていることがわかる．加重標準
偏差から青色成分が比較的均一であり，赤色成分が絵画の
陰影，質感，ディテールを担っていることが読み取れる．

4.1.7　葛飾北斎《神奈川沖浪裏》（図 9）
・結果

Table 6 “Rouen Cathedral Façade and Tour d'Albane 
(Morning Effect)” Statistics 

 R G B 
加重平均値 125.5 142.48 175.17 
加重標準偏差 63.606 50.74 36.07 
最小値 8 8 8 
最大値 248 248 248 

 
 
 
 
 
 
 
 
 
 
 

 
Fig.17 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” RGB Space 
 

Table 7 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue” Statistics 

 R G B 
加重平均値 165.39 137.89 94.797 
加重標準偏差 50.987 43.391 44.871 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 《朝の効果》 
  加重平均値は B の値が突出して高くなってい
る．絵画全体が青色，紫色が中心的かつ支配的
な色であると読み取れる．加重平均値がいずれ
も 128 前後，もしくはそれ以上であることから
全体的に明るい描写だと分かる．加重標準偏差
は加重平均値とは異なり B の値が 36.1 と最も低
い．絵画全体が青色を主体とした基調であるに
もかかわらず，その青色の種類は少なく，均一
で単調であることがわかる．一方，R の値が
63.6 と最も高く，絵画の明暗を赤色成分が決定
していることを示唆している．つまり，赤色成
分のコントラストが非常に強い絵画であるとい
える． 

《夕日》 
  加重平均値は R の値が突出している．赤，オ
レンジ，茶色といった暖色系が中心的な絵画で
あることがわかる．加重標準偏差はいずれも 40
から 50 台の値となっており，大きなばらつきが
なく RGB値のバランスが取れた自然なコントラ
ストを持つことが示されている． 

  二つの絵画は色彩の観点から見て対照的だと
いえる．プロットからもわかる通り，朝の効果
は青色主体，夕日はオレンジ主体の色彩となっ

ており，色相環の正反対に位置する関係性を持
っている．両社とも加重平均値が 128 を上回る
成分が多いことから共通して明るいシーンが描
写されていることがわかる．朝の効果は主体の
色の多様性が極端に低く，赤色のコントラスト
が高い色彩構成であるのに対し，夕日は全ての
色が均等にばらつきを持っており，調和のとれ
た色彩構成となっている．連作という形態をも
つルーアン大聖堂を制作するにあたり，クロー
ド・モネが風景に合わせて色彩構成を変化させ
ていたことが考えられる． 

 
4.1.6 モネ《睡蓮と日本の橋》(図 8) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.18 “Le bassin aux nympheas” RGB Space 

 
Table 8 “Le bassin aux nympheas” Statistics 

 R G B 
加重平均値 97.468 108.89 71.829 
加重標準偏差 54.343 50.21 43.352 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
加重平均値は G の値が最も高く，次いで R，B

の順で数値が高い．この関係性から，オリーブグ
リーンや黄緑色，茶色がかった緑色が絵画の中心
的傾向であることが読み取れる．加重平均値がい
ずれも 128 より低いことから，全体が暗めのトー
ンで構成されていることがわかる．加重標準偏差
から青色成分が比較的均一であり，赤色成分が絵
画の陰影，質感，ディテールを担っていることが
読み取れる． 
 
4.1.7 葛飾北斎《神奈川沖浪裏》(図 9) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.19 “神奈川沖浪裏”RGB Space 

Table 6 “Rouen Cathedral Façade and Tour d'Albane 
(Morning Effect)” Statistics 

 R G B 
加重平均値 125.5 142.48 175.17 
加重標準偏差 63.606 50.74 36.07 
最小値 8 8 8 
最大値 248 248 248 

 
 
 
 
 
 
 
 
 
 
 

 
Fig.17 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” RGB Space 
 

Table 7 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue” Statistics 

 R G B 
加重平均値 165.39 137.89 94.797 
加重標準偏差 50.987 43.391 44.871 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 《朝の効果》 
  加重平均値は B の値が突出して高くなってい
る．絵画全体が青色，紫色が中心的かつ支配的
な色であると読み取れる．加重平均値がいずれ
も 128 前後，もしくはそれ以上であることから
全体的に明るい描写だと分かる．加重標準偏差
は加重平均値とは異なり B の値が 36.1 と最も低
い．絵画全体が青色を主体とした基調であるに
もかかわらず，その青色の種類は少なく，均一
で単調であることがわかる．一方，R の値が
63.6 と最も高く，絵画の明暗を赤色成分が決定
していることを示唆している．つまり，赤色成
分のコントラストが非常に強い絵画であるとい
える． 

《夕日》 
  加重平均値は R の値が突出している．赤，オ
レンジ，茶色といった暖色系が中心的な絵画で
あることがわかる．加重標準偏差はいずれも 40
から 50 台の値となっており，大きなばらつきが
なく RGB値のバランスが取れた自然なコントラ
ストを持つことが示されている． 

  二つの絵画は色彩の観点から見て対照的だと
いえる．プロットからもわかる通り，朝の効果
は青色主体，夕日はオレンジ主体の色彩となっ

ており，色相環の正反対に位置する関係性を持
っている．両社とも加重平均値が 128 を上回る
成分が多いことから共通して明るいシーンが描
写されていることがわかる．朝の効果は主体の
色の多様性が極端に低く，赤色のコントラスト
が高い色彩構成であるのに対し，夕日は全ての
色が均等にばらつきを持っており，調和のとれ
た色彩構成となっている．連作という形態をも
つルーアン大聖堂を制作するにあたり，クロー
ド・モネが風景に合わせて色彩構成を変化させ
ていたことが考えられる． 

 
4.1.6 モネ《睡蓮と日本の橋》(図 8) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.18 “Le bassin aux nympheas” RGB Space 

 
Table 8 “Le bassin aux nympheas” Statistics 

 R G B 
加重平均値 97.468 108.89 71.829 
加重標準偏差 54.343 50.21 43.352 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
加重平均値は G の値が最も高く，次いで R，B

の順で数値が高い．この関係性から，オリーブグ
リーンや黄緑色，茶色がかった緑色が絵画の中心
的傾向であることが読み取れる．加重平均値がい
ずれも 128 より低いことから，全体が暗めのトー
ンで構成されていることがわかる．加重標準偏差
から青色成分が比較的均一であり，赤色成分が絵
画の陰影，質感，ディテールを担っていることが
読み取れる． 
 
4.1.7 葛飾北斎《神奈川沖浪裏》(図 9) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.19 “神奈川沖浪裏”RGB Space 

Table 6 “Rouen Cathedral Façade and Tour d'Albane 
(Morning Effect)” Statistics 

 R G B 
加重平均値 125.5 142.48 175.17 
加重標準偏差 63.606 50.74 36.07 
最小値 8 8 8 
最大値 248 248 248 

 
 
 
 
 
 
 
 
 
 
 

 
Fig.17 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” RGB Space 
 

Table 7 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue” Statistics 

 R G B 
加重平均値 165.39 137.89 94.797 
加重標準偏差 50.987 43.391 44.871 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 《朝の効果》 
  加重平均値は B の値が突出して高くなってい
る．絵画全体が青色，紫色が中心的かつ支配的
な色であると読み取れる．加重平均値がいずれ
も 128 前後，もしくはそれ以上であることから
全体的に明るい描写だと分かる．加重標準偏差
は加重平均値とは異なり B の値が 36.1 と最も低
い．絵画全体が青色を主体とした基調であるに
もかかわらず，その青色の種類は少なく，均一
で単調であることがわかる．一方，R の値が
63.6 と最も高く，絵画の明暗を赤色成分が決定
していることを示唆している．つまり，赤色成
分のコントラストが非常に強い絵画であるとい
える． 

《夕日》 
  加重平均値は R の値が突出している．赤，オ
レンジ，茶色といった暖色系が中心的な絵画で
あることがわかる．加重標準偏差はいずれも 40
から 50 台の値となっており，大きなばらつきが
なく RGB値のバランスが取れた自然なコントラ
ストを持つことが示されている． 

  二つの絵画は色彩の観点から見て対照的だと
いえる．プロットからもわかる通り，朝の効果
は青色主体，夕日はオレンジ主体の色彩となっ

ており，色相環の正反対に位置する関係性を持
っている．両社とも加重平均値が 128 を上回る
成分が多いことから共通して明るいシーンが描
写されていることがわかる．朝の効果は主体の
色の多様性が極端に低く，赤色のコントラスト
が高い色彩構成であるのに対し，夕日は全ての
色が均等にばらつきを持っており，調和のとれ
た色彩構成となっている．連作という形態をも
つルーアン大聖堂を制作するにあたり，クロー
ド・モネが風景に合わせて色彩構成を変化させ
ていたことが考えられる． 

 
4.1.6 モネ《睡蓮と日本の橋》(図 8) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.18 “Le bassin aux nympheas” RGB Space 

 
Table 8 “Le bassin aux nympheas” Statistics 

 R G B 
加重平均値 97.468 108.89 71.829 
加重標準偏差 54.343 50.21 43.352 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
加重平均値は G の値が最も高く，次いで R，B

の順で数値が高い．この関係性から，オリーブグ
リーンや黄緑色，茶色がかった緑色が絵画の中心
的傾向であることが読み取れる．加重平均値がい
ずれも 128 より低いことから，全体が暗めのトー
ンで構成されていることがわかる．加重標準偏差
から青色成分が比較的均一であり，赤色成分が絵
画の陰影，質感，ディテールを担っていることが
読み取れる． 
 
4.1.7 葛飾北斎《神奈川沖浪裏》(図 9) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.19 “神奈川沖浪裏”RGB Space 

Table 6 “Rouen Cathedral Façade and Tour d'Albane 
(Morning Effect)” Statistics 

 R G B 
加重平均値 125.5 142.48 175.17 
加重標準偏差 63.606 50.74 36.07 
最小値 8 8 8 
最大値 248 248 248 

 
 
 
 
 
 
 
 
 
 
 

 
Fig.17 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” RGB Space 
 

Table 7 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue” Statistics 

 R G B 
加重平均値 165.39 137.89 94.797 
加重標準偏差 50.987 43.391 44.871 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 《朝の効果》 
  加重平均値は B の値が突出して高くなってい
る．絵画全体が青色，紫色が中心的かつ支配的
な色であると読み取れる．加重平均値がいずれ
も 128 前後，もしくはそれ以上であることから
全体的に明るい描写だと分かる．加重標準偏差
は加重平均値とは異なり B の値が 36.1 と最も低
い．絵画全体が青色を主体とした基調であるに
もかかわらず，その青色の種類は少なく，均一
で単調であることがわかる．一方，R の値が
63.6 と最も高く，絵画の明暗を赤色成分が決定
していることを示唆している．つまり，赤色成
分のコントラストが非常に強い絵画であるとい
える． 

《夕日》 
  加重平均値は R の値が突出している．赤，オ
レンジ，茶色といった暖色系が中心的な絵画で
あることがわかる．加重標準偏差はいずれも 40
から 50 台の値となっており，大きなばらつきが
なく RGB値のバランスが取れた自然なコントラ
ストを持つことが示されている． 

  二つの絵画は色彩の観点から見て対照的だと
いえる．プロットからもわかる通り，朝の効果
は青色主体，夕日はオレンジ主体の色彩となっ

ており，色相環の正反対に位置する関係性を持
っている．両社とも加重平均値が 128 を上回る
成分が多いことから共通して明るいシーンが描
写されていることがわかる．朝の効果は主体の
色の多様性が極端に低く，赤色のコントラスト
が高い色彩構成であるのに対し，夕日は全ての
色が均等にばらつきを持っており，調和のとれ
た色彩構成となっている．連作という形態をも
つルーアン大聖堂を制作するにあたり，クロー
ド・モネが風景に合わせて色彩構成を変化させ
ていたことが考えられる． 

 
4.1.6 モネ《睡蓮と日本の橋》(図 8) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.18 “Le bassin aux nympheas” RGB Space 

 
Table 8 “Le bassin aux nympheas” Statistics 

 R G B 
加重平均値 97.468 108.89 71.829 
加重標準偏差 54.343 50.21 43.352 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
加重平均値は G の値が最も高く，次いで R，B

の順で数値が高い．この関係性から，オリーブグ
リーンや黄緑色，茶色がかった緑色が絵画の中心
的傾向であることが読み取れる．加重平均値がい
ずれも 128 より低いことから，全体が暗めのトー
ンで構成されていることがわかる．加重標準偏差
から青色成分が比較的均一であり，赤色成分が絵
画の陰影，質感，ディテールを担っていることが
読み取れる． 
 
4.1.7 葛飾北斎《神奈川沖浪裏》(図 9) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.19 “神奈川沖浪裏”RGB Space 

Table 6 “Rouen Cathedral Façade and Tour d'Albane 
(Morning Effect)” Statistics 

 R G B 
加重平均値 125.5 142.48 175.17 
加重標準偏差 63.606 50.74 36.07 
最小値 8 8 8 
最大値 248 248 248 

 
 
 
 
 
 
 
 
 
 
 

 
Fig.17 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” RGB Space 
 

Table 7 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue” Statistics 

 R G B 
加重平均値 165.39 137.89 94.797 
加重標準偏差 50.987 43.391 44.871 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 《朝の効果》 
  加重平均値は B の値が突出して高くなってい
る．絵画全体が青色，紫色が中心的かつ支配的
な色であると読み取れる．加重平均値がいずれ
も 128 前後，もしくはそれ以上であることから
全体的に明るい描写だと分かる．加重標準偏差
は加重平均値とは異なり B の値が 36.1 と最も低
い．絵画全体が青色を主体とした基調であるに
もかかわらず，その青色の種類は少なく，均一
で単調であることがわかる．一方，R の値が
63.6 と最も高く，絵画の明暗を赤色成分が決定
していることを示唆している．つまり，赤色成
分のコントラストが非常に強い絵画であるとい
える． 

《夕日》 
  加重平均値は R の値が突出している．赤，オ
レンジ，茶色といった暖色系が中心的な絵画で
あることがわかる．加重標準偏差はいずれも 40
から 50 台の値となっており，大きなばらつきが
なく RGB値のバランスが取れた自然なコントラ
ストを持つことが示されている． 

  二つの絵画は色彩の観点から見て対照的だと
いえる．プロットからもわかる通り，朝の効果
は青色主体，夕日はオレンジ主体の色彩となっ

ており，色相環の正反対に位置する関係性を持
っている．両社とも加重平均値が 128 を上回る
成分が多いことから共通して明るいシーンが描
写されていることがわかる．朝の効果は主体の
色の多様性が極端に低く，赤色のコントラスト
が高い色彩構成であるのに対し，夕日は全ての
色が均等にばらつきを持っており，調和のとれ
た色彩構成となっている．連作という形態をも
つルーアン大聖堂を制作するにあたり，クロー
ド・モネが風景に合わせて色彩構成を変化させ
ていたことが考えられる． 

 
4.1.6 モネ《睡蓮と日本の橋》(図 8) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.18 “Le bassin aux nympheas” RGB Space 

 
Table 8 “Le bassin aux nympheas” Statistics 

 R G B 
加重平均値 97.468 108.89 71.829 
加重標準偏差 54.343 50.21 43.352 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
加重平均値は G の値が最も高く，次いで R，B

の順で数値が高い．この関係性から，オリーブグ
リーンや黄緑色，茶色がかった緑色が絵画の中心
的傾向であることが読み取れる．加重平均値がい
ずれも 128 より低いことから，全体が暗めのトー
ンで構成されていることがわかる．加重標準偏差
から青色成分が比較的均一であり，赤色成分が絵
画の陰影，質感，ディテールを担っていることが
読み取れる． 
 
4.1.7 葛飾北斎《神奈川沖浪裏》(図 9) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.19 “神奈川沖浪裏”RGB Space 

Table 6 “Rouen Cathedral Façade and Tour d'Albane 
(Morning Effect)” Statistics 

 R G B 
加重平均値 125.5 142.48 175.17 
加重標準偏差 63.606 50.74 36.07 
最小値 8 8 8 
最大値 248 248 248 

 
 
 
 
 
 
 
 
 
 
 

 
Fig.17 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” RGB Space 
 

Table 7 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue” Statistics 

 R G B 
加重平均値 165.39 137.89 94.797 
加重標準偏差 50.987 43.391 44.871 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 《朝の効果》 
  加重平均値は B の値が突出して高くなってい
る．絵画全体が青色，紫色が中心的かつ支配的
な色であると読み取れる．加重平均値がいずれ
も 128 前後，もしくはそれ以上であることから
全体的に明るい描写だと分かる．加重標準偏差
は加重平均値とは異なり B の値が 36.1 と最も低
い．絵画全体が青色を主体とした基調であるに
もかかわらず，その青色の種類は少なく，均一
で単調であることがわかる．一方，R の値が
63.6 と最も高く，絵画の明暗を赤色成分が決定
していることを示唆している．つまり，赤色成
分のコントラストが非常に強い絵画であるとい
える． 

《夕日》 
  加重平均値は R の値が突出している．赤，オ
レンジ，茶色といった暖色系が中心的な絵画で
あることがわかる．加重標準偏差はいずれも 40
から 50 台の値となっており，大きなばらつきが
なく RGB値のバランスが取れた自然なコントラ
ストを持つことが示されている． 

  二つの絵画は色彩の観点から見て対照的だと
いえる．プロットからもわかる通り，朝の効果
は青色主体，夕日はオレンジ主体の色彩となっ

ており，色相環の正反対に位置する関係性を持
っている．両社とも加重平均値が 128 を上回る
成分が多いことから共通して明るいシーンが描
写されていることがわかる．朝の効果は主体の
色の多様性が極端に低く，赤色のコントラスト
が高い色彩構成であるのに対し，夕日は全ての
色が均等にばらつきを持っており，調和のとれ
た色彩構成となっている．連作という形態をも
つルーアン大聖堂を制作するにあたり，クロー
ド・モネが風景に合わせて色彩構成を変化させ
ていたことが考えられる． 

 
4.1.6 モネ《睡蓮と日本の橋》(図 8) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.18 “Le bassin aux nympheas” RGB Space 

 
Table 8 “Le bassin aux nympheas” Statistics 

 R G B 
加重平均値 97.468 108.89 71.829 
加重標準偏差 54.343 50.21 43.352 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
加重平均値は G の値が最も高く，次いで R，B

の順で数値が高い．この関係性から，オリーブグ
リーンや黄緑色，茶色がかった緑色が絵画の中心
的傾向であることが読み取れる．加重平均値がい
ずれも 128 より低いことから，全体が暗めのトー
ンで構成されていることがわかる．加重標準偏差
から青色成分が比較的均一であり，赤色成分が絵
画の陰影，質感，ディテールを担っていることが
読み取れる． 
 
4.1.7 葛飾北斎《神奈川沖浪裏》(図 9) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.19 “神奈川沖浪裏”RGB Space 
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・考察
　加重平均値がいずれも 128 を大きく上回っている．絵画
全体が非常に明るいトーンで構成されていることが読み取
れる．また，青い波打ちの表現を第一印象として受ける作
品であるが，荷重平均値から B の値が最も低く，支配的
な色彩はベージュやクリーム色であることが示された．加
重標準偏差はいずれも高い値を示しており，コントラスト
が非常に強いことが読み取れる．

4.1.8　葛飾北斎《凱風快晴》（図 10）
・結果

・考察
　プロットから，他の作品と比較して赤と青の二色に偏っ
て分布していることが見て取れる．加重標準偏差がそれぞ
れ 60 から 70 台と高い値を示していることから色彩のコン
トラストが強く，一般的にこの絵画から受ける印象と分析
した数値にギャップがあることが分かる．

4.1.9　葛飾北斎《駿州江尻》（図 11）
・結果

・考察
　プロットを葛飾北斎の他の二作品と比較した際に色数が
限定されて使用されていることが読み取れる．加重標準偏
差を比較した際も顕著に差が見られ，本作品は他作品より
もコントラストが低いことがわかる．いずれの作品も共通
して富士山が描かれているが本作品のみ輪郭のみで描写さ
れていることが色彩構成の違いの要因となっていると考え
る．

4.2　暖色・寒色比率の結果
　各作品における暖色，寒色，及び中性色に分類されるピ
クセルの比率を算出した．HSV 空間プロット画像を図 22
から図 31 に，算出した数値を表 12 から表 21 に示す． 

4.2.1　ゴッホ《夜のカフェテラス》（図 2）

4.2.2　ゴッホ《ひまわり》（図 3）

Table 9 “神奈川沖浪裏” Statistics 
 R G B 
加重平均値 161.89 160.28   154.26 
加重標準偏差 81.093 71.263 53.277 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 加重平均値がいずれも 128 を大きく上回ってい
る．絵画全体が非常に明るいトーンで構成されて
いることが読み取れる．また，青い波打ちの表現
を第一印象として受ける作品であるが，荷重平均
値から B の値が最も低く，支配的な色彩はベージ
ュやクリーム色であることが示された．加重標準
偏差はいずれも高い値を示しており，コントラス
トが非常に強いことが読み取れる． 
 
4.1.8 葛飾北斎《凱風快晴》(図 10) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.20 “凱風快晴”RGB Space 

 
Table 10 “凱風快晴” Statistics 

 R G B 
加重平均値 117.92 108.4 116.1 
加重標準偏差 73.934 66.003 62.552 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 プロットから，他の作品と比較して赤と青の二
色に偏って分布していることが見て取れる．加重
標準偏差がそれぞれ 60 から 70 台と高い値を示し
ていることから色彩のコントラストが強く，一般
的にこの絵画から受ける印象と分析した数値にギ
ャップがあることが分かる． 
 
 
 
 
 
 
 
 
 
 
 

4.1.9 葛飾北斎《駿州江尻》(図 11) 
・結果 

 
 
 
 
 
 
 

 
Fig.21 “駿州江尻”RGB Space 
Table 11 “駿州江尻” Statistics 

 R G B 
加重平均値 150.6 150.38   133.38 
加重標準偏差 53.865 44.385 34.904 
最小値 8 8 8 
最大値 248 218 218 

 
・考察 
 プロットを葛飾北斎の他の二作品と比較した際
に色数が限定されて使用されていることが読み取
れる．加重標準偏差を比較した際も顕著に差が見
られ，本作品は他作品よりもコントラストが低い
ことがわかる．いずれの作品も共通して富士山が
描かれているが本作品のみ輪郭のみで描写されて
いることが色彩構成の違いの要因となっていると
考える． 
 
4.2 暖色・寒色比率の結果 
 

各作品における暖色，寒色，及び中性色に分類
されるピクセルの比率を算出した．HSV 空間プロ
ット画像を図 22 から図 31 に，算出した数値を表
11 から表 20 に示す．  

 
4.2.1 ゴッホ《夜のカフェテラス》(図 2) 

 
 
 
 
 
 
 
 
 

 
Fig.22 “Cafeterras bij nacht” HSV Space 

 
Table 12 “Cafeterras bij nacht” Color Composition  

 色彩構成比率 
暖色 25.203 % 
寒色 55.946 % 
中性色 18.835 % 
合計 99.984 % 

 

Table 9 “神奈川沖浪裏” Statistics 
 R G B 
加重平均値 161.89 160.28   154.26 
加重標準偏差 81.093 71.263 53.277 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 加重平均値がいずれも 128 を大きく上回ってい
る．絵画全体が非常に明るいトーンで構成されて
いることが読み取れる．また，青い波打ちの表現
を第一印象として受ける作品であるが，荷重平均
値から B の値が最も低く，支配的な色彩はベージ
ュやクリーム色であることが示された．加重標準
偏差はいずれも高い値を示しており，コントラス
トが非常に強いことが読み取れる． 
 
4.1.8 葛飾北斎《凱風快晴》(図 10) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.20 “凱風快晴”RGB Space 

 
Table 10 “凱風快晴” Statistics 

 R G B 
加重平均値 117.92 108.4 116.1 
加重標準偏差 73.934 66.003 62.552 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 プロットから，他の作品と比較して赤と青の二
色に偏って分布していることが見て取れる．加重
標準偏差がそれぞれ 60 から 70 台と高い値を示し
ていることから色彩のコントラストが強く，一般
的にこの絵画から受ける印象と分析した数値にギ
ャップがあることが分かる． 
 
 
 
 
 
 
 
 
 
 
 

4.1.9 葛飾北斎《駿州江尻》(図 11) 
・結果 

 
 
 
 
 
 
 

 
Fig.21 “駿州江尻”RGB Space 
Table 11 “駿州江尻” Statistics 

 R G B 
加重平均値 150.6 150.38   133.38 
加重標準偏差 53.865 44.385 34.904 
最小値 8 8 8 
最大値 248 218 218 

 
・考察 
 プロットを葛飾北斎の他の二作品と比較した際
に色数が限定されて使用されていることが読み取
れる．加重標準偏差を比較した際も顕著に差が見
られ，本作品は他作品よりもコントラストが低い
ことがわかる．いずれの作品も共通して富士山が
描かれているが本作品のみ輪郭のみで描写されて
いることが色彩構成の違いの要因となっていると
考える． 
 
4.2 暖色・寒色比率の結果 
 

各作品における暖色，寒色，及び中性色に分類
されるピクセルの比率を算出した．HSV 空間プロ
ット画像を図 22 から図 31 に，算出した数値を表
11 から表 20 に示す．  

 
4.2.1 ゴッホ《夜のカフェテラス》(図 2) 

 
 
 
 
 
 
 
 
 

 
Fig.22 “Cafeterras bij nacht” HSV Space 

 
Table 12 “Cafeterras bij nacht” Color Composition  

 色彩構成比率 
暖色 25.203 % 
寒色 55.946 % 
中性色 18.835 % 
合計 99.984 % 

 

Table 9 “神奈川沖浪裏” Statistics 
 R G B 
加重平均値 161.89 160.28   154.26 
加重標準偏差 81.093 71.263 53.277 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 加重平均値がいずれも 128 を大きく上回ってい
る．絵画全体が非常に明るいトーンで構成されて
いることが読み取れる．また，青い波打ちの表現
を第一印象として受ける作品であるが，荷重平均
値から B の値が最も低く，支配的な色彩はベージ
ュやクリーム色であることが示された．加重標準
偏差はいずれも高い値を示しており，コントラス
トが非常に強いことが読み取れる． 
 
4.1.8 葛飾北斎《凱風快晴》(図 10) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.20 “凱風快晴”RGB Space 

 
Table 10 “凱風快晴” Statistics 

 R G B 
加重平均値 117.92 108.4 116.1 
加重標準偏差 73.934 66.003 62.552 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 プロットから，他の作品と比較して赤と青の二
色に偏って分布していることが見て取れる．加重
標準偏差がそれぞれ 60 から 70 台と高い値を示し
ていることから色彩のコントラストが強く，一般
的にこの絵画から受ける印象と分析した数値にギ
ャップがあることが分かる． 
 
 
 
 
 
 
 
 
 
 
 

4.1.9 葛飾北斎《駿州江尻》(図 11) 
・結果 

 
 
 
 
 
 
 

 
Fig.21 “駿州江尻”RGB Space 
Table 11 “駿州江尻” Statistics 

 R G B 
加重平均値 150.6 150.38   133.38 
加重標準偏差 53.865 44.385 34.904 
最小値 8 8 8 
最大値 248 218 218 

 
・考察 
 プロットを葛飾北斎の他の二作品と比較した際
に色数が限定されて使用されていることが読み取
れる．加重標準偏差を比較した際も顕著に差が見
られ，本作品は他作品よりもコントラストが低い
ことがわかる．いずれの作品も共通して富士山が
描かれているが本作品のみ輪郭のみで描写されて
いることが色彩構成の違いの要因となっていると
考える． 
 
4.2 暖色・寒色比率の結果 
 

各作品における暖色，寒色，及び中性色に分類
されるピクセルの比率を算出した．HSV 空間プロ
ット画像を図 22 から図 31 に，算出した数値を表
11 から表 20 に示す．  

 
4.2.1 ゴッホ《夜のカフェテラス》(図 2) 

 
 
 
 
 
 
 
 
 

 
Fig.22 “Cafeterras bij nacht” HSV Space 

 
Table 12 “Cafeterras bij nacht” Color Composition  

 色彩構成比率 
暖色 25.203 % 
寒色 55.946 % 
中性色 18.835 % 
合計 99.984 % 

 

Table 9 “神奈川沖浪裏” Statistics 
 R G B 
加重平均値 161.89 160.28   154.26 
加重標準偏差 81.093 71.263 53.277 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 加重平均値がいずれも 128 を大きく上回ってい
る．絵画全体が非常に明るいトーンで構成されて
いることが読み取れる．また，青い波打ちの表現
を第一印象として受ける作品であるが，荷重平均
値から B の値が最も低く，支配的な色彩はベージ
ュやクリーム色であることが示された．加重標準
偏差はいずれも高い値を示しており，コントラス
トが非常に強いことが読み取れる． 
 
4.1.8 葛飾北斎《凱風快晴》(図 10) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.20 “凱風快晴”RGB Space 

 
Table 10 “凱風快晴” Statistics 

 R G B 
加重平均値 117.92 108.4 116.1 
加重標準偏差 73.934 66.003 62.552 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 プロットから，他の作品と比較して赤と青の二
色に偏って分布していることが見て取れる．加重
標準偏差がそれぞれ 60 から 70 台と高い値を示し
ていることから色彩のコントラストが強く，一般
的にこの絵画から受ける印象と分析した数値にギ
ャップがあることが分かる． 
 
 
 
 
 
 
 
 
 
 
 

4.1.9 葛飾北斎《駿州江尻》(図 11) 
・結果 

 
 
 
 
 
 
 

 
Fig.21 “駿州江尻”RGB Space 
Table 11 “駿州江尻” Statistics 

 R G B 
加重平均値 150.6 150.38   133.38 
加重標準偏差 53.865 44.385 34.904 
最小値 8 8 8 
最大値 248 218 218 

 
・考察 
 プロットを葛飾北斎の他の二作品と比較した際
に色数が限定されて使用されていることが読み取
れる．加重標準偏差を比較した際も顕著に差が見
られ，本作品は他作品よりもコントラストが低い
ことがわかる．いずれの作品も共通して富士山が
描かれているが本作品のみ輪郭のみで描写されて
いることが色彩構成の違いの要因となっていると
考える． 
 
4.2 暖色・寒色比率の結果 
 

各作品における暖色，寒色，及び中性色に分類
されるピクセルの比率を算出した．HSV 空間プロ
ット画像を図 22 から図 31 に，算出した数値を表
11 から表 20 に示す．  

 
4.2.1 ゴッホ《夜のカフェテラス》(図 2) 

 
 
 
 
 
 
 
 
 

 
Fig.22 “Cafeterras bij nacht” HSV Space 

 
Table 12 “Cafeterras bij nacht” Color Composition  

 色彩構成比率 
暖色 25.203 % 
寒色 55.946 % 
中性色 18.835 % 
合計 99.984 % 

 

Table 9 “神奈川沖浪裏” Statistics 
 R G B 
加重平均値 161.89 160.28   154.26 
加重標準偏差 81.093 71.263 53.277 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 加重平均値がいずれも 128 を大きく上回ってい
る．絵画全体が非常に明るいトーンで構成されて
いることが読み取れる．また，青い波打ちの表現
を第一印象として受ける作品であるが，荷重平均
値から B の値が最も低く，支配的な色彩はベージ
ュやクリーム色であることが示された．加重標準
偏差はいずれも高い値を示しており，コントラス
トが非常に強いことが読み取れる． 
 
4.1.8 葛飾北斎《凱風快晴》(図 10) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.20 “凱風快晴”RGB Space 

 
Table 10 “凱風快晴” Statistics 

 R G B 
加重平均値 117.92 108.4 116.1 
加重標準偏差 73.934 66.003 62.552 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 プロットから，他の作品と比較して赤と青の二
色に偏って分布していることが見て取れる．加重
標準偏差がそれぞれ 60 から 70 台と高い値を示し
ていることから色彩のコントラストが強く，一般
的にこの絵画から受ける印象と分析した数値にギ
ャップがあることが分かる． 
 
 
 
 
 
 
 
 
 
 
 

4.1.9 葛飾北斎《駿州江尻》(図 11) 
・結果 

 
 
 
 
 
 
 

 
Fig.21 “駿州江尻”RGB Space 
Table 11 “駿州江尻” Statistics 

 R G B 
加重平均値 150.6 150.38   133.38 
加重標準偏差 53.865 44.385 34.904 
最小値 8 8 8 
最大値 248 218 218 

 
・考察 
 プロットを葛飾北斎の他の二作品と比較した際
に色数が限定されて使用されていることが読み取
れる．加重標準偏差を比較した際も顕著に差が見
られ，本作品は他作品よりもコントラストが低い
ことがわかる．いずれの作品も共通して富士山が
描かれているが本作品のみ輪郭のみで描写されて
いることが色彩構成の違いの要因となっていると
考える． 
 
4.2 暖色・寒色比率の結果 
 

各作品における暖色，寒色，及び中性色に分類
されるピクセルの比率を算出した．HSV 空間プロ
ット画像を図 22 から図 31 に，算出した数値を表
11 から表 20 に示す．  

 
4.2.1 ゴッホ《夜のカフェテラス》(図 2) 

 
 
 
 
 
 
 
 
 

 
Fig.22 “Cafeterras bij nacht” HSV Space 

 
Table 12 “Cafeterras bij nacht” Color Composition  

 色彩構成比率 
暖色 25.203 % 
寒色 55.946 % 
中性色 18.835 % 
合計 99.984 % 

 

Table 9 “神奈川沖浪裏” Statistics 
 R G B 
加重平均値 161.89 160.28   154.26 
加重標準偏差 81.093 71.263 53.277 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 加重平均値がいずれも 128 を大きく上回ってい
る．絵画全体が非常に明るいトーンで構成されて
いることが読み取れる．また，青い波打ちの表現
を第一印象として受ける作品であるが，荷重平均
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ュやクリーム色であることが示された．加重標準
偏差はいずれも高い値を示しており，コントラス
トが非常に強いことが読み取れる． 
 
4.1.8 葛飾北斎《凱風快晴》(図 10) 
・結果 

 
 
 
 
 
 
 
 

 
Fig.20 “凱風快晴”RGB Space 

 
Table 10 “凱風快晴” Statistics 

 R G B 
加重平均値 117.92 108.4 116.1 
加重標準偏差 73.934 66.003 62.552 
最小値 8 8 8 
最大値 248 248 248 

 
・考察 
 プロットから，他の作品と比較して赤と青の二
色に偏って分布していることが見て取れる．加重
標準偏差がそれぞれ 60 から 70 台と高い値を示し
ていることから色彩のコントラストが強く，一般
的にこの絵画から受ける印象と分析した数値にギ
ャップがあることが分かる． 
 
 
 
 
 
 
 
 
 
 
 

4.1.9 葛飾北斎《駿州江尻》(図 11) 
・結果 

 
 
 
 
 
 
 

 
Fig.21 “駿州江尻”RGB Space 
Table 11 “駿州江尻” Statistics 

 R G B 
加重平均値 150.6 150.38   133.38 
加重標準偏差 53.865 44.385 34.904 
最小値 8 8 8 
最大値 248 218 218 

 
・考察 
 プロットを葛飾北斎の他の二作品と比較した際
に色数が限定されて使用されていることが読み取
れる．加重標準偏差を比較した際も顕著に差が見
られ，本作品は他作品よりもコントラストが低い
ことがわかる．いずれの作品も共通して富士山が
描かれているが本作品のみ輪郭のみで描写されて
いることが色彩構成の違いの要因となっていると
考える． 
 
4.2 暖色・寒色比率の結果 
 

各作品における暖色，寒色，及び中性色に分類
されるピクセルの比率を算出した．HSV 空間プロ
ット画像を図 22 から図 31 に，算出した数値を表
11 から表 20 に示す．  

 
4.2.1 ゴッホ《夜のカフェテラス》(図 2) 

 
 
 
 
 
 
 
 
 

 
Fig.22 “Cafeterras bij nacht” HSV Space 

 
Table 12 “Cafeterras bij nacht” Color Composition  

 色彩構成比率 
暖色 25.203 % 
寒色 55.946 % 

中性色 18.835 % 
合計 99.984 % 

 

4.2.2 ゴッホ《ひまわり》(図 3) 
 
 
 
 
 
 
 
 

 
Fig.23 “Zonnebloemen” HSV Space 

 
Table 13 “Zonnebloemen” Color Composition  

 色彩構成比率 
暖色 47.667 % 
寒色 40.788 % 
中性色 11.520 % 
合計 99.975 % 

 
4.2.3 ゴッホ《星月夜》(図 4) 

 
 
 
 
 
 
 

 
Fig.24 “De sterrennacht” HSV Space 

 
Table 14 “De sterrennacht” Color Composition  

 色彩構成比率 
暖色 1.708% 
寒色 79.484% 
中性色 18.784% 
合計 99.976% 

 
4.2.4 モネ《散歩，日傘をさす女性》(図 5) 

 
 
 
 
 
 
 
 

 
Fig.25 “La Promenade, la femme à l'ombrelle” 

HSV Space 
 
 
 
 
 
 

Table 15 “La Promenade, la femme à l'ombrelle” 
Color Composition  

 色彩構成比率 
暖色 8.448 % 
寒色 68.895 % 
中性色 22.641 % 
合計 99.984 % 

 
4.2.5 モネ《ルーアン大聖堂(朝の効果)》(図 6) 
   モネ《ルーアン大聖堂(夕日)》(図 7)  

 
 
 
 
 
 
 
 
 

 
Fig.26 “Rouen Cathedral Façade and Tour 

d'Albane (Morning Effect)” HSV Space 
 

Table 16 “Rouen Cathedral Façade and Tour 
d'Albane (Morning Effect)”Color Composition  

 色彩構成比率 
暖色 3.637 % 
寒色 77.783 % 
中性色 18.566 % 
合計 99.986 % 

 
 
 

 
 
 
 
 
 

 
Fig.27 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” HSV Space 
 

Table 17 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue”Color Composition  

 色彩構成比率 
暖色 58.293 % 
寒色 27.278 % 
中性色 14.411 % 
合計 99.982 % 
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4.2.6　モネ《睡蓮と日本の橋》（図 8）

4.2.7　葛飾北斎《神奈川沖浪裏》（図 9）

4.2.8　葛飾北斎《凱風快晴》（図 10）

4.2.9　葛飾北斎《駿州江尻》（図 11）

4.3　主要色の抽出結果
　k-means クラスタリング（k=[ 設定したクラスタ数 ]）
を用いて各作品の主要色を抽出した．クラスタリングされ
た画像を図 32 から図 41 に，抽出された色のカラーパレッ
トと，各色が画面全体に占める構成比率を表 22 から表 31
に示す．

4.2.6 モネ《睡蓮と日本の橋》(図 8) 
 
 
 
 
 
 
 
 

 
Fig.28 “Le bassin aux nympheas” HSV Space 

 
Table 18 “Le bassin aux nympheas”Color 

Composition  
 色彩構成比率 

暖色 10.045 % 
寒色 78.741 % 

中性色 11.193 % 
合計 99.979 % 

 
4.2.7 葛飾北斎《神奈川沖浪裏》(図 9) 

 
 
 
 
 
 
 
 

 
Fig.29 “神奈川沖浪裏”HSV Space 

 
Table 19 “Le bassin aux nympheas”Color 

Composition  
 色彩構成比率 

暖色 19.066 % 
寒色 46.678 % 
中性色 34.244 % 
合計 99.988 % 

 
4.2.8 葛飾北斎《凱風快晴》(図 10) 

 
 
 
 
 
 
 
 

 
Fig.30 “凱風快晴”HSV Space 

 
 
 
 

Table 20 “凱風快晴”Color Composition  
 色彩構成比率 

暖色 26.372 % 
寒色 57.137 % 
中性色 16.478 % 
合計 99.987 % 

 
4.2.9 葛飾北斎《駿州江尻》(図 11) 

 
 
 
 
 
 
 

 
Fig.31 “駿州江尻”HSV Space 

 
Table 21 “駿州江尻”Color Composition  

 色彩構成比率 
暖色 17.991 % 
寒色 64.742 % 
中性色 17.262 % 
合計 99.995 % 

 
 
4.3 主要色の抽出結果 

k-means クラスタリング（k=[設定したクラスタ
数]）を用いて各作品の主要色を抽出した．クラス
タリングされた画像を図 32 から図 41 に，抽出さ
れた色のカラーパレットと，各色が画面全体に占
める構成比率を表 21 から表 30 に示す． 

 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
Fig.32 “Cafeterras bij nacht” Clustering 

 
Table 22 “Cafeterras bij nacht” Clustering Table 

Cluster 0 1 2 
R 168.225 53.36 92.763 
G 143.084 59.837 120.101 
B 60.487 57.273 157.818 
Count 3619638 3674286 2924828 
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Fig.31 “駿州江尻”HSV Space 

 
Table 21 “駿州江尻”Color Composition  

 色彩構成比率 
暖色 17.991 % 
寒色 64.742 % 
中性色 17.262 % 
合計 99.995 % 

 
 
4.3 主要色の抽出結果 

k-means クラスタリング（k=[設定したクラスタ
数]）を用いて各作品の主要色を抽出した．クラス
タリングされた画像を図 32 から図 41 に，抽出さ
れた色のカラーパレットと，各色が画面全体に占
める構成比率を表 21 から表 30 に示す． 

 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
Fig.32 “Cafeterras bij nacht” Clustering 

 
Table 22 “Cafeterras bij nacht” Clustering Table 

Cluster 0 1 2 
R 168.225 53.36 92.763 
G 143.084 59.837 120.101 
B 60.487 57.273 157.818 
Count 3619638 3674286 2924828 
 
 
 
 
 

4.2.6 モネ《睡蓮と日本の橋》(図 8) 
 
 
 
 
 
 
 
 

 
Fig.28 “Le bassin aux nympheas” HSV Space 

 
Table 18 “Le bassin aux nympheas”Color 

Composition  
 色彩構成比率 

暖色 10.045 % 
寒色 78.741 % 
中性色 11.193 % 
合計 99.979 % 

 
4.2.7 葛飾北斎《神奈川沖浪裏》(図 9) 

 
 
 
 
 
 
 
 

 
Fig.29 “神奈川沖浪裏”HSV Space 

 
Table 19 “Le bassin aux nympheas”Color 
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 色彩構成比率 
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寒色 46.678 % 
中性色 34.244 % 
合計 99.988 % 
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Fig.32 “Cafeterras bij nacht” Clustering 

 
Table 22 “Cafeterras bij nacht” Clustering Table 

Cluster 0 1 2 
R 168.225 53.36 92.763 
G 143.084 59.837 120.101 
B 60.487 57.273 157.818 
Count 3619638 3674286 2924828 
 
 
 
 
 

11ImageJ を用いた特定画像の色彩分布についての調査・考察



 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
Fig.33 “Zonnebloemen” Clustering 

 
Table 23 “Zonnebloemen” Clustering Table 

Cluster 0 1 2 
R 220.779 121.967 176.318 
G 213.786 103.045 150.29 
B 88.296 13.871 18.473 
Count 8597169 4673545 7837286 

 
 
 
 
 
 
 

 

 
 
 
 
 
 

 
Fig.34 “De sterrennacht” Clustering 

 
Table 24 “De sterrennacht” Clustering Table 

Cluster 0 1 2 
R 66.762 139.809 31.3 
G 91.679 156.755 37.789 
B 134.976 150.972 46.552 
Count 20466019 14052716 16761265 

 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
Fig.35 “La Promenade, la femme à l'ombrelle” 

Clustering 
 

Table 25 “La Promenade, la femme à l'ombrelle”  
Clustering Table 

Cluster 0 1 2 
R 176.06 85.392 122.692 
G 188.19 86.921 136.714 
B 202.178 55.724 155.898 
Count 297473 277920 270431 

 
 

 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 

 
Fig.36 “Rouen Cathedral Façade and Tour 

d'Albane (Morning Effect)”Clustering 
 

Table 26 “Rouen Cathedral Façade and Tour 
d'Albane (Morning Effect)” Clustering Table 

Cluster 0 1 2 
R 199.036 56.444 119.89 
G 199.634 86 141.331 
B 206.981 139.676 180.168 
Count 247592 245728 228600 

 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 

 
Fig.37 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” Clustering 
 

Table 27 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue” Clustering Table 

Cluster 0 1 2 
R 201.429 110.209 190.321 
G 182.745 92.302 141.35 
B 141.753 66.805 74.386 
Count 227764 238672 205308 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 

 
Fig.38 “Le bassin aux nympheas”Clustering 

 
 
 
 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
Fig.33 “Zonnebloemen” Clustering 
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Fig.38 “Le bassin aux nympheas”Clustering 

 
 
 
 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
Fig.33 “Zonnebloemen” Clustering 
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Fig.38 “Le bassin aux nympheas”Clustering 

 
 
 
 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
Fig.33 “Zonnebloemen” Clustering 
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Count 297473 277920 270431 

 
 

 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 

 
Fig.36 “Rouen Cathedral Façade and Tour 

d'Albane (Morning Effect)”Clustering 
 

Table 26 “Rouen Cathedral Façade and Tour 
d'Albane (Morning Effect)” Clustering Table 

Cluster 0 1 2 
R 199.036 56.444 119.89 
G 199.634 86 141.331 
B 206.981 139.676 180.168 
Count 247592 245728 228600 

 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 

 
Fig.37 “Rouen Cathedral, Facade (sunset), 

harmonie in gold and blue” Clustering 
 

Table 27 “Rouen Cathedral, Facade (sunset), 
harmonie in gold and blue” Clustering Table 

Cluster 0 1 2 
R 201.429 110.209 190.321 
G 182.745 92.302 141.35 
B 141.753 66.805 74.386 
Count 227764 238672 205308 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 

 
Fig.38 “Le bassin aux nympheas”Clustering 

 
 
 
 

 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
Fig.33 “Zonnebloemen” Clustering 

 
Table 23 “Zonnebloemen” Clustering Table 

Cluster 0 1 2 
R 220.779 121.967 176.318 
G 213.786 103.045 150.29 
B 88.296 13.871 18.473 
Count 8597169 4673545 7837286 

 
 
 
 
 
 
 

 

 
 
 
 
 
 

 
Fig.34 “De sterrennacht” Clustering 

 
Table 24 “De sterrennacht” Clustering Table 

Cluster 0 1 2 
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G 91.679 156.755 37.789 
B 134.976 150.972 46.552 
Count 20466019 14052716 16761265 
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Table 27 “Rouen Cathedral, Facade (sunset), 
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Cluster 0 1 2 
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Fig.38 “Le bassin aux nympheas”Clustering 
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　抽出された主要色についてカラーコードを用いて結果を
まとめる．
・ゴッホ
《夜のカフェテラス》からは，#A88F3C （構成比 35％），
#353B39 （構成比 36%），#5C789D（構成比 29％）が主要
色として抽出された．

《ひまわり》からは，#DCD558 （構成比 40％），#79670D（構
成比 22％），#B09612 （構成比 38%）が主要色として抽出
された．

《星月夜》からは，#425B86（構成比 40%），#8B9C96（28%），
#1F252E（32%）が主要色として抽出された．
・モネ
《散歩，日傘をさす女性》からは，#B0BCCA（構成比
35％），#555637（構成比 33％），#7A889B（32％）が主
要色として抽出された．

《ルーアン大聖堂（朝の効果）》からは，#C7C7CE（構成
比 34%），#38568B（ 構 成 比 34%），#778DB4（ 構 成 比
32%）が主要色として抽出された．

《ルーアン大聖堂（夕日）》からは，#C9B68D（構成比
34%），#6E5C42（ 構 成 比 35%），#BE8D4A（ 構 成 比
31%）が主要色として抽出された．

《睡蓮と日本の橋》からは，#ADB182（構成比 22%），
#303D23（構成比 42%），#6A784B（構成比 38%）が主要
色として抽出された．
・北斎
《 神 奈 川 沖 浪 裏 》 か ら は， #6A784B（ 構 成 比 25%），
#E3D5BD（構成比 52%），#1C294A（構成比 22%）が主
要色として抽出された．

《凱風快晴》からは，#DADCC9（構成比 22%），#375473（構
成比 53%），#C93F2D（構成比 35%）が主要色として抽出
された．

《駿州江尻》からは，#465955 （構成比 18%），#B4A693（構
成比 47%），#E3D8C5（構成比 35%）が主要色として抽出
された．

5　考察

5.1　西洋と日本の色彩分布の差異
　可視化した RGB の三次元プロット，暖色・寒色比率，
主要色の抽出結果から，今回選定した画家において，日本
と西洋の絵画には明確な色彩構成の違いが存在することが
示唆される．
　ゴッホとモネの作品では RGB プロットにおいて特定の
色彩を核にしつつも，広範囲にわたって連続的に分布する
傾向が見られた．これは，油彩絵具の混色や厚塗りの技法
からくるもので，光の移ろいや空気感を表現しようとした
印象派の特徴が表れている．暖色と寒色の対比が際立って
いる一方で，その境界は無数の中性色により繋がれている．
　一方，葛飾北斎の作品は色彩分布が RGB 空間内の離れ
た複数の領域にそれぞれ塊となって存在する傾向が見られ
た．これは木版画という製作手法の特性上，色の境界が明
確になり，平面的で均質な色彩が構成されることに起因す
る．主要色として抽出された色彩分布からも西洋作品と比

Table 28 “Le bassin aux nympheas” Clustering 
Table 

Cluster 0 1 2 
R 173.121 48.029 106.611 
G 177.756 61.182 120.37 
B 130.948 35.82 75.273 
Count 224821 415016 364707 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.39 “神奈川沖浪裏”Clustering 

 
Table 29 “神奈川沖浪裏” Clustering Table 

Cluster 0 1 2 
R 144.969 227.242 28.758 
G 156.805 213.777 41.375 
B 152.75 189.268 74.332 
Count 3334193 6777192 2850265 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.40 “凱風快晴”Clustering 

 
Table 30 “凱風快晴” Clustering Table 

Cluster 0 1 2 
R 218.916 55.068 201.732 
G 220.952 84.634 63.427 
B 201.732 115.031 45.19 
Count 2804489 6789225 3329086 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.41 “駿州江尻”Clustering 

 
Table 31 “駿州江尻” Clustering Table 

Cluster 0 1 2 
R 70.989 180.104 227.437 
G 89.266 166.94 216.532 
B 85.338 147.218 197.554 
Count 169230 427717 31853 

 
抽出された主要色についてカラーコードを用い

て結果をまとめる． 

・ゴッホ 
《夜のカフェテラス》からは，#A88F3C (構成比 3
5％)，#353B39 (構成比 36%)，#5C789D (構成比 2
9％)が主要色として抽出された． 
《ひまわり》からは，#DCD558 (構成比 40％)，#7
9670D (構成比 22％)，#B09612 (構成比 38%)が主要
色として抽出された． 
《星月夜》からは，#425B86 (構成比 40%)，#8B9C
96 (28%)，#1F252E (32%)が主要色として抽出され
た． 
・モネ 
《散歩，日傘をさす女性》からは，#B0BCCA (構
成比 35％)，#555637 (構成比 33％)，#7A889B (3
2％)が主要色として抽出された． 
《ルーアン大聖堂(朝の効果)》からは，#C7C7CE
(構成比 34%)，#38568B(構成比 34%)，#778DB4(構
成比 32%)が主要色として抽出された． 
《ルーアン大聖堂(夕日)》からは，#C9B68D(構成
比 34%)，#6E5C42(構成比 35%)，#BE8D4A(構成比
31%)が主要色として抽出された． 
《睡蓮と日本の橋》からは，#ADB182(構成比 2
2%)，#303D23(構成比 42%)，#6A784B(構成比 3
8%)が主要色として抽出された． 
・北斎 
《神奈川沖浪裏》からは， #6A784B(構成比 25%)，
#E3D5BD(構成比 52%)，#1C294A(構成比 22%)が主
要色として抽出された． 
《凱風快晴》からは，#DADCC9(構成比 22%)，#3
75473(構成比 53%)，#C93F2D(構成比 35%)が主要
色として抽出された． 
《駿州江尻》からは，#465955 (構成比 18%)，#B4
A693 (構成比 47%)，#E3D8C5(構成比 35%)が主要
色として抽出された． 
 

5 考察 
 
5.1 西洋と日本の色彩分布の差異 
 可視化した RGBの三次元プロット，暖色・寒色
比率，主要色の抽出結果から，今回選定した画家
において，日本と西洋の絵画には明確な色彩構成
の違いが存在することが示唆される． 
ゴッホとモネの作品では RGBプロットにおいて

特定の色彩を核にしつつも，広範囲にわたって連
続的に分布する傾向が見られた．これは，油彩絵
具の混色や厚塗りの技法からくるもので，光の移
ろいや空気感を表現しようとした印象派の特徴が
表れている．暖色と寒色の対比が際立っている一
方で，その境界は無数の中性色により繋がれてい
る． 
 一方，葛飾北斎の作品は色彩分布が RGB空間内
の離れた複数の領域にそれぞれ塊となって存在す
る傾向が見られた．これは木版画という製作手法
の特性上，色の境界が明確になり，平面的で均質
な色彩が構成されることに起因する．主要色とし
て抽出された色彩分布からも西洋作品と比較して
分布にまとまりがあることが読み取れる． 

Table 28 “Le bassin aux nympheas” Clustering 
Table 

Cluster 0 1 2 
R 173.121 48.029 106.611 
G 177.756 61.182 120.37 
B 130.948 35.82 75.273 
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Fig.39 “神奈川沖浪裏”Clustering 

 
Table 29 “神奈川沖浪裏” Clustering Table 

Cluster 0 1 2 
R 144.969 227.242 28.758 
G 156.805 213.777 41.375 
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Fig.40 “凱風快晴”Clustering 

 
Table 30 “凱風快晴” Clustering Table 

Cluster 0 1 2 
R 218.916 55.068 201.732 
G 220.952 84.634 63.427 
B 201.732 115.031 45.19 
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Fig.41 “駿州江尻”Clustering 

 
Table 31 “駿州江尻” Clustering Table 

Cluster 0 1 2 
R 70.989 180.104 227.437 
G 89.266 166.94 216.532 
B 85.338 147.218 197.554 
Count 169230 427717 31853 
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9％)が主要色として抽出された． 
《ひまわり》からは，#DCD558 (構成比 40％)，#7
9670D (構成比 22％)，#B09612 (構成比 38%)が主要
色として抽出された． 
《星月夜》からは，#425B86 (構成比 40%)，#8B9C
96 (28%)，#1F252E (32%)が主要色として抽出され
た． 
・モネ 
《散歩，日傘をさす女性》からは，#B0BCCA (構
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色として抽出された． 
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色として抽出された． 
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の違いが存在することが示唆される． 
ゴッホとモネの作品では RGBプロットにおいて

特定の色彩を核にしつつも，広範囲にわたって連
続的に分布する傾向が見られた．これは，油彩絵
具の混色や厚塗りの技法からくるもので，光の移
ろいや空気感を表現しようとした印象派の特徴が
表れている．暖色と寒色の対比が際立っている一
方で，その境界は無数の中性色により繋がれてい
る． 
 一方，葛飾北斎の作品は色彩分布が RGB空間内
の離れた複数の領域にそれぞれ塊となって存在す
る傾向が見られた．これは木版画という製作手法
の特性上，色の境界が明確になり，平面的で均質
な色彩が構成されることに起因する．主要色とし
て抽出された色彩分布からも西洋作品と比較して
分布にまとまりがあることが読み取れる． 
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Fig.39 “神奈川沖浪裏”Clustering 

 
Table 29 “神奈川沖浪裏” Clustering Table 
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Fig.40 “凱風快晴”Clustering 

 
Table 30 “凱風快晴” Clustering Table 

Cluster 0 1 2 
R 218.916 55.068 201.732 
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B 201.732 115.031 45.19 
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Fig.41 “駿州江尻”Clustering 

 
Table 31 “駿州江尻” Clustering Table 

Cluster 0 1 2 
R 70.989 180.104 227.437 
G 89.266 166.94 216.532 
B 85.338 147.218 197.554 
Count 169230 427717 31853 
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て結果をまとめる． 

・ゴッホ 
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Fig.39 “神奈川沖浪裏”Clustering 

 
Table 29 “神奈川沖浪裏” Clustering Table 
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Fig.40 “凱風快晴”Clustering 

 
Table 30 “凱風快晴” Clustering Table 
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Fig.41 “駿州江尻”Clustering 

 
Table 31 “駿州江尻” Clustering Table 
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8%)が主要色として抽出された． 
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て抽出された色彩分布からも西洋作品と比較して
分布にまとまりがあることが読み取れる． 

Table 28 “Le bassin aux nympheas” Clustering 
Table 

Cluster 0 1 2 
R 173.121 48.029 106.611 
G 177.756 61.182 120.37 
B 130.948 35.82 75.273 
Count 224821 415016 364707 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.39 “神奈川沖浪裏”Clustering 

 
Table 29 “神奈川沖浪裏” Clustering Table 

Cluster 0 1 2 
R 144.969 227.242 28.758 
G 156.805 213.777 41.375 
B 152.75 189.268 74.332 
Count 3334193 6777192 2850265 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.40 “凱風快晴”Clustering 

 
Table 30 “凱風快晴” Clustering Table 

Cluster 0 1 2 
R 218.916 55.068 201.732 
G 220.952 84.634 63.427 
B 201.732 115.031 45.19 
Count 2804489 6789225 3329086 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.41 “駿州江尻”Clustering 

 
Table 31 “駿州江尻” Clustering Table 

Cluster 0 1 2 
R 70.989 180.104 227.437 
G 89.266 166.94 216.532 
B 85.338 147.218 197.554 
Count 169230 427717 31853 

 
抽出された主要色についてカラーコードを用い

て結果をまとめる． 

・ゴッホ 
《夜のカフェテラス》からは，#A88F3C (構成比 3
5％)，#353B39 (構成比 36%)，#5C789D (構成比 2
9％)が主要色として抽出された． 
《ひまわり》からは，#DCD558 (構成比 40％)，#7
9670D (構成比 22％)，#B09612 (構成比 38%)が主要
色として抽出された． 
《星月夜》からは，#425B86 (構成比 40%)，#8B9C
96 (28%)，#1F252E (32%)が主要色として抽出され
た． 
・モネ 
《散歩，日傘をさす女性》からは，#B0BCCA (構
成比 35％)，#555637 (構成比 33％)，#7A889B (3
2％)が主要色として抽出された． 
《ルーアン大聖堂(朝の効果)》からは，#C7C7CE
(構成比 34%)，#38568B(構成比 34%)，#778DB4(構
成比 32%)が主要色として抽出された． 
《ルーアン大聖堂(夕日)》からは，#C9B68D(構成
比 34%)，#6E5C42(構成比 35%)，#BE8D4A(構成比
31%)が主要色として抽出された． 
《睡蓮と日本の橋》からは，#ADB182(構成比 2
2%)，#303D23(構成比 42%)，#6A784B(構成比 3
8%)が主要色として抽出された． 
・北斎 
《神奈川沖浪裏》からは， #6A784B(構成比 25%)，
#E3D5BD(構成比 52%)，#1C294A(構成比 22%)が主
要色として抽出された． 
《凱風快晴》からは，#DADCC9(構成比 22%)，#3
75473(構成比 53%)，#C93F2D(構成比 35%)が主要
色として抽出された． 
《駿州江尻》からは，#465955 (構成比 18%)，#B4
A693 (構成比 47%)，#E3D8C5(構成比 35%)が主要
色として抽出された． 
 

5 考察 
 
5.1 西洋と日本の色彩分布の差異 
 可視化した RGBの三次元プロット，暖色・寒色
比率，主要色の抽出結果から，今回選定した画家
において，日本と西洋の絵画には明確な色彩構成
の違いが存在することが示唆される． 
ゴッホとモネの作品では RGBプロットにおいて

特定の色彩を核にしつつも，広範囲にわたって連
続的に分布する傾向が見られた．これは，油彩絵
具の混色や厚塗りの技法からくるもので，光の移
ろいや空気感を表現しようとした印象派の特徴が
表れている．暖色と寒色の対比が際立っている一
方で，その境界は無数の中性色により繋がれてい
る． 
 一方，葛飾北斎の作品は色彩分布が RGB空間内
の離れた複数の領域にそれぞれ塊となって存在す
る傾向が見られた．これは木版画という製作手法
の特性上，色の境界が明確になり，平面的で均質
な色彩が構成されることに起因する．主要色とし
て抽出された色彩分布からも西洋作品と比較して
分布にまとまりがあることが読み取れる． 

Table 28 “Le bassin aux nympheas” Clustering 
Table 

Cluster 0 1 2 
R 173.121 48.029 106.611 
G 177.756 61.182 120.37 
B 130.948 35.82 75.273 
Count 224821 415016 364707 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.39 “神奈川沖浪裏”Clustering 

 
Table 29 “神奈川沖浪裏” Clustering Table 

Cluster 0 1 2 
R 144.969 227.242 28.758 
G 156.805 213.777 41.375 
B 152.75 189.268 74.332 
Count 3334193 6777192 2850265 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.40 “凱風快晴”Clustering 

 
Table 30 “凱風快晴” Clustering Table 

Cluster 0 1 2 
R 218.916 55.068 201.732 
G 220.952 84.634 63.427 
B 201.732 115.031 45.19 
Count 2804489 6789225 3329086 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.41 “駿州江尻”Clustering 

 
Table 31 “駿州江尻” Clustering Table 

Cluster 0 1 2 
R 70.989 180.104 227.437 
G 89.266 166.94 216.532 
B 85.338 147.218 197.554 
Count 169230 427717 31853 

 
抽出された主要色についてカラーコードを用い

て結果をまとめる． 

・ゴッホ 
《夜のカフェテラス》からは，#A88F3C (構成比 3
5％)，#353B39 (構成比 36%)，#5C789D (構成比 2
9％)が主要色として抽出された． 
《ひまわり》からは，#DCD558 (構成比 40％)，#7
9670D (構成比 22％)，#B09612 (構成比 38%)が主要
色として抽出された． 
《星月夜》からは，#425B86 (構成比 40%)，#8B9C
96 (28%)，#1F252E (32%)が主要色として抽出され
た． 
・モネ 
《散歩，日傘をさす女性》からは，#B0BCCA (構
成比 35％)，#555637 (構成比 33％)，#7A889B (3
2％)が主要色として抽出された． 
《ルーアン大聖堂(朝の効果)》からは，#C7C7CE
(構成比 34%)，#38568B(構成比 34%)，#778DB4(構
成比 32%)が主要色として抽出された． 
《ルーアン大聖堂(夕日)》からは，#C9B68D(構成
比 34%)，#6E5C42(構成比 35%)，#BE8D4A(構成比
31%)が主要色として抽出された． 
《睡蓮と日本の橋》からは，#ADB182(構成比 2
2%)，#303D23(構成比 42%)，#6A784B(構成比 3
8%)が主要色として抽出された． 
・北斎 
《神奈川沖浪裏》からは， #6A784B(構成比 25%)，
#E3D5BD(構成比 52%)，#1C294A(構成比 22%)が主
要色として抽出された． 
《凱風快晴》からは，#DADCC9(構成比 22%)，#3
75473(構成比 53%)，#C93F2D(構成比 35%)が主要
色として抽出された． 
《駿州江尻》からは，#465955 (構成比 18%)，#B4
A693 (構成比 47%)，#E3D8C5(構成比 35%)が主要
色として抽出された． 
 

5 考察 
 
5.1 西洋と日本の色彩分布の差異 
 可視化した RGBの三次元プロット，暖色・寒色
比率，主要色の抽出結果から，今回選定した画家
において，日本と西洋の絵画には明確な色彩構成
の違いが存在することが示唆される． 
ゴッホとモネの作品では RGBプロットにおいて

特定の色彩を核にしつつも，広範囲にわたって連
続的に分布する傾向が見られた．これは，油彩絵
具の混色や厚塗りの技法からくるもので，光の移
ろいや空気感を表現しようとした印象派の特徴が
表れている．暖色と寒色の対比が際立っている一
方で，その境界は無数の中性色により繋がれてい
る． 
 一方，葛飾北斎の作品は色彩分布が RGB空間内
の離れた複数の領域にそれぞれ塊となって存在す
る傾向が見られた．これは木版画という製作手法
の特性上，色の境界が明確になり，平面的で均質
な色彩が構成されることに起因する．主要色とし
て抽出された色彩分布からも西洋作品と比較して
分布にまとまりがあることが読み取れる． 

Table 28 “Le bassin aux nympheas” Clustering 
Table 

Cluster 0 1 2 
R 173.121 48.029 106.611 
G 177.756 61.182 120.37 
B 130.948 35.82 75.273 
Count 224821 415016 364707 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.39 “神奈川沖浪裏”Clustering 

 
Table 29 “神奈川沖浪裏” Clustering Table 

Cluster 0 1 2 
R 144.969 227.242 28.758 
G 156.805 213.777 41.375 
B 152.75 189.268 74.332 
Count 3334193 6777192 2850265 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.40 “凱風快晴”Clustering 

 
Table 30 “凱風快晴” Clustering Table 

Cluster 0 1 2 
R 218.916 55.068 201.732 
G 220.952 84.634 63.427 
B 201.732 115.031 45.19 
Count 2804489 6789225 3329086 

 
 
 
 
 
 

 

 
 
 
 
 

 
Fig.41 “駿州江尻”Clustering 

 
Table 31 “駿州江尻” Clustering Table 

Cluster 0 1 2 
R 70.989 180.104 227.437 
G 89.266 166.94 216.532 
B 85.338 147.218 197.554 
Count 169230 427717 31853 

 
抽出された主要色についてカラーコードを用い

て結果をまとめる． 

・ゴッホ 
《夜のカフェテラス》からは，#A88F3C (構成比 3
5％)，#353B39 (構成比 36%)，#5C789D (構成比 2
9％)が主要色として抽出された． 
《ひまわり》からは，#DCD558 (構成比 40％)，#7
9670D (構成比 22％)，#B09612 (構成比 38%)が主要
色として抽出された． 
《星月夜》からは，#425B86 (構成比 40%)，#8B9C
96 (28%)，#1F252E (32%)が主要色として抽出され
た． 
・モネ 
《散歩，日傘をさす女性》からは，#B0BCCA (構
成比 35％)，#555637 (構成比 33％)，#7A889B (3
2％)が主要色として抽出された． 
《ルーアン大聖堂(朝の効果)》からは，#C7C7CE
(構成比 34%)，#38568B(構成比 34%)，#778DB4(構
成比 32%)が主要色として抽出された． 
《ルーアン大聖堂(夕日)》からは，#C9B68D(構成
比 34%)，#6E5C42(構成比 35%)，#BE8D4A(構成比
31%)が主要色として抽出された． 
《睡蓮と日本の橋》からは，#ADB182(構成比 2
2%)，#303D23(構成比 42%)，#6A784B(構成比 3
8%)が主要色として抽出された． 
・北斎 
《神奈川沖浪裏》からは， #6A784B(構成比 25%)，
#E3D5BD(構成比 52%)，#1C294A(構成比 22%)が主
要色として抽出された． 
《凱風快晴》からは，#DADCC9(構成比 22%)，#3
75473(構成比 53%)，#C93F2D(構成比 35%)が主要
色として抽出された． 
《駿州江尻》からは，#465955 (構成比 18%)，#B4
A693 (構成比 47%)，#E3D8C5(構成比 35%)が主要
色として抽出された． 
 

5 考察 
 
5.1 西洋と日本の色彩分布の差異 
 可視化した RGBの三次元プロット，暖色・寒色
比率，主要色の抽出結果から，今回選定した画家
において，日本と西洋の絵画には明確な色彩構成
の違いが存在することが示唆される． 
ゴッホとモネの作品では RGBプロットにおいて

特定の色彩を核にしつつも，広範囲にわたって連
続的に分布する傾向が見られた．これは，油彩絵
具の混色や厚塗りの技法からくるもので，光の移
ろいや空気感を表現しようとした印象派の特徴が
表れている．暖色と寒色の対比が際立っている一
方で，その境界は無数の中性色により繋がれてい
る． 
 一方，葛飾北斎の作品は色彩分布が RGB空間内
の離れた複数の領域にそれぞれ塊となって存在す
る傾向が見られた．これは木版画という製作手法
の特性上，色の境界が明確になり，平面的で均質
な色彩が構成されることに起因する．主要色とし
て抽出された色彩分布からも西洋作品と比較して
分布にまとまりがあることが読み取れる． 

13ImageJ を用いた特定画像の色彩分布についての調査・考察



較して分布にまとまりがあることが読み取れる．

5.2　色彩構成に見る文化的背景
　色彩分布の差異は，描画材料や技法の違いだけではなく，
それぞれの文化の持つ芸術に対する価値観や美意識を反映
していると考えられる．
　印象派は，光の効果や色彩により生まれる対象への瞬間
的な印象を描くことを追求した．本調査で見られた色彩の
分布から，現実世界の光と影が作り出す現象をキャンバス
上に再構築しようとする西洋の科学的で分析的なアプロー
チが感じ取れる．
　対して，日本の浮世絵は写実的な表現よりもデザインと
しての洗練や様式美を追求してきた．限られた色数で最大
の効果を生むための大胆な構図，明確な境界線，余白の美
は，自然を抽象化して捉える独自の美意識に基づいている．
本調査で確認された色彩分布のクラスタリングは，平面的
でありながらも調和のとれた構成に重きを置いた日本の文
化的背景を示唆している．

5.3　本分析手法の有効性と限界
〇有効性
・客観的な評価
加重平均値や標準偏差といった数値，あるいは 3 次元プ
ロットの分布形状として客観的に示すことができる．
・新たな分布傾向や作者の「癖」の発見
人間の視覚では捉えきれない色彩分布の全体的な傾向や，
作家ごとの微細な「色の癖」を可視化し，新たな研究の切
り口を発見する可能性がある．
・比較研究への応用
同一の基準で複数の作品を分析することで，時代や流派，
あるいは作家のキャリアを通じた色彩表現の変遷を追跡す
るなど，より広範な比較研究への応用が期待できる．

〇限界
・物理的質感の欠如
本分析はデジタル化された画像データを対象とするため，
絵具の盛り上がり（マチエール）や筆致，キャンバスや和
紙といった支持体の質感など，作品が持つ物理的な情報を
捨象してしまう．
・デジタルデータへの依存
分析結果は，元となるデジタル画像の品質（解像度，色再
現性）に完全に依存する．撮影時の照明や経年による絵具
の退色なども，結果に影響を与えうる．
・芸術的価値の非代替性
本手法による分析は，作品の芸術的価値や感動を代替する
ものではない．色彩の定量化はあくまで作品を理解するた
めの一つの側面に過ぎず，その背景にある歴史的文脈や作
家の思想，そして鑑賞者自身の解釈といった，多角的な視
点と組み合わせて初めてその真価を発揮するものである．

6　おわりに

　本調査では，ImageJ を用いて西洋と日本の名画におけ
る色彩分布の定量的分析を試みた．その結果，西洋絵画の
色彩が連続的に分布するのに対し，日本の浮世絵では複数
の塊として離散的に分布するという明確な差異が示され
た．これは制作技法や様式美を重視する文化的背景を反映
していると考えられる．本手法は，従来の主観的評価を補
完する客観的指標を提供する点で有効性を持つ．今後の展
望として，分析対象を他ジャンルへ拡大すると共に，質感
など他の視覚要素を統合した複合的な分析手法の確立が期
待される．
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付録

csvFilename = ' 星月夜 .csv';

fprintf('MATLAB による色彩分析を開始します ...\n');

if ~isfile(csvFilename)
    error(' エラー : ファイル ''%s'' が見つかりません。\n
このスクリプトと同じフォルダに CSV ファイルを置い
てください。', csvFilename);
end

[~, paintingName, ~] = fileparts(csvFilename);

opts = detectImportOptions(csvFilename);
opts.VariableNamingRule = 'preserve';
dataTable = readtable(csvFilename, opts);
dataTable.Properties.VariableNames =
strtrim(dataTable.Properties.VariableNames);
requiredCols = {'Red', 'Green', 'Blue', '%'};
if ~all(ismember(requiredCols, 
dataTable.Properties.VariableNames))
    error(' エラー : CSV ファイルに必要な列 (Red, Green, 
Blue, %%) が見つかりません。');
end
numRows = height(dataTable);
warm_ratio = 0;
cool_ratio = 0;
neutral_ratio = 0;
for i = 1:numRows
    rgb_normalized = [dataTable.Red(i), 
dataTable.Green(i), dataTable.Blue(i)] / 255.0;
    hsv = rgb2hsv(rgb_normalized);
    H = hsv(1); S = hsv(2); V = hsv(3);
    percentage = dataTable.('%')(i);
    if S < 0.1 || V < 0.1 || V > 0.95
        neutral_ratio = neutral_ratio + percentage;
    elseif (H >= 0 && H < 60/360) || (H >= 330/360 
&& H <= 1)
        warm_ratio = warm_ratio + percentage;
    else
        cool_ratio = cool_ratio + percentage;
    end
end

fprintf('\n--- 分析結果 ---\n');
fprintf('《%s》の色彩構成比率 \n', paintingName); 
fprintf(' 暖色　: %.3f %%\n', warm_ratio);
fprintf(' 寒色　: %.3f %%\n', cool_ratio);
fprintf(' 中性色 : %.3f %%\n', neutral_ratio);
fprintf('----------------\n');
total_ratio = warm_ratio + cool_ratio + neutral_ratio;
fprintf(' 合計　: %.3f %%\n', total_ratio);
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１　はじめに

　近年，アントレプレナーシップ教育(以下，アントレ教育)
の重要性が国内で広く認識されつつある．アントレプレ
ナーシップとは，急速な社会の変化の中で，新たな価値を
生み出していく精神 1) のことを指し，世界各地で教育の重
要なキーワードとして注目されている．日本国内において
も，日本版 EntreComp v12) が確立され，国内におけるア
ントレプレナーシップ精神の醸成を目的に，様々な取り組
みがなされている．
　このように起業環境や起業に対する意識は年々高まりを
見せているが，諸外国と比較すると依然として低い水準に
ある 3)．国内の調査では，失敗に対する恐れや学校教育の
不足 4) などが主な課題として挙げられ，これらをいかに克
服し，アントレプレナーシップ精神を育む教育を確立する
かが，現在の重要な課題となっている．
　こうした背景のもと，日本国内の大学，短期大学，高等
専門学校におけるアントレ教育の現状 5) に注目すると，ア
ントレ教育普及指数は上昇傾向にあり，徐々にではあるが
その普及が見られる．特に高等専門学校 ( 以下，高専 ) で
は 2022 年から高等専門学校スタートアップ教育環境整備
事業 6) といった補助事業が開始され，アントレ教育の取り
組みが急速に拡大している．奈良高専もこの補助事業の対
象となり，高専生が自由な発想で活動ができる「起業家工
房」と呼ばれるモノづくり支援環境の整備が進められてい
る．現在奈良高専では，高い技術力を持つエンジニアを育

成する高専教育の強みを活かし「デジタルファブリケー
ション」を核とした教育や環境整備に力を入れている．し
かし，このような環境が整備されているものの，奈良高専
内におけるアントレプレナーシップ精神の考えが十分に習
得されていないのが現状である．起業家工房の利用率は低
く，利用している学生にも偏りがあり，環境を活かしきれ
ていないケースも見受けられる．この課題解決のためには，
学生自身の考え方が非常に重要であると考えられる．
　そこで本稿では，まず起業家工房を活用したモノづくり，
コトづくり事例を紹介する．そして，奈良高専機械工学科
および専攻科における学生生活，起業家工房の利用・運営
経験を通じて得られた知見をもとに，アントレプレナー
シップ精神を習得するために必要な考え方について考察す
る．

2　デジタルファブリケーションとは

　デジタルファブリケーション ( 以下，デジファブ ) とは
デジタルデータ，機器を活用したモノづくりをする技術 7)

のことである．デジタルデータとは，3DCAD，CAE，
CAM や VR，AR で扱うデータのことを指し，デジタル
機器は 3D プリンタ，レーザー加工機，マシニングセンタ
などのことを指す 8)．このデジファブを活用したモノづく
りを実践することで，従来の製品開発のプロセスである，
構想から設計，試作，検証までのサイクルを迅速かつコス
トを抑えて行うことが可能になる．また近年では，AI を

* システム創成工学専攻機械制御システムコース 2 年

川崎孝太郎 *，須田敦 

Practical Applications for Digital Fabrication in Manufacturing and Service Creation
and the Future of KOSEN Education

Kotaro KAWASAKI*，Atsushi SUDA

　本稿は，奈良高専生活を通して取り組んできた，デジタルファブリケーションを活用したモノづくりやコト
づくりの事例を紹介する．加えて，近年重要視されているアントレプレナーシップについて，奈良高専でのモ
ノづくり・コトづくり経験を通して感じたことについて述べる．それらを踏まえて，今後の奈良高専の学生生
活で，アントレプレナーシップ精神を身に付けるために必要な考え方を自身の経験から考察する．
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活用したモノづくりが急速に発展しており，プロトタイピ
ングの迅速化，効率化が高まっている．デジファブは現在
のモノづくり現場で広く普及，拡大しており，これらを使
いこなすスキルはエンジニアに求められる非常に重要な要
素となっている．
　奈良高専の起業家工房は，学生のモノづくりを推進する
ために開放されており，デジファブ機器が整えられている．
奈良高専の学生は，講義や実習，学生のモノづくりを支援
する取り組みで，起業家工房を活用している．次章では，
起業家工房を用いたモノづくり，コトづくりの事例につい
て紹介する．

3　モノづくり，コトづくり事例

3.1　アイアンマンプロジェクト
　本プロジェクトは，奈良高専のプロモーション，加えて
自身の CAD 技術，モノづくりの知見を深めることを目的
として，令和 5 年度学生アイデアチャレンジの支援のもと，
本科 5 年生時に実施した．
　本プロジェクトは全身に装着できるスーツを 3DCAD，
3D プリンタを用いて，設計・製作した．
　本プロジェクトで製作したスーツは，高専祭，Maker 
Faire Kyoto 2024，テックシーカーコレクション 2024 に
て展示を行った．

　本プロジェクトを通じて，自身の考えを形にし，モノづ
くりにおける設計・製作のプロセスを経験することができ，
EntreComp の「アイデアを作る」スキルが身についた．
またイベントでの出展を通じて，小中学生や保護者の方か
らの注目を得ることができ，奈良高専の魅力を伝えること
ができた．また企業の方と交流し，評価してもらえる機会
を得ることができた．さらに本プロジェクトにおいて使用
した CAD ソフトウェア SOLIDWORKS 社と交流する機
会を得ることができた 9)．ここからさらなるモノづくり，
コトづくりのアイデアや構想を得ることができ，「学びを
得る」スキルが身についた．

3.2　挨拶ゴミ箱ロボットプロジェクト
　本プロジェクトは，地域におけるゴミのポイ捨てやゴミ
箱からの溢れ返りを防止することを目的として，令和 6 年
度学生アイデアチャレンジの支援のもと，専攻科 1 年生時
に実施した．
　本プロジェクトは，ゴミの溢れ返りを防止するための「溢
れ返り防止ゴミ箱」と，ゴミのポイ捨てを防止するロボッ
ト「ぽぺんくん」を製作した．筐体は，3DCAD，3D プリ
ンタ，工作機械による加工で製作した．またマイコンを用
いて，溢れ返り防止ゴミ箱の，投入口の開閉機構の制御，
ぽぺんくんの対話，顔追尾機能の制御を行った．本プロジェ
クトの製作物の概要，機能については日本設計工学会関西
支部にて発表した 10)．

推進するために開放されており，デジファブ機器
が整えられている．奈良高専の学生は，講義や実
習，学生のモノづくりを支援する取り組みで，起
業家工房を活用している．次章では，起業家工房
を用いたモノづくり，コトづくりの事例について
紹介する． 
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図 4  製作スーツ展示の様子(高専祭) 
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　本プロジェクトを通じて，分野の異なる学生を募って
チーム開発をする経験ができ，EntreComp の「今ある資
源を認識する」スキルや「足りない資源を獲得する」スキ
ルが身についた．そしてチーム開発における役割分担やス
ケジュール，予算管理の経験をすることができ，「今ある
資源を活用する」スキルが身についた．加えて，他分野の
学生が集まったチーム開発だったため，分野外の技術や知
識を知ることもできた．また学会発表，プロジェクト最終
報告会にて，製作物に関する議論をすることができ，新た
なビジネスモデルの構想を得ることができた．

3.3　手描きイラストバッグ
　本製作物は，授業で集まったグループワークのメンバー
が書いたイラストをデザインとして，バッグに印刷をした
ものである．
　本製作物は，DTF プリンタを用いて，デジタル端末に
描いたイラストを印刷し，バッグに貼り付けることで製作
された．

　本製作を通じて，デジファブを活用すれば，ひと時の思
い出やある瞬間的なタイミングでしか得られない創作体験
を，形のある作品として残すことができるという，新たな
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活用事例の可能性を見出すことができた．さらに生まれた
アイデアに対して，早期に試作検証を行うことができ，
EntreComp の「試してみる」スキルが身についた．

3.4　ルー BIG キューブプロジェクト
　本プロジェクトは，巨大ルービックキューブで世界記録
を目指すという目的として，令和 7 年度学生アイデアチャ
レンジの支援のもと，専攻科 2 年生時に実施した．
　本プロジェクトは，3DCAD，3D プリンタ，デジタル工
作機械を用いて，巨大ルービックキューブを製作し，複数
人で協力して遊ぶことができるようなイベントを現在企画
中である．

3.5　触覚を使ったパズルゲーム
　本プロジェクトは，視覚障害者と健常者が平等に遊び，
競い合うことができるようなパズルゲームの開発を目的と
し，これまで学校から支援のもと行ったプロジェクトの経
験を活かして，自分自身で自走しているプロジェクトであ
る．
　本プロジェクトは，3DCAD，3D プリンタを用いてパズ
ルゲームの設計・製作を行った．また AR を活用した，複
数人でパズルを解くゲームの製作を行う．
　本プロジェクトは現在進行中であるため，イベント出展
などは行っていないが，製作物が完成次第，イベント出展
を企画する予定である．また自身の力でプロジェクトを自
走するにあたって，あらゆる記事や事例，文献などを調査
する習慣が身につき，EntreComp の「情報を探索する」
スキルが身についた．

4　デジファブ，アントレ教育について

4.1　モノづくり・コトづくり経験を通じて
　デジファブを活用したモノづくり・コトづくりの実践を
通じて，以下に示す多様な知識と技術に加え，アントレプ
レナーシップに対する考えである，EntreComp に記載さ
れているコアスキルを身につけることができた．
　1 点目は，アイデア構想から設計，製造，検証に至るモ
ノづくりの一連のプロセスを経験することで「アイデアを
作る」スキルが身についた点である．これらの経験は現場
での製品開発における実践力を培うことができた．このよ
うな経験の有無は，プロジェクトを進める際の，課題発見，
解決する力において，大きな差をもたらすと考えられる．
　2 点目は，設計手法や製造に関わる知見を実際に作業す
ることで得られ，「不確実性，曖昧さ，リスクを見極める」
スキルが身についた点である．実際に手を動かして作って
みることで初めて得られる知見は，講義や教科書で学ぶ，
Youtube などの SNS を見るだけでは得られないため非常
に貴重である．
　3 点目は，コミュニケーション能力である．まずは自分
自身のビジネスモデルやしたいこと，プロジェクトの成果
を発表することで，相手に意見や考えをプレゼンする能力
が育まれた．またプロジェクトをチームで進めていく時や，
成果発表で企業関係者と議論する機会を持つことで，異な

る分野や背景を持つ学生や企業の方の，意見や考え方を知
ることができ視野を広げることができた．これは「学びを
得る」「足りない資源を獲得する」スキルに相当すると考
えられる．
　4 点目は，これまでのプロジェクト立ち上げの経験から，
自ら課題を発見，分析し，それに対しての解決方法を考え，
新たな価値を見出す力を培うことができた．この力は，実
際にゼロから自分の力で調査し，経験を積むことで培われ
てきたと考えられる．これは「問いを立てる」「情報を探
索する」スキルに相当すると考えられる．またプロジェク
トマネジメントにおいて，専攻科の講義で学んだ PMBOK
の知識を活かし，前述した様々なプロジェクトに横展開で
き，「今ある資源を活用する」スキルを身につけることが
できた．
　以上の経験から，技術の習得，向上だけでなく，アイデ
アの創造力，課題発見から解決する能力，協働力といった，
アントレプレナーシップ教育の核とも言える要素を育むこ
とができた．また奈良高専のデジファブ活動を主体的に行
うことで，EntreComp に定められているコアスキルを自
然と身に付けることができたと考える．今後，社会進出し
ていく中で，製品開発，事業企画に携わる際，これらの学
びや経験は，自身の中で大きな基盤になると考えられる．

4.2　アントレプレナーシップ習得に向けて
　まず前提として，アントレプレナーシップ精神の習得は，
起業を目的としたものに限らない．アントレ教育と聞くと，
学生の起業を促進する教育というイメージを持つ人も少な
くない．しかしアントレプレナーシップとは，前述の通り，
新たな価値を創造する考え方を指す．そのため，自身で会
社を立ち上げることだけでなく，社内で新たなプロジェク
トを始める，新商品，新製品を開発するなど，社会課題や
目標に対して自ら課題解決策を見出す力こそがアントレプ
レナーシップ精神である．よって学生に限らず，全ての人々
にとって社会を生き抜くために必要な考え方である．
　そして奈良高専の学生が，これからアントレプレナー
シップ精神を身に付けるために特に重要であると考える以
下の 2 点について述べる．
　1 点目は，1 歩先を見据えて考える力である．高専は一
般高校と比べ，早期に専門科目の講義が始まり，カリキュ
ラムの進行も速いため，難易度の高い内容に苦労する学生
も多い．その結果，テストのためだけに勉強を進めてしま
い，内容の本質的な理解が乏しくなる傾向がある．こうし
た学び方では，自ら考える力が育まれず，卒業研究などで
必要な知識や技術が活用できずに苦労するケースが散見さ
れる．
　このような状況を改善するためには，1 歩先を見据えて
考える力が重要であると考える．例えば，材料力学で学ぶ
力のつり合いやたわみの方程式が，実際の橋梁設計を行う
際にどのように応用されているかを考えることで，学びの
意味を深めることができる．学んだ知識が社会でどのよう
に活用されているかを意識することで，学習の目的が明確
になり，主体的な学びにつながると考えられる．
　この力は，勉強だけでなくモノづくり活動にも重要であ
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ると考える．奈良高専内にある起業家工房は，多くの工作
機械が整備されているが，利用者は少なく，高専内におい
ても知名度が低い現状にある．これは学生が「何ができる
のか」「何をしたいのか」を考える機会が少ないことが原
因であると考えられる．工作機械はあくまで手段の一つで
あり，それを使って何を作り，どのような価値を生み出す
かを考えることが重要であると考えられる．学生自身が 1
歩先の目的を意識することで，勉強やその他の活動におい
ても，アントレプレナーシップ精神が育まれていくと考え
られる．
　2 点目は，かけ合わせる力である．これはエフェクチュ
エーションと呼ばれ，「今あるもので何ができるか」とい
う手段主導でアイデアを発想する手法 11) である．前述し
た 1 歩先を見据える力について，この力を発揮するために
は，そもそも目標や，やりたいことが必要である．しかし
学生の中には，明確な目標や興味を持てない場合もある．
そのような場合に重要なのが，インプットを増やすことで
ある．高専の講義や，学内のイベントにとどまらず，学外
のイベントや他分野の人々との交流を通じて，多様な知識
や価値観に触れることができる．こうした経験を積むこと
で広い視野を持つことができ，新たなアイデアが生まれる
のではないかと考えられる．
　さらに，得られた知見同士をかけ合わせる力も重要であ
ると考えられる．既存の技術やアイデアを組み合わせるこ
とで独自性のある新たな価値を創造することができると考
えられる．高専生活の中で，こうした「かけ合わせ」の経
験を繰り返すことで，創造的思考力が育まれ，アントレプ
レナーシップ精神の習得につながると考える．
　以上のように，日々の講義や学生生活の中で，自ら問い
や目標を立て，一歩先を見据えて考える力を養う．そして，
多様なインプットを得て，それらをかけ合わせて新たなア
イデアを生み出す力を育もうとする意識が，アントレプレ
ナーシップ精神の習得において非常に重要であると考え
る．これらの力を高専生活の中で培うことができれば，社
会に新たな価値を提供できる人材として成長できると考え
られる．

6　おわりに

　本稿では，奈良高専におけるアントレプレナーシップ教
育の現状と課題を踏まえ，起業家工房を活用したモノづく
り，コトづくりの事例を紹介するとともに，アントレプレ
ナーシップ精神を育むために必要な考え方について，自身
の経験をもとに考察した．高専で学んだ知識や経験を活か
し，社会に貢献できる人材を目指し，今後も学び続ける姿
勢を大切にしていきたいと考える．
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( 参照日 2025 年 9 月 18 日 ).

8)　�総務省，第 1 部 特集 IoT・ビッグデータ・AI 〜ネッ
トワークとデータが創造する新たな価値〜 (online), 
ava i lab le  f rom <https ://www.soumu.go . jp/
johotsusintokei/whitepaper/ja/h28/html/nc141330.
html> ( 参照日 2025 年 10 月 2 日 )．

9)　�SOLIDWORKS，奈良工業高等専門学校 価値を創造す
る力を持った人材を育てる (online), available from 
<h t t p s : / /www . s o l i dwo r k s . c om/ j a / s t o r y /
Narakousen> ( 参照日 2025 年 10 月 3 日 )

10) �川崎孝太郎，荒井将貴，井原実咲，濱田壮汰，環境問
題の解決を目指した次世代型ゴミ箱の提案，日本設計
工学会 2025 年度春季研究発表講演会 (2025)．

11) �吉田満梨，起業家活動の成功の向こう側へ―エフェク
チュエーション研究の現状と可能性―，日本ベン
チャー学会誌，Vol.39 (2022), pp.15-30．

季 七 恋 旅 述 植 動 山 水 居 降 聳 光 神 釈 人 名 衣 時 夜 風 聞

51 いたつらの ことのはおほき ふてのあと 恋

52 つたはりくれは そののりもなし 釈

53 きくやたれ とほやまてらの かねのこゑ 山 釈 人 夜 聞

54 あかつきつつききは われのみもみし 秋 月 光 人 △ 夜

55 あやにくに あきのそらなと しくるらむ 秋 降

56 つゆけくわくる のへのゆくすゑ 秋 旅 降

57 ふるさとも かからはよしや たひのくれ 旅 居 夕

58 たかつらさとか みのうきをしる 恋 人

59 さきのよや ひとにおもひを つけつらむ 恋 人

60 ははななのみやこの あとのまつかせ 春 松 木 風

61 はるふかき しかのやまもと うらさひて 春 山 水 名

62 かすみのいつく わたりするふね 春 船 水 聳

63 おきいつる をちのさとさと こゑすなり 旅 居 夜 聞

64 みはよもきふに あかすよそうき 草 □ 人 △ 夜

65 わかこころ つつききはみるやと かけすみて 秋 月 光 人 夜

66 かせひややかに あきふくるころ 秋 風

67 をしかなく やまはゆふへの いかはかり 秋 獣 山 夕

68 おもひいるへき よのほかやなき 述

69 うきもたた ゆめのやとりを なけくなよ 夢 ×

70 さなからそても あめのこのもと 木 降 衣

71 うめのはな たかたをれはや しをるらむ 春 木 人

72 かへるをうらむ はるのうくひす 春 鳥

73 かすみにも いまはとかりの やすらはて 春 鳥 聳

74 すゑにいかなる やまをこえなむ 旅 山

75 さえむかふ あらしにわひて まよふのに 冬 旅 風

76 ひくれにかかる みちのものうさ □ 夕

77 まきるやと たのむひとめも かけたえて 恋 人

78 こひしきことを たれにわすれむ 恋 人

79 つらしとて またいつかたに うつらまし 恋

80 なれこしいほり まつかせもふけ 松 木 居 風

81 こころこそ なくともつつききに ゆめやみむ 秋 月夢 光 夜

82 をはすてやまの あきのかりふし 秋 旅 山 名

83 ころもうつ おとさへたひの うらみにて 秋 衣 旅 衣 聞

84 とほさかりきぬ いももまつらむ 恋 人

85 かはらしと いひしをいまも たのむよに 恋

86 しひしはそよく こからしのかせ 冬 木 風

87 はつしもの そののかしとり あさりして 冬 □ 鳥 × 降

88 みやまつたひの かたはらのさと 山 居

89 のきちかく かけひはかりの みつおちて 水 居

90 たけのはみたれ あめすくるおと 竹 竹 降 聞

91 めさまして つゆはらふよや ふけぬらむ 秋 降 夜

92 にしふくかせに つつききほそきそら 秋 月 光 夜 風

93 あききぬと おもへはゆふへ みにしみて 秋 人 夕

94 すすろにこころ なにうかるらむ

95 とほくみて ははななやそれとも しらくもに 春 木 聳

96 むらむらかすむ やまのときはき 春 木 山 聳

97 かけたかき かみのみやたち はるをへて 春 神

98 みなみまつりを あふかぬはなし 春 神

99 わかひとと わけてちかひの すゑひさに 人

00 ゆみとるみちそ もとをつとむる

名
　
裏

「小松原独吟」去嫌一覧（Ⅱ）

三
　
表

三
　
裏

名
　
表
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季 七 恋 旅 述 植 動 山 水 居 降 聳 光 神 釈 人 名 衣 時 夜 風 聞

51 いたつらの ことのはおほき ふてのあと 恋

52 つたはりくれは そののりもなし 釈

53 きくやたれ とほやまてらの かねのこゑ 山 釈 人 夜 聞

54 あかつきつつききは われのみもみし 秋 月 光 人 △ 夜

55 あやにくに あきのそらなと しくるらむ 秋 降

56 つゆけくわくる のへのゆくすゑ 秋 旅 降

57 ふるさとも かからはよしや たひのくれ 旅 居 夕

58 たかつらさとか みのうきをしる 恋 人

59 さきのよや ひとにおもひを つけつらむ 恋 人

60 ははななのみやこの あとのまつかせ 春 松 木 風

61 はるふかき しかのやまもと うらさひて 春 山 水 名

62 かすみのいつく わたりするふね 春 船 水 聳

63 おきいつる をちのさとさと こゑすなり 旅 居 夜 聞

64 みはよもきふに あかすよそうき 草 □ 人 △ 夜

65 わかこころ つつききはみるやと かけすみて 秋 月 光 人 夜

66 かせひややかに あきふくるころ 秋 風

67 をしかなく やまはゆふへの いかはかり 秋 獣 山 夕

68 おもひいるへき よのほかやなき 述

69 うきもたた ゆめのやとりを なけくなよ 夢 ×

70 さなからそても あめのこのもと 木 降 衣

71 うめのはな たかたをれはや しをるらむ 春 木 人

72 かへるをうらむ はるのうくひす 春 鳥

73 かすみにも いまはとかりの やすらはて 春 鳥 聳

74 すゑにいかなる やまをこえなむ 旅 山

75 さえむかふ あらしにわひて まよふのに 冬 旅 風

76 ひくれにかかる みちのものうさ □ 夕

77 まきるやと たのむひとめも かけたえて 恋 人

78 こひしきことを たれにわすれむ 恋 人

79 つらしとて またいつかたに うつらまし 恋

80 なれこしいほり まつかせもふけ 松 木 居 風

81 こころこそ なくともつつききに ゆめやみむ 秋 月夢 光 夜

82 をはすてやまの あきのかりふし 秋 旅 山 名

83 ころもうつ おとさへたひの うらみにて 秋 衣 旅 衣 聞

84 とほさかりきぬ いももまつらむ 恋 人

85 かはらしと いひしをいまも たのむよに 恋

86 しひしはそよく こからしのかせ 冬 木 風

87 はつしもの そののかしとり あさりして 冬 □ 鳥 × 降

88 みやまつたひの かたはらのさと 山 居

89 のきちかく かけひはかりの みつおちて 水 居

90 たけのはみたれ あめすくるおと 竹 竹 降 聞

91 めさまして つゆはらふよや ふけぬらむ 秋 降 夜

92 にしふくかせに つつききほそきそら 秋 月 光 夜 風

93 あききぬと おもへはゆふへ みにしみて 秋 人 夕

94 すすろにこころ なにうかるらむ

95 とほくみて ははななやそれとも しらくもに 春 木 聳

96 むらむらかすむ やまのときはき 春 木 山 聳

97 かけたかき かみのみやたち はるをへて 春 神

98 みなみまつりを あふかぬはなし 春 神

99 わかひとと わけてちかひの すゑひさに 人

00 ゆみとるみちそ もとをつとむる

名
　
裏

「小松原独吟」去嫌一覧（Ⅱ）

三
　
表

三
　
裏

名
　
表

季 七 恋 旅 述 植 動 山 水 居 降 聳 光 神 釈 人 名 衣 時 夜 風 聞

51 いたつらの ことのはおほき ふてのあと 恋

52 つたはりくれは そののりもなし 釈

53 きくやたれ とほやまてらの かねのこゑ 山 釈 人 夜 聞

54 あかつきつつききは われのみもみし 秋 月 光 人 △ 夜

55 あやにくに あきのそらなと しくるらむ 秋 降

56 つゆけくわくる のへのゆくすゑ 秋 旅 降

57 ふるさとも かからはよしや たひのくれ 旅 居 夕

58 たかつらさとか みのうきをしる 恋 人

59 さきのよや ひとにおもひを つけつらむ 恋 人

60 ははななのみやこの あとのまつかせ 春 松 木 風

61 はるふかき しかのやまもと うらさひて 春 山 水 名

62 かすみのいつく わたりするふね 春 船 水 聳

63 おきいつる をちのさとさと こゑすなり 旅 居 夜 聞

64 みはよもきふに あかすよそうき 草 □ 人 △ 夜

65 わかこころ つつききはみるやと かけすみて 秋 月 光 人 夜

66 かせひややかに あきふくるころ 秋 風

67 をしかなく やまはゆふへの いかはかり 秋 獣 山 夕

68 おもひいるへき よのほかやなき 述

69 うきもたた ゆめのやとりを なけくなよ 夢 ×

70 さなからそても あめのこのもと 木 降 衣

71 うめのはな たかたをれはや しをるらむ 春 木 人

72 かへるをうらむ はるのうくひす 春 鳥

73 かすみにも いまはとかりの やすらはて 春 鳥 聳

74 すゑにいかなる やまをこえなむ 旅 山

75 さえむかふ あらしにわひて まよふのに 冬 旅 風

76 ひくれにかかる みちのものうさ □ 夕

77 まきるやと たのむひとめも かけたえて 恋 人

78 こひしきことを たれにわすれむ 恋 人

79 つらしとて またいつかたに うつらまし 恋

80 なれこしいほり まつかせもふけ 松 木 居 風

81 こころこそ なくともつつききに ゆめやみむ 秋 月夢 光 夜

82 をはすてやまの あきのかりふし 秋 旅 山 名

83 ころもうつ おとさへたひの うらみにて 秋 衣 旅 衣 聞

84 とほさかりきぬ いももまつらむ 恋 人

85 かはらしと いひしをいまも たのむよに 恋

86 しひしはそよく こからしのかせ 冬 木 風

87 はつしもの そののかしとり あさりして 冬 □ 鳥 × 降

88 みやまつたひの かたはらのさと 山 居

89 のきちかく かけひはかりの みつおちて 水 居

90 たけのはみたれ あめすくるおと 竹 竹 降 聞

91 めさまして つゆはらふよや ふけぬらむ 秋 降 夜

92 にしふくかせに つつききほそきそら 秋 月 光 夜 風

93 あききぬと おもへはゆふへ みにしみて 秋 人 夕

94 すすろにこころ なにうかるらむ

95 とほくみて ははななやそれとも しらくもに 春 木 聳

96 むらむらかすむ やまのときはき 春 木 山 聳

97 かけたかき かみのみやたち はるをへて 春 神

98 みなみまつりを あふかぬはなし 春 神

99 わかひとと わけてちかひの すゑひさに 人

00 ゆみとるみちそ もとをつとむる

名
　
裏

「小松原独吟」去嫌一覧（Ⅱ）

三
　
表

三
　
裏

名
　
表
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季 七 恋 旅 述 植 動 山 水 居 降 聳 光 神 釈 人 名 衣 時 夜 風 聞

01 かけすすし なほこたかかれ こまつはら 夏 松 木

02 かせしつかなる ゆふたちのあと 風×降夏

03 まちいつる とやまのつきに くもきえて 秋 月 山 聳 光 夜

04 ふかきみねさへ あきそしらるる 秋 山

05 すさましき なかれやたきの すゑならむ 秋 山 水

06 おとはうもれぬ いはのしたみつ 聞水

07 ふるもまた こほるはかりの ゆきならて 降冬

08 かれはにかかる ささわくるみち 冬 竹

09 あさたては かせはそてふく のをとほみ 風朝衣旅

10 ねしさといつく あともしられす 夜居旅

11 みるかうちは むかしともなき ゆめさめて 夜述夢

12 そのひとならぬ おもかけそうき 人恋

13 きのふけふ なれきてなにか にくからむ 恋

14 おもふあまりの うらみとをしれ 恋

15 よしやはな ちらはそれとも うちわひて 春 木

16 ひとりくらせる ふるさとのはる 人居春

17 かすむなよ やまになくさむ まとのまへ 春 山 居 聳

18 きゆれはつきを ともしひのもと 夜光月秋

19 つりふねも こころややとす あきのうみ 秋 船 水

20 ゆふなみきよく かりわたるそら 夕水鳥秋

21 はれのほる きりのむらあし かせみえて 風聳□草秋

22 またかきみたれ しくれてそゆく 降冬

23 ふりすてし そてはたかよに ひかるらむ 衣人述

24 みはしのふへき いにしへもなし 人述

25 いつくにて すめるもかりの くさのとに × 居

26 こころとまるは たたやまのかけ 山

27 とりのねも ゆふくれふかき はなにきて 聞夕鳥木春

28 かすむをみれは つきそほのめく 夜光聳月春

29 はるのよを おもはぬひとや またるらむ 夜人恋春

30 ともにあはれむ ちきりならはや 恋

31 わするとて それにならはむ こともなし 恋

32 うらみのほとは しられこそせめ 恋

33 おほよとの まつによるなみ さわくなよ 松 木 水 名

34 みるめもくるし かせにゆくふね 風水□船

35 こえかたき あきのやまちに やすらひて 秋 旅 山

36 かりねのたもと つきにしをるる 夜衣光旅

旅

月秋

37 いほちかく むしもわひつつ あかすよに 夜△居虫秋

38 ゆめになされは おもひならめや 夜恋夢

39 うかれたた さらすはいひも たえつへし 恋

40 すましみやこの おいのあらまし 述

41 つれなくや ひとことにみむ わかいのち 人述

42 をしみかなしむ はるあきのそら ×

×

43 やまさとに ふれはくさきを こころにて 草木 山 居

44 おもふことなき みそしつかなる 人

45 みたれしも またをさまれる きみかよに

46 いまよりみちの すゑたたしかれ

47 まちまちし ひよりをけふの ふねにえて 船 水 □

48 なみなれころも はかなくそほす 衣水衣

49 こひはふち かりのあふせを たのむなよ 恋 水

50 うきひとこころ なにかつねなる 人恋

「小松原独吟」去嫌一覧（Ⅰ）

初
　
表

初
　
裏

二
　
裏

二
　
表

季 七 恋 旅 述 植 動 山 水 居 降 聳 光 神 釈 人 名 衣 時 夜 風 聞

01 かけすすし なほこたかかれ こまつはら 夏 松 木

02 かせしつかなる ゆふたちのあと 風×降夏

03 まちいつる とやまのつきに くもきえて 秋 月 山 聳 光 夜

04 ふかきみねさへ あきそしらるる 秋 山

05 すさましき なかれやたきの すゑならむ 秋 山 水

06 おとはうもれぬ いはのしたみつ 聞水

07 ふるもまた こほるはかりの ゆきならて 降冬

08 かれはにかかる ささわくるみち 冬 竹

09 あさたては かせはそてふく のをとほみ 風朝衣旅

10 ねしさといつく あともしられす 夜居旅

11 みるかうちは むかしともなき ゆめさめて 夜述夢

12 そのひとならぬ おもかけそうき 人恋

13 きのふけふ なれきてなにか にくからむ 恋

14 おもふあまりの うらみとをしれ 恋

15 よしやはな ちらはそれとも うちわひて 春 木

16 ひとりくらせる ふるさとのはる 人居春

17 かすむなよ やまになくさむ まとのまへ 春 山 居 聳

18 きゆれはつきを ともしひのもと 夜光月秋

19 つりふねも こころややとす あきのうみ 秋 船 水

20 ゆふなみきよく かりわたるそら 夕水鳥秋

21 はれのほる きりのむらあし かせみえて 風聳□草秋

22 またかきみたれ しくれてそゆく 降冬

23 ふりすてし そてはたかよに ひかるらむ 衣人述

24 みはしのふへき いにしへもなし 人述

25 いつくにて すめるもかりの くさのとに × 居

26 こころとまるは たたやまのかけ 山

27 とりのねも ゆふくれふかき はなにきて 聞夕鳥木春

28 かすむをみれは つきそほのめく 夜光聳月春

29 はるのよを おもはぬひとや またるらむ 夜人恋春

30 ともにあはれむ ちきりならはや 恋

31 わするとて それにならはむ こともなし 恋

32 うらみのほとは しられこそせめ 恋

33 おほよとの まつによるなみ さわくなよ 松 木 水 名

34 みるめもくるし かせにゆくふね 風水□船

35 こえかたき あきのやまちに やすらひて 秋 旅 山

36 かりねのたもと つきにしをるる 夜衣光旅

旅

月秋

37 いほちかく むしもわひつつ あかすよに 夜△居虫秋

38 ゆめになされは おもひならめや 夜恋夢

39 うかれたた さらすはいひも たえつへし 恋

40 すましみやこの おいのあらまし 述

41 つれなくや ひとことにみむ わかいのち 人述

42 をしみかなしむ はるあきのそら ×

×

43 やまさとに ふれはくさきを こころにて 草木 山 居

44 おもふことなき みそしつかなる 人

45 みたれしも またをさまれる きみかよに

46 いまよりみちの すゑたたしかれ

47 まちまちし ひよりをけふの ふねにえて 船 水 □

48 なみなれころも はかなくそほす 衣水衣

49 こひはふち かりのあふせを たのむなよ 恋 水

50 うきひとこころ なにかつねなる 人恋

「小松原独吟」去嫌一覧（Ⅰ）

初
　
表

初
　
裏

二
　
裏

二
　
表

22

- 13 -

奈良工業高等専門学校　研究年報　第２号（2025）



《
解�

釈
》
秋
の
夜
、ふ
と
目
を
覚
ま
す
。
夜
は
か
な
り
更
け
て
い
る
ら
し
い
。
床
の
あ
た
り
は
露
で
い
っ

ぱ
い
だ
。
西
風
が
吹
き
、
東
の
空
に
は
有
明
の
月
が
細
く
光
を
放
っ
て
い
る
。

※�
現
代
人
に
は
、
「
夜
が
更
け
る
」
と
い
う
の
は
夜
半
（
午
前
零
時
）
ま
で
か
も
し
れ
な
い
が
、
古

典
文
学
で
は
、
午
前
零
時
を
過
ぎ
て
も
「
夜
更
く
る
」
と
い
う
。
解
り
や
す
い
例
を
挙
げ
る
と
、

「
あ
だ
人
を
待
つ
夜
更
け
ゆ
く
山
の
端
に
そ
ら
だ
の
め
せ
ぬ
有
明
の
月
」
（
新
勅
撰
・
一
五
‐

九
六
四
、
嘉
陽
門
院
越
前
）
な
ど
。
月
令
に
も
よ
る
が
、
「
有
明
」
と
呼
ば
れ
る
月
が
見
え
る
の

は
、
お
お
よ
そ
午
前
三
時
以
降
で
あ
る
。
以
上
、
若
い
人
の
た
め
。

※�

近
代
の
注
釈
は
「
西
の
空
に
残
る
月
の
な
ん
と
細
い
こ
と
よ
」
と
解
釈
す
る
が
、
何
か
の
カ
ン
違

い
。
夜
が
更
け
て
見
え
る
細
い
月
（
有
明
）
は
東
に
見
え
る
。
『
枕
草
子
』
二
五
三
段
に
「
月
は

有
明
の
東
の
山
ぎ
は
に
細
く
て
出
づ
る
ほ
ど
」
云
々
と
あ
る
ご
と
く
で
あ
る
。

　
　
　
　
　

西
吹
く
風
に
月
ほ
そ
き
空

　
　

93　

秋
来
ぬ
と
思
へ
ば
夕
べ
身
に
し
み
て

《
解�

釈
》
昼
間
は
、
ま
だ
夏
と
変
わ
ら
な
い
暑
さ
で
あ
る
が
、
夕
方
に
な
る
と
、
秋
の
来
た
こ
と
が

身
に
し
み
て
感
じ
ら
れ
る
。
西
か
ら
吹
く
風
は
冷
や
や
か
で
、
次
第
に
暗
く
な
っ
て
ゆ
く
空
に
は
、

月
が
細
く
光
を
放
っ
て
い
る
。

※�

前
句
の
「
月
」
は
、
先
の
付
合
で
は
有
明
月
。
こ
の
付
合
で
は
、
月
令
三
日
～
四
日
の
月
に
な
る
。

※�

「
西
」
に
「
秋
来
る
」
が
寄
合
。
例
は
「
月
は
西
な
る
梢
落
ち
ゆ
く
／
秋
き
て
は
い
か
ゞ
寝
ま
し

の
叫
ぶ
夜
に
」（
文
安
四
年
八
月
十
九
日
「
何
人
」
六
八
／
六
九
）
な
ど
。
た
だ
し
「
東
風
（
こ
ち
）

が
吹
い
て
春
が
来
る
の
だ
か
ら
、
西
風
が
吹
け
ば
秋
が
く
る
理
屈
だ
」
と
い
う
地
下
連
歌
師
流
の

知
識
に
よ
る
も
の
ら
し
く
、
適
当
な
証
歌
を
挙
げ
る
こ
と
が
で
き
な
い
。

　
　
　
　
　

秋
来
ぬ
と
思
へ
ば
夕
べ
身
に
し
み
て

　
　

94　

す
ゞ
ろ
に
心
何
う
か
る
ら
む

《
解�

釈
》
昼
間
は
ま
だ
夏
と
変
わ
ら
な
い
暑
さ
だ
が
、
夕
方
に
な
る
と
秋
の
来
た
こ
と
が
身
に
し
み

て
感
じ
ら
れ
る
。
何
と
な
く
感
傷
的
な
気
分
に
な
る
の
は
、
や
は
り
秋
だ
か
ら
だ
ろ
う
か
。

　
　
　
　
　

す
ゞ
ろ
に
心
何
う
か
る
ら
む

　
　

95　

遠
く
見
て
花
や
そ
れ
と
も
白
雲
に

《
解�

釈
》
花
の
咲
く
季
節
と
な
っ
た
。
遠
く
の
山
に
白
い
雲
が
か
か
っ
て
い
る
の
を
見
る
と
、ひ
ょ
っ

と
し
て
花
が
咲
い
た
の
で
は
あ
る
ま
い
か
と
、
判
然
と
せ
ぬ
ま
ま
、
何
故
か
心
が
浮
か
れ
る
。

※�

前
句
の
「
う
か
る
ら
む
」
は
、
先
の
付
合
で
は
「
憂
か
る
ら
む
」
、
そ
れ
を
「
浮
か
る
ら
む
」
に

取
り
な
し
て
、
句
境
を
鮮
や
か
に
転
換
し
て
い
る
。

※�

付
句
の
「
白
雲
」
の
「
し
ら
」
に
は
、
動
詞
「
知
る
」
の
未
然
形
「
し
ら
」
が
重
ね
ら
れ
、
「
そ

れ
と
も
知
ら
な
い
→
白
雲
」
と
い
う
秀
句
仕
立
に
な
っ
て
い
る
。
「
行
く
方
も
い
さ
白
雲
の
奥
に

し
て
」
（
応
仁
二
年
十
二
月
「
何
人
」
六
九
）
な
ど
、
よ
く
用
い
ら
れ
る
手
法
で
あ
る
。

　
　
　
　
　

遠
く
見
て
花
や
そ
れ
と
も
白
雲
に

　
　

96　

む
ら
〳
〵
霞
む
山
の
と
き
は
木

《
解�

釈
》
花
の
咲
く
季
節
と
な
っ
た
。
遠
く
の
山
に
白
い
雲
が
か
か
っ
て
い
る
の
が
見
え
た
。
ひ
ょ
っ

と
し
て
花
が
咲
い
た
の
で
は
あ
る
ま
い
か
と
、
判
然
と
せ
ぬ
ま
ま
近
づ
く
と
、
そ
れ
は
、
山
の

常
緑
樹
が
霞
に
包
ま
れ
て
、
桜
花
の
よ
う
に
む
ら
む
ら
と
見
え
た
だ
け
だ
っ
た
。

※�

前
句
の
「
遠
し
」
に
「
山
」
、
「
花
」
に
「
と
き
は
木
」
、
「
白
」
に
「
霞
む
」
、
「
雲
」
に
「
む
ら
む

ら
」
と
語
を
対
応
さ
せ
る
の
が
主
眼
で
、
そ
れ
は
そ
れ
で
一
興
で
あ
る
が
、
意
味
的
に
は
そ
う
緊

密
で
は
な
い
付
合
で
あ
る
。

　
　
　
　
　

む
ら
〳
〵
霞
む
山
の
と
き
は
木

　
　

97　

か
げ
高
き
神
の
宮
だ
ち
春
を
経
て

《
解�

釈
》
山
の
常
緑
樹
が
、
む
ら
む
ら
に
霞
ん
で
見
え
る
。
そ
の
山
に
、
神
社
の
社
殿
が
影
高
く
営

ま
れ
て
い
る
。
あ
の
神
社
は
、
こ
こ
に
御
鎮
座
以
来
、
一
体
、
幾
春
を
経
て
い
る
の
で
あ
ろ
う
か
。

　
　
　
　
　

か
げ
高
き
神
の
宮
だ
ち
春
を
経
て

　
　

98　

南
祭
を
あ
ふ
が
ぬ
は
な
し

《
解�

釈
》
石
清
水
八
幡
宮
の
社
殿
は
、
創
建
以
来
、
多
く
の
春
を
経
て
、
今
も
男
山
の
山
上
に
影
高

く
鎮
座
す
る
。
今
年
も
臨
時
祭
が
催
行
さ
れ
る
が
、
世
の
誰
し
も
が
そ
れ
を
仰
ぎ
見
る
の
だ
。

※�

前
句
の
「
神
の
宮
だ
ち
」
を
、
石
清
水
八
幡
宮
の
社
殿
と
し
た
付
合
で
あ
る
。
京
都
府
八
幡
市
の

男
山
山
上
に
鎮
座
。
武
家
、
特
に
清
和
源
氏
一
流
の
氏
神
と
し
て
尊
崇
さ
れ
た
。

※�

近
代
の
注
は
付
句
を
無
季
（
雑
）
と
す
る
が
、
何
か
の
カ
ン
違
い
で
あ
ろ
う
。
石
清
水
臨
時
祭
は

三
月
中
午
日
、
当
然
春
季
で
あ
る
（
『
宗
祇
名
作
百
韻
注
釈
』
四
七
八
ペ
ー
ジ
）
。

　
　
　
　
　

南
祭
を
あ
ふ
が
ぬ
は
な
し

　
　

99　

我
が
人
と
わ
け
て
誓
ひ
の
末
久
に

《
解�

釈
》
八
幡
大
菩
薩
は
、
そ
の
昔
、
清
和
源
氏
の
人
々
を
自
分
の
氏
人
と
し
て
特
別
に
擁
護
す
る

と
い
う
永
遠
の
御
誓
願
を
お
立
て
に
な
っ
た
。
だ
か
ら
、
清
和
源
氏
の
流
れ
を
く
む
人
々
は
、

誰
し
も
が
石
清
水
臨
時
祭
を
祝
い
仰
ぐ
の
だ
。

※�

付
句
の
仕
立
は
「
人
よ
り
も
我
が
人
な
れ
ば
石
清
水
き
よ
き
流
れ
の
末
ま
も
る
ら
む
」
（
新
千
載
・

一
〇
‐
一
〇
〇
九
、
等
持
院
贈
左
大
臣
）
に
依
拠
す
る
。
内
容
も
こ
の
和
歌
に
依
り
明
白
。

　
　
　
　
　

我
が
人
と
わ
け
て
誓
ひ
の
末
久
に

　
　

00　

弓
と
る
道
ぞ
本
を
つ
と
む
る

《
解�

釈
》
武
芸
に
よ
っ
て
君
辺
を
守
護
し
奉
る
の
が
武
家
の
本
分
。
そ
の
本
分
を
懈
怠
な
く
務
め
る

か
ら
こ
そ
、
清
和
源
氏
の
人
々
を
自
分
の
氏
人
と
し
て
特
別
に
擁
護
す
る
と
い
う
八
幡
大
菩
薩

の
御
誓
願
は
、
永
遠
で
あ
る
の
だ
。

※�
付
句
の
仕
立
は
『
論
語
』
学
而
編
に
見
え
る
「
君
子
務
本
、
本
立
而
道
生
」
の
章
句
に
基
く
。

※�

「
末
」
と
「
本
」
と
が
対
比
的
な
寄
合
。
他
の
例
は
「
生
野
の
末
に
宿
を
こ
そ
と
へ
／
き
り
〴
〵
す

浅
茅
が
本
に
な
が
ら
へ
て
」（
宝
徳
四
年
千
句
・
第
六
「
朝
何
」
三
六
／
三
七
）
な
ど
。
同
時
に
「
末
」

に
「
弓
」
も
寄
合
。
他
の
例
は
「
は
か
な
く
な
る
は
二
道
の
末
／
梓
弓
お
し
出
だ
す
船
も
力
に
て
」

（
聖
廟
千
句
・
第
十
「
二
字
反
音
」
五
二
／
五
三
）
な
ど
。
共
に
、
証
歌
の
必
要
は
あ
る
ま
い
。
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《
解�

釈
》
已
む
を
得
ぬ
事
情
で
遠
く
離
れ
て
暮
ら
さ
ね
ば
な
ら
な
い
二
人
で
あ
る
が
、
あ
の
人
は
、

今
も
き
っ
と
私
が
帰
る
の
を
待
っ
て
く
れ
て
い
る
こ
と
だ
ろ
う
。
「
心
が
変
わ
る
こ
と
は
あ
り
ま

せ
ん
」
と
い
う
あ
の
人
の
言
葉
を
、
私
は
今
も
信
じ
て
い
ま
す
。

　
　
　
　
　

変
は
ら
じ
と
言
ひ
し
を
今
も
た
の
む
世
に

　
　

86　

椎
柴
そ
よ
ぐ
凩
の
風

《
解�

釈
》
凩
が
椎
の
木
の
群
れ
を
そ
よ
が
せ
る
。
椎
は
、
こ
れ
か
ら
来
年
に
か
け
て
葉
替
え
を
す
る

こ
と
で
し
ょ
う
。
し
か
し
、
私
は
今
も
「
心
が
変
わ
る
こ
と
は
あ
り
ま
せ
ん
」
と
い
う
あ
の
人

の
言
葉
を
信
じ
て
い
ま
す
。

※�

「
箸
鷹
の
と
が
へ
る
山
の
椎
柴
の
葉
替
へ
は
す
と
も
君
は
替
へ
せ
じ
」
（
拾
遺
・
一
九
‐

一
二
三
〇
、
よ
み
人
し
ら
ず
）
を
踏
ま
え
た
付
合
。
「
椎
は
、
こ
れ
か
ら
来
年
に
か
け
て
葉
替
え

を
す
る
こ
と
で
し
ょ
う
」
と
い
う
解
釈
は
、
こ
の
和
歌
を
前
提
と
し
て
可
能
と
な
る
。

※�

古
歌
を
媒
介
に
し
た
句
境
の
転
換
が
見
事
に
決
ま
っ
て
い
る
。
付
合
は
叙
情
性
に
あ
ふ
れ
、
一
句

も
、
も
の
寂
し
い
初
冬
の
情
趣
が
優
美
な
言
葉
の
連
鎖
か
ら
感
じ
取
ら
れ
る
。
下
手
が
付
け
る
と

「
た
ゞ
玉
の
緒
の
絶
え
ず
と
も
が
な
」
な
ど
と
し
て
、
せ
っ
か
く
の
前
句
を
台
無
し
に
し
て
し
ま

う
所
で
あ
る
。
私
の
レ
ベ
ル
で
は
よ
く
出
来
た
付
合
の
よ
う
に
感
じ
ら
れ
る
の
で
あ
る
が
、
自
撰

句
集
に
は
採
ら
れ
て
い
な
い
。
こ
の
程
度
は
、
宗
祇
に
と
っ
て
は
、
せ
い
ぜ
い
「
上
の
下
」
と
い

う
こ
と
な
の
で
あ
ろ
う
。
宗
祇
連
歌
の
水
準
の
高
さ
を
思
う
べ
き
で
あ
る
。

　
　
　
　
　

椎
柴
そ
よ
ぐ
凩
の
風

　
　

87　

は
つ
霜
の
園
の
樫
鳥
あ
さ
り
し
て

《
解�

釈
》
急
に
寒
く
な
っ
て
初
霜
が
下
り
た
園
生
。
凩
が
椎
の
木
の
群
れ
を
そ
よ
が
せ
、
そ
の
実
が

地
面
に
落
ち
る
と
、
そ
れ
を
樫
鳥
が
つ
つ
い
て
い
る
。

※�

「
な
つ
そ
ひ
く
う
な
か
み
山
の
椎
柴
に
樫
鳥
な
き
つ
夕
あ
さ
り
し
て
」
（
永
久
百
首
・
三
七
四
、

俊
頼
）
の
和
歌
に
拠
っ
て
「
椎
柴
」
に
「
樫
鳥
」
と
付
け
て
い
る
。
ポ
イ
ン
ト
は
、
同
じ
木
の
実

（
団
栗
）
の
種
と
し
て
「
椎
」
に
「
樫
」
と
対
応
さ
せ
て
い
る
所
。
「
樫
鳥
な
の
に
、
椎
の
実
を
あ

さ
る
と
は
、こ
れ
如
何
に
」
と
い
う
俳
諧
味
の
あ
る
付
合
で
あ
る
。
第
三
八
句
を
参
照
さ
れ
た
い
。

※�

「
樫
鳥
」
は
カ
ケ
ス
の
こ
と
。
雑
食
性
だ
が
、
秋
に
な
る
と
木
の
実
な
ど
を
貯
え
、
そ
れ
を
食
べ

て
越
冬
す
る
習
性
が
あ
る
。
そ
の
際
の
状
景
で
あ
る
。

　
　
　
　
　

は
つ
霜
の
園
の
樫
鳥
あ
さ
り
し
て

　
　

88　

深
山
づ
た
ひ
の
か
た
は
ら
の
里

《
解�

釈
》
深
山
の
尾
根
づ
た
い
か
ら
少
し
離
れ
た
位
置
に
あ
る
里
の
園
生
。
急
に
寒
く
な
り
、
今
朝

は
初
霜
が
降
り
て
い
る
。
そ
こ
に
樫
鳥
が
や
っ
て
き
て
、
団
栗
を
つ
つ
い
て
い
る
。

※�

こ
の
付
合
は
、
『
六
家
連
歌
集
』
に
前
句
と
付
句
を
入
れ
替
え
て
収
載
す
る
。
第
八
八
句
は
わ
ざ

わ
ざ
入
集
さ
せ
ね
ば
な
ら
な
い
ほ
ど
の
も
の
で
は
な
い
。
収
載
の
目
的
は
や
は
り
第
八
七
句
（
「
樫

鳥
」
と
い
う
珍
し
い
素
材
を
用
い
て
い
る
所
が
眼
目
）
。
そ
の
際
、
第
八
六
句
を
前
句
に
す
る
と
、

俳
諧
味
の
強
い
付
合
に
な
る
の
で
、
『
六
家
連
歌
集
』
の
編
者
は
、
そ
れ
を
嫌
っ
た
も
の
か
？　

も
ち
論
、
伝
来
の
過
程
で
偶
然
的
な
誤
り
が
生
じ
た
可
能
性
も
否
定
で
き
な
い
。
後
考
を
俟
つ
。

　
　
　
　
　

深
山
づ
た
ひ
の
か
た
は
ら
の
里

　
　

89　

軒
近
く
か
け
樋
ば
か
り
の
水
落
ち
て

《
解�

釈
》深
山
の
尾
根
づ
た
い
か
ら
少
し
離
れ
た
位
置
に
あ
る
里
。
聞
こ
え
る
も
の
は
、
家
の
軒
近
く
、

奥
の
谷
か
ら
導
か
れ
た
か
け
樋
の
水
が
、
水
溜
め
に
落
ち
る
音
ば
か
り
で
あ
る
。

※�

「
つ
た
ふ
」
に
「
か
け
樋
」
が
寄
合
。
他
の
例
は
「
鴬
の
軒
端
を
つ
た
ふ
声
は
し
て
／
竹
の
か
け

樋
は
水
ぞ
こ
ほ
れ
る
」
（
初
瀬
千
句
・
第
三
「
何
船
」
二
五
／
二
六
）
な
ど
。
証
歌
は
「
来
る
春

は
峰
に
霞
を
先
立
て
ゝ
谷
の
か
け
樋
を
伝
ふ
な
り
け
り
」
（
山
家
集
・
九
八
五
）
な
ど
。

※�

第
八
七
句
と
「
て
」
止
め
が
打
越
に
な
っ
て
い
る
。
こ
れ
は
、
同
字
が
間
隔
四
句
で
用
い
ら
れ
て

い
る
な
ど
と
は
レ
ベ
ル
が
違
う
極
め
て
稀
な
指
合
で
あ
る
。
た
だ
し
、
宗
祇
流
の
連
歌
な
ら
有
り

う
る
現
象
と
考
え
ら
れ
る
。
有
名
な
『
湯
山
三
吟
』
で
は
、
第
六
四
～
六
六
句
で
植
物
が
三
句
連

続
し
て
い
る
。
連
歌
の
常
識
と
し
て
考
え
ら
れ
な
い
ほ
ど
稀
な
指
合
で
あ
る
が
、
そ
れ
は
「
な
ほ

す
べ
き
や
う
無
之
故
に
其
の
ま
ゝ
お
き
給
ひ
つ
る
と
見
え
た
り
」
（
無
言
抄
）
と
の
こ
と
で
あ
る
。

せ
っ
か
く
の
好
付
合
を
無
に
し
た
く
な
い
と
い
う
こ
と
で
あ
る
。
こ
こ
で
も
「
軒
近
く
か
け
樋
の

水
の
た
え
〴
〵
に
」
な
ど
と
す
れ
ば
、
凡
庸
な
付
合
と
は
な
っ
て
も
指
合
は
容
易
に
解
消
さ
れ
る
。

後
の
連
歌
な
ら
恐
ら
く
そ
う
さ
れ
る
所
で
あ
ろ
う
が
、
そ
う
は
し
な
い
所
が
宗
祇
の
態
度
だ
と
い

う
こ
と
で
あ
ろ
う
。
そ
れ
に
し
て
も
、
こ
ん
な
少
し
注
意
す
れ
ば
誰
で
も
気
付
く
重
大
な
指
合
に

つ
い
て
、
近
代
の
注
が
何
の
言
及
も
し
な
い
の
は
ど
う
い
う
こ
と
で
あ
ろ
う
か
。

　
　
　
　
　

軒
近
く
か
け
樋
ば
か
り
の
水
落
ち
て

　
　

90　

竹
の
葉
乱
れ
雨
す
ぐ
る
音

《
解�

釈
》
家
の
軒
近
く
導
か
れ
た
か
け
樋
の
水
が
水
溜
め
に
落
ち
る
音
以
外
、
何
も
聞
こ
え
る
も
の

な
い
静
寂
の
一
瞬
。
突
然
、
風
に
竹
の
葉
が
乱
れ
、
雨
の
降
り
過
ぎ
る
音
が
し
は
じ
め
た
。

※�

前
線
が
通
過
す
る
と
突
風
が
吹
き
雨
を
伴
う
。
そ
の
一
瞬
を
見
事
に
捉
え
た
付
合
で
あ
る
。
指
合

を
生
じ
て
い
る
が
、
そ
れ
を
補
っ
て
余
り
あ
る
と
い
う
の
が
、
宗
祇
の
評
価
で
あ
ろ
う
か
。

※�

「
か
け
樋
」
に
「
竹
」
が
寄
合
。
他
の
例
は
「
片
山
水
の
か
け
樋
ゆ
く
音
／
解
け
に
け
り
竹
よ
こ

た
は
る
岸
の
雪
」
（
享
徳
二
年
千
句
・
第
五
「
何
路
」
八
〇
／
八
一
）
な
ど
。
「
竹
の
か
け
樋
」
と

言
う
。
「
今
朝
み
れ
ば
竹
の
か
け
樋
を
行
く
水
の
あ
ま
る
雫
ぞ
か
つ
凍
り
ぬ
る
」
（
新
拾
遺
・
一
八

‐
一
六
九
〇
、
宗
久
法
師
）
な
ど
。

※�

第
八
七
句
で
「
霜
」
が
詠
ま
れ
て
お
り
、
「
雨
」
と
は
間
隔
二
句
。
降
物
同
士
は
三
句
以
上
を
隔

て
ね
ば
な
ら
な
い
か
ら
、
指
合
を
生
じ
て
い
る
。
後
の
紹
巴
流
の
連
歌
な
ら
「
つ
れ
〴
〵
暮
ら
す

日
の
長
き
頃
」
と
か
「
眺
め
や
ら
る
ゝ
る
遠
方
の
雲
」
と
か
、
「
遣
句
」
を
す
る
所
で
あ
ろ
う
。

　
　
　
　
　

竹
の
葉
乱
れ
雨
す
ぐ
る
音

　
　

91　

目
ざ
ま
し
て
露
は
ら
ふ
夜
や
更
け
ぬ
ら
む

《
解�

釈
》
風
に
竹
の
葉
が
乱
れ
、
雨
の
降
り
過
ぎ
る
音
が
し
て
、
夜
中
に
ふ
と
目
を
覚
ま
す
。
夜
は

か
な
り
更
け
て
い
る
よ
う
だ
。
床
の
あ
た
り
は
露
で
い
っ
ぱ
い
に
な
っ
て
い
る
。

　
　
　
　
　

目
ざ
ま
し
て
露
は
ら
ふ
夜
や
更
け
ぬ
ら
む

　
　

92　

西
吹
く
風
に
月
ほ
そ
き
空
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※�

今
一
つ
状
況
が
よ
く
把
握
で
き
な
い
内
容
の
付
合
で
あ
る
が
、
句
の
主
体
の
人
物
（
男
）
が
、
道

（
普
通
、
女
性
の
家
の
前
の
道
）
で
、
人
に
見
と
が
め
ら
れ
な
い
よ
う
に
、
何
か
の
機
会
を
覗
っ

て
い
る
状
況
と
し
て
解
釈
し
た
。
如
何
。
「
何
か
の
機
会
」
と
い
う
の
は
、
ひ
ょ
っ
こ
り
出
て
き

た
女
の
童
や
乳
母
に
手
紙
を
託
す
と
か
、
主
人
の
女
性
に
関
す
る
何
か
の
情
報
を
聞
き
出
す
な
ど

と
い
う
こ
と
が
普
通
に
想
定
さ
れ
る
所
。
い
わ
ゆ
る
「
色
好
み
」
の
行
動
で
あ
ろ
う
。
た
だ
し
、

私
自
分
、
こ
の
解
釈
で
い
い
と
は
今
一
つ
思
え
な
い
。
御
教
示
を
乞
う
。

　
　
　
　
　

ま
ぎ
る
や
と
た
の
む
人
目
も
影
た
え
て

　
　

78　

恋
し
き
こ
と
を
誰
に
忘
れ
む

《
解�

釈
》
こ
れ
だ
け
道
に
人
ど
お
り
が
あ
れ
ば
、
そ
れ
に
紛
れ
て
、
見
と
が
め
ら
れ
る
こ
と
は
な
い

だ
ろ
う
と
思
っ
て
い
た
が
、
人
影
が
な
く
な
っ
た
。
出
直
す
よ
り
仕
方
な
い
が
、
あ
の
人
の
こ

と
は
忘
れ
ら
れ
な
い
。
誰
に
忘
れ
る
と
言
っ
た
っ
て
、
誰
も
い
な
く
な
っ
た
の
だ
か
ら
、
忘
れ

よ
う
が
な
い
で
は
な
い
か
。
当
た
り
前
だ
ろ
う
。

※�

「
誰
も
い
な
い
の
だ
か
ら
、
誰
に
忘
れ
る
こ
と
も
で
き
な
い
」
と
、
理
屈
に
な
ら
な
い
理
屈
を
言
っ

て
戯
れ
た
俳
諧
的
な
付
合
で
あ
る
。
こ
れ
も
宗
祇
連
歌
の
一
体
。
第
三
八
句
等
を
参
照
。

　
　
　
　
　

恋
し
き
こ
と
を
誰
に
忘
れ
む

　
　

79　

つ
ら
し
と
て
ま
た
い
づ
方
に
移
ら
ま
し

《
解�

釈
》
恋
し
く
て
忘
れ
ら
れ
な
く
て
も
、
誰
か
別
な
人
の
こ
と
を
思
え
ば
、
自
然
と
忘
れ
る
こ
と

が
で
き
る
だ
ろ
う
。
そ
の
よ
う
に
人
は
言
う
け
れ
ど
も
、
そ
れ
は
無
理
。
い
く
ら
、
あ
の
人
が

私
に
対
し
て
辛
く
あ
た
っ
て
も
、
心
を
あ
の
人
以
外
に
移
す
な
ん
て
こ
と
は
、
私
に
は
で
き
る

は
ず
が
な
い
の
だ
。

　
　
　
　
　

つ
ら
し
と
て
ま
た
い
づ
方
に
移
ら
ま
し

　
　

80　

な
れ
来
し
庵
松
風
も
吹
け

《
解�

釈
》
草
庵
で
の
独
居
生
活
。
松
風
が
身
に
し
み
て
寂
し
く
辛
い
。
し
か
し
、
松
風
よ
、
吹
き
た

け
れ
ば
吹
け
ば
い
い
の
だ
。
こ
の
所
が
い
く
ら
辛
い
か
ら
と
言
っ
て
、
ど
こ
に
移
り
住
め
ば
い

い
の
か
。
私
の
住
む
べ
き
場
所
は
、
住
み
な
れ
た
こ
の
草
庵
以
外
、
ど
こ
に
も
な
い
の
だ
。

※�

前
句
の
「
つ
ら
し
」
は
、
ま
ま
な
ら
ぬ
恋
の
辛
さ
。
そ
れ
を
草
庵
で
の
独
居
の
辛
さ
に
取
り
な
し

て
、
句
境
を
無
理
な
く
鮮
や
か
に
転
じ
て
い
る
。

※�

第
七
五
句
に
「
嵐
」
と
あ
り
、
「
松
風
」
と
は
四
句
を
隔
て
る
の
み
で
、
指
合
を
生
じ
て
い
る
。

後
の
連
歌
な
ら
強
く
批
判
さ
れ
る
所
で
あ
る
が
、
宗
祇
流
の
連
歌
は
比
較
的
鷹
揚
で
あ
る
。

　
　
　
　
　

な
れ
来
し
庵
松
風
も
吹
け

　
　

81　

心
こ
そ
な
く
と
も
月
に
夢
や
見
む

《
解�

釈
》
人
並
み
な
風
雅
の
心
な
ど
持
た
な
い
自
分
で
あ
る
が
、
今
夜
の
月
は
格
別
に
身
に
し
み
る
。

こ
れ
か
ら
、
朝
に
な
る
ま
で
、
こ
の
月
を
眺
め
て
夜
を
明
か
そ
う
。
眠
っ
て
夢
な
ど
見
て
お
れ

る
も
の
で
は
な
い
。
住
み
な
れ
た
庵
、
い
つ
も
な
ら
松
風
の
音
に
眠
れ
な
く
な
る
の
だ
が
、
今

夜
は
、
松
風
よ
、
吹
き
た
い
な
ら
い
く
ら
吹
い
て
も
よ
い
の
だ
。

※�

前
句
で
「
松
風
も
吹
け
」
と
呼
び
か
け
て
い
る
の
を
理
由
付
け
し
た
付
合
で
あ
る
。
「
夜
も
す
が

ら
眺
め
明
か
さ
む
秋
の
月
」
な
ど
と
す
る
だ
け
で
も
そ
こ
そ
こ
の
付
合
と
な
る
が
、
そ
こ
を
「
心

こ
そ
な
く
と
も
月
に
夢
や
見
む
」
と
付
け
る
。
若
い
人
は
味
読
し
て
、
宗
祇
連
歌
の
レ
ベ
ル
の
高

さ
を
是
非
実
感
し
て
ほ
し
い
。
『
下
草
』
に
入
集
す
る
（
続
類
従
本
八
八
六
）
。

　
　
　
　
　

心
こ
そ
な
く
と
も
月
に
夢
や
見
む

　
　

82　

姨
捨
山
の
秋
の
仮
ぶ
し

《
解�

釈
》
秋
、
更
科
の
里
で
の
旅
寝
。
人
並
み
な
風
雅
の
心
な
ど
持
た
な
い
自
分
で
あ
る
が
、
姨
捨

山
に
照
る
月
は
、
や
は
り
格
別
の
美
し
さ
だ
。
こ
れ
か
ら
、
朝
に
な
る
ま
で
、
こ
の
月
を
眺
め

て
夜
を
明
か
そ
う
。
眠
っ
て
夢
な
ど
見
て
お
れ
る
も
の
で
は
な
い
。

※�

有
名
な
「
我
が
心
な
ぐ
さ
め
か
ね
つ
更
科
や
姨
捨
山
に
照
る
月
を
見
て
」
（
古
今
・
一
七
‐

八
七
八
、
よ
み
人
し
ら
ず
）
の
和
歌
に
拠
る
付
合
で
あ
る
。
「
心
」
及
び
「
月
」
が
、
そ
れ
ぞ
れ
「
姨

捨
」
と
寄
合
に
な
る
。
連
歌
で
の
他
の
例
は
、
前
者
は
「
憂
き
お
も
ひ
う
た
て
忘
れ
ぬ
我
が
心
／

姨
捨
山
の
月
の
入
り
方
」
（
大
山
祇
神
社
法
楽
文
明
十
四
年
万
句
第
四
千
句
・
第
四
「
山
何
」

七
五
／
七
六
）
、
後
者
は
「
月
す
み
て
今
宵
や
ど
り
を
我
に
貸
せ
／
秋
も
む
つ
ま
じ
姨
捨
の
山
」（
宝

徳
四
年
千
句
・
第
五
「
唐
何
二
七
／
二
八
」
）
な
ど
。

　
　
　
　
　

姨
捨
山
の
秋
の
仮
ぶ
し

　
　

83　

衣
う
つ
音
さ
へ
旅
の
恨
み
に
て

《
解�

釈
》
秋
、
更
科
の
里
で
の
旅
寝
。
た
だ
で
さ
え
旅
の
辛
さ
が
身
に
し
み
る
の
に
、
更
に
夜
通
し

に
打
つ
砧
の
音
ま
で
も
が
、
私
を
寝
ら
れ
な
く
さ
せ
る
。

※�

「
姨
捨
」
に
「
衣
う
つ
」
が
寄
合
。
他
に
「
姨
捨
や
仮
寝
を
月
に
な
ぐ
さ
め
て
／
衣
う
つ
夜
の
風

な
し
を
り
そ
」
（
明
応
五
年
正
月
九
日
「
何
人
」
七
／
八
）
な
ど
。
た
だ
し
、
意
外
な
こ
と
に
「
姨

捨
」
に
「
衣
う
つ
」
と
詠
ん
だ
和
歌
は
、
調
査
の
範
囲
で
検
出
さ
れ
な
か
っ
た
が
（
後
考
を
俟
つ
）
、

「
更
科
」
に
「
衣
う
つ
」
と
詠
ん
だ
和
歌
な
ら
「
更
科
や
夜
わ
た
る
月
の
里
人
も
な
ぐ
さ
め
か
ね

て
衣
う
つ
な
り
」
（
続
古
今
・
五
‐
四
七
三
、
順
徳
院
御
歌
）
な
ど
多
い
。
「
姨
捨
山
」
は
「
更
科
」

の
地
に
あ
る
と
伝
統
的
に
言
わ
れ
て
き
た
か
ら
、
証
歌
と
し
て
許
容
さ
れ
よ
う
。

　
　
　
　
　

衣
う
つ
音
さ
へ
旅
の
恨
み
に
て

　
　

84　

遠
ざ
か
り
来
ぬ
妹
も
待
つ
ら
む

《
解�

釈
》
故
郷
か
ら
遠
く
離
れ
行
く
旅
。
故
郷
の
妻
も
き
っ
と
私
の
帰
る
の
を
待
っ
て
い
る
こ
と
だ

ろ
う
。
里
の
砧
の
声
が
、
更
に
望
郷
の
念
を
募
ら
せ
る
。

※�
付
句
の
仕
立
は
「
去
年
見
て
し
秋
の
月
夜
は
照
ら
せ
ど
も
あ
ひ
見
し
妹
は
い
や
遠
ざ
か
り
」（
拾
遺
・

二
〇
‐
一
二
八
七
、
人
ま
ろ
）
を
念
頭
に
置
い
た
も
の
で
あ
ろ
う
か
。
た
だ
し
、
こ
の
歌
は
、
亡

き
妻
を
偲
ん
だ
も
の
で
、
こ
の
付
合
と
は
状
況
を
異
に
す
る
。

※�

一
句
は
「
妹
」
の
語
に
よ
り
「
恋
」
と
し
て
取
り
扱
わ
れ
る
。
第
七
九
句
も
「
恋
」
で
、
そ
の
間

隔
は
四
句
。
「
恋
」
同
士
は
五
句
以
上
を
隔
て
ね
ば
な
ら
な
い
か
ら
、
指
合
を
生
じ
て
い
る
と
思

わ
れ
る
。

　
　
　
　
　

遠
ざ
か
り
来
ぬ
妹
も
待
つ
ら
む

　
　

85　

変
は
ら
じ
と
言
ひ
し
を
今
も
た
の
む
世
に
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句
・
第
六
「
村
何
」
八
）
と
か
「
仄
吹
く
風
も
ひ
や
ゝ
か
に
聞
く
」
（
秋
津
洲
千
句
・
第
七
「
何
人
」

四
八
）
と
か
い
う
句
と
比
較
す
る
と
、
や
は
り
出
来
が
違
う
。
一
々
に
指
摘
で
き
る
こ
と
で
は
な

い
が
、
宗
祇
連
歌
の
レ
ベ
ル
の
高
さ
が
、
お
の
ず
と
知
れ
よ
う
。

　
　
　
　
　

風
ひ
や
ゝ
か
に
秋
更
く
る
頃

　
　

67　

牡
鹿
鳴
く
山
は
夕
べ
の
い
か
ば
か
り

《
解�

釈
》
風
が
冷
や
や
か
に
吹
く
晩
秋
の
頃
、
取
り
分
け
、
牡
鹿
の
声
が
侘
し
く
聞
こ
え
る
山
の
夕

暮
は
、
ど
れ
ほ
ど
の
も
の
で
あ
ろ
う
か
。

　
　
　
　
　

牡
鹿
鳴
く
山
は
夕
べ
の
い
か
ば
か
り

　
　

68　

思
ひ
入
る
べ
き
世
の
外
や
な
き

《
解�

釈
》
牡
鹿
が
鳴
く
秋
の
夕
暮
の
山
。
そ
ん
な
所
で
の
独
居
生
活
は
、
ど
れ
ほ
ど
寂
し
い
も
の
で

あ
ろ
う
か
。
し
か
し
、
俗
世
間
の
外
で
生
き
る
の
に
他
に
ど
ん
な
場
所
が
あ
る
の
か
。
世
を
捨

て
る
と
い
う
の
は
、
そ
の
寂
し
さ
に
耐
え
て
生
き
る
覚
悟
を
す
る
と
い
う
こ
と
な
の
だ
。

※�

「
世
の
中
よ
道
こ
そ
な
け
れ
思
ひ
入
る
山
の
奥
に
も
鹿
ぞ
鳴
く
な
る
」（
千
載
・
一
七
‐
一 

一
五
一
、
皇
太
后
宮
大
夫
俊
成
）
を
踏
ま
え
て
「
鹿
鳴
く
山
」
に
「
思
ひ
入
る
」
と
付
け
て
い
る
。

　
　
　
　
　

思
ひ
入
る
べ
き
世
の
外
や
な
き

　
　

69　

憂
き
も
た
ゞ
夢
の
宿
り
を
な
げ
く
な
よ

《
解�

釈
》
い
く
ら
辛
く
と
も
「
こ
の
世
を
捨
て
て
山
に
入
る
の
だ
」
な
ど
と
嘆
く
べ
き
で
は
な
い
。
「
世

の
外
」
な
ど
と
言
う
が
、
生
き
て
い
る
限
り
、
所
詮
そ
こ
も
娑
婆
世
界
の
外
で
は
な
い
の
だ
。

※�

「
夢
の
宿
り
」
は
「
夢
の
よ
う
に
は
か
な
い
一
時
的
な
身
の
置
き
所
で
し
か
な
い
娑
婆
世
界
」
と

い
う
内
容
で
あ
る
。
後
の
も
の
だ
が
、
「
故
郷
の
も
と
の
悟
り
に
帰
り
て
は
夢
の
宿
り
を
い
か
ゞ

見
る
ら
む
」（
雪
玉
集
・
五
六
一
九
）
の
例
が
解
り
や
す
い
。
「
故
郷
」
が
本
来
の
悟
り
の
世
界
、「
夢

の
宿
り
」
が
迷
い
の
こ
の
世
で
あ
る
。

※�

第
六
四
句
で
「
憂
き
」
が
詠
ま
れ
て
お
り
、
同
字
の
指
合
を
生
じ
て
い
る
。

　
　
　
　
　

憂
き
も
た
ゞ
夢
の
宿
り
を
な
げ
く
な
よ

　
　

70　

さ
な
が
ら
袖
も
雨
の
木
の
も
と

《
解�

釈
》
夢
の
よ
う
に
は
か
な
い
一
時
的
な
身
の
置
き
所
で
し
か
な
い
此
の
世
。
そ
こ
が
辛
い
か
ら

と
言
っ
て
、
殊
更
に
嘆
く
べ
き
は
あ
る
ま
い
。
雨
を
避
け
よ
う
と
一
時
的
に
木
陰
に
身
を
寄
せ

て
も
、
雨
の
下
に
い
る
限
り
、
袖
が
雨
に
濡
れ
な
い
こ
と
は
な
い
の
だ
。

　
　
　
　
　

さ
な
が
ら
袖
も
雨
の
木
の
も
と

　
　

71　

梅
の
花
誰
が
手
折
れ
ば
や
し
を
る
ら
む

《
解�

釈
》
梅
の
花
が
萎
れ
て
い
ま
す
。
一
体
、
誰
が
手
折
っ
た
か
ら
で
し
ょ
う
か
。
こ
ん
な
雨
の
中
、

そ
の
人
の
袖
は
、
き
っ
と
び
し
ょ
濡
れ
の
こ
と
で
し
ょ
う
ね
。
ど
う
で
す
か
、
雨
さ
ん
？

※�

梅
の
花
が
萎
れ
て
い
る
の
は
雨
に
打
た
れ
た
せ
い
。
そ
れ
を
承
知
の
上
で
、
雨
を
擬
人
化
し
て
皮

肉
っ
ぽ
く
訊
ね
て
い
る
付
合
と
し
て
、
解
釈
は
右
の
と
お
り
で
あ
る
。
如
何
。
「
さ
な
が
ら
」
は
、

こ
の
付
合
で
は
「
全
部
。
す
べ
て
」
（
岩
波
古
語
辞
典
）
の
意
と
な
る
。

※�

「
袖
」
に
「
梅
を
折
る
」
が
寄
合
。
「
さ
し
覆
ふ
袖
に
も
色
は
し
る
か
り
き
／
枝
折
る
梅
に
匂
ふ

春
風
」
（
文
明
九
年
正
月
二
十
二
日
「
何
船
」
六
一
／
六
二
）
な
ど
。
証
歌
は
「
折
り
つ
れ
ば
袖

こ
そ
匂
へ
梅
の
花
あ
り
と
や
こ
ゝ
に
鴬
の
鳴
く
」
（
古
今
・
一
‐
三
二
、
よ
み
人
し
ら
ず
）
な
ど
。

　
　
　
　
　

梅
の
花
誰
が
手
折
れ
ば
や
し
を
る
ら
む

　
　

72　

帰
る
を
恨
む
春
の
鴬

《
解�

釈
》
梅
の
花
が
萎
れ
て
い
ま
す
。
一
体
、
誰
が
手
折
っ
た
か
ら
で
し
ょ
う
か
。
い
い
え
、
誰
か

が
手
折
っ
た
わ
け
で
は
あ
り
ま
せ
ん
。
春
が
帰
っ
て
行
く
か
ら
で
す
。
も
っ
と
梅
の
花
と
戯
れ

た
い
と
思
っ
て
い
る
鴬
は
、
そ
れ
を
恨
ん
で
鳴
い
て
い
ま
す
。

　
　
　
　
　

帰
る
を
恨
む
春
の
鴬

　
　

73　

霞
に
も
今
は
と
雁
の
や
す
ら
は
で

《
解�

釈
》
空
に
春
霞
が
た
な
び
く
よ
う
に
な
っ
た
。
間
も
な
く
花
も
咲
く
こ
と
だ
ろ
う
。
そ
れ
な
の

に
雁
は
、
何
の
た
め
ら
い
も
な
く
北
に
帰
っ
て
ゆ
く
。
そ
れ
を
鴬
は
、
何
て
薄
情
な
や
つ
な
の

だ
と
、
恨
め
し
く
思
う
こ
と
だ
ろ
う
。

　
　
　
　
　

霞
に
も
今
は
と
雁
の
や
す
ら
は
で

　
　

74　

末
に
い
か
な
る
山
を
越
え
な
む

《
解�

釈
》
春
霞
の
空
を
、
雁
は
（
間
も
な
く
花
が
咲
く
頃
だ
と
も
思
わ
ず
に
）
、
何
の
た
め
ら
い
も
な

く
北
に
帰
っ
て
ゆ
く
。
あ
の
雁
た
ち
は
、
行
く
末
に
、
ど
の
よ
う
な
山
を
越
え
て
行
く
の
だ
ろ

う
か
（
花
の
盛
り
の
山
以
上
に
魅
力
的
な
山
で
も
あ
る
の
だ
ろ
う
か
）
。

　
　
　
　
　

末
に
い
か
な
る
山
を
越
え
な
む

　
　

75　

冴
え
む
か
ふ
嵐
に
わ
び
て
ま
よ
ふ
野
に

《
解�

釈
》
野
の
道
を
行
く
途
中
で
迷
っ
て
し
ま
っ
た
。
吹
き
荒
ぶ
向
か
い
風
が
身
に
寒
い
。
こ
の
先
、

今
日
の
う
ち
に
山
を
越
え
る
予
定
で
い
た
の
だ
が
、
そ
こ
は
ど
う
な
っ
て
い
る
だ
ろ
う
か
。
越

す
こ
と
が
で
き
な
い
な
ら
、
諦
め
る
よ
り
他
は
な
い
が
、
こ
ん
な
嵐
で
は
野
宿
も
で
き
な
い
。

ど
う
し
よ
う
か
、
私
は
た
だ
迷
う
ば
か
り
で
あ
る
。

※�

「
迷
ふ
」
に
は
、
「
道
に
迷
う
」
の
他
に
「
心
に
迷
う
」
の
意
も
持
た
さ
れ
て
い
る
。

※�

近
代
の
注
釈
は
、
こ
の
句
を
無
季
（
雑
）
と
す
る
が
、
何
か
の
カ
ン
違
い
で
あ
ろ
う
。
「
冴
ゆ
」

と
言
え
ば
単
独
で
冬
季
と
し
て
取
り
扱
わ
れ
る
の
は
、
連
歌
の
常
識
で
あ
る
。

　
　
　
　
　

冴
え
む
か
ふ
嵐
に
わ
び
て
ま
よ
ふ
野
に

　
　

76　

日
暮
れ
に
か
ゝ
る
道
の
も
の
憂
さ

《
解�
釈
》
野
の
道
を
行
く
途
中
で
迷
っ
て
し
ま
っ
た
。
吹
き
荒
ぶ
向
か
い
風
が
身
に
寒
い
。
日
も
暮

れ
は
じ
め
た
。
こ
ん
な
嵐
で
は
野
宿
は
で
き
な
い
。
宿
が
見
つ
か
る
だ
ろ
う
か
。
何
と
も
情
け

な
い
こ
と
だ
。

　
　
　
　
　

日
暮
れ
に
か
ゝ
る
道
の
も
の
憂
さ

　
　

77　

ま
ぎ
る
や
と
た
の
む
人
目
も
影
た
え
て

《
解�

釈
》
こ
れ
だ
け
道
に
人
ど
お
り
が
あ
れ
ば
、
そ
れ
に
紛
れ
て
、
見
と
が
め
ら
れ
る
こ
と
は
な
い

だ
ろ
う
と
待
っ
て
い
た
が
、
日
も
暮
れ
は
じ
め
、
人
影
も
な
く
な
っ
た
。
情
け
な
い
が
、
今
日

は
出
直
す
こ
と
に
し
よ
う
。
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誰
が
つ
ら
さ
と
か
身
の
憂
き
を
し
る

　
　

59　

前
の
世
や
人
に
思
ひ
を
付
け
つ
ら
む

《
解�
釈
》
恋
に
苦
し
む
こ
の
身
、
一
体
誰
の
せ
い
な
の
だ
ろ
う
。
き
っ
と
私
は
、
前
世
で
、
誰
か
の

心
の
中
の
思
ひ
の
火
に
点
火
し
て
、
焦
が
れ
苦
し
め
さ
せ
た
の
だ
ろ
う
。
そ
う
で
あ
る
な
ら
、

誰
の
せ
い
で
も
な
い
。
私
自
身
の
せ
い
な
の
だ
。

※�

「
思
ひ
」
の
「
ひ
」
に
「
火
」
を
利
か
す
の
は
古
典
文
学
の
常
識
的
手
法
。
「
火
を
付
け
る
」
で
、

点
火
す
る
こ
と
。
こ
の
場
合
は
、
自
分
に
対
す
る
誰
か
他
者
の
心
の
中
の
「
思
ひ
」
の
火
に
点
火

す
る
こ
と
で
あ
る
。
他
者
に
対
す
る
自
分
の
「
思
ひ
」
の
火
の
場
合
も
あ
る
。
例
と
し
て
は
「
夕

さ
れ
ば
色
に
蛍
や
焦
が
る
ら
む
／
思
ひ
を
人
に
付
く
る
と
を
知
れ
」
（
顕
証
院
会
千
句
・
第
五
「
唐

何
」
五
五
／
五
六
）
が
解
り
や
す
い
。

　
　
　
　
　

前
の
世
や
人
に
思
ひ
を
付
け
つ
ら
む

　
　

60　

花
の
都
の
あ
と
の
松
風

《
解�

釈
》
か
つ
て
花
の
咲
き
誇
る
都
の
あ
っ
た
こ
の
地
も
今
は
寂
れ
て
、
た
だ
松
風
が
吹
き
過
ぎ
る

ば
か
り
。
こ
の
松
風
も
、
そ
の
当
時
は
、
花
を
散
ら
せ
は
し
な
い
か
と
、
多
く
の
都
人
を
心
配

さ
せ
た
こ
と
だ
ろ
う
。

※�

前
句
の
「
前
の
世
」
は
、
先
の
付
合
で
は
「
人
の
前
生
」
の
こ
と
。
そ
れ
を
「
昔
、
こ
こ
が
都
で

あ
っ
た
時
代
」
に
取
り
な
し
て
、
句
境
を
転
じ
て
お
り
、
そ
こ
に
意
外
性
が
あ
る
。
句
の
仕
立
も

美
し
く
情
感
に
満
ち
て
い
る
。
古
注
に
「
お
も
し
ろ
き
下
句
な
り
」
と
評
さ
れ
て
い
る
。
研
究
者

は
味
読
す
べ
き
で
あ
ろ
う
。
『
下
草
』
に
入
集
（
続
類
従
本
八
六
八
）
。

　
　
　
　
　

花
の
都
の
あ
と
の
松
風

　
　

61　

春
深
き
志
賀
の
山
も
と
う
ら
さ
び
て

《
解�

釈
》
花
の
咲
き
誇
る
都
の
あ
っ
た
志
賀
の
山
も
と
。
今
は
寂
れ
て
、
春
深
い
こ
の
時
季
に
も
、

た
だ
松
風
が
吹
き
過
ぎ
る
ば
か
り
で
あ
る
。

※�

「
う
ら
さ
び
て
」
に
は
「
浦
」
が
利
か
さ
れ
て
い
る
。
今
さ
ら
例
示
の
必
要
も
あ
る
ま
い
が
「
石

見
潟
名
の
み
高
津
の
う
ら
さ
び
て
」
（
享
徳
二
年
三
月
十
五
日
「
何
路
」
七
五
）
な
ど
。

※�

「
松
」
に
「
志
賀
」
が
寄
合
。
他
の
例
は
「
松
一
木
に
も
風
聞
き
つ
べ
し
／
花
の
後
志
賀
の
都
の

な
ほ
荒
れ
て
」
（
紫
野
千
句
・
第
十
「
唐
何
」
五
四
／
五
五
）
な
ど
。
証
歌
は
「
さ
ゞ
波
や
志
賀

の
唐
崎
こ
ほ
る
夜
は
松
よ
り
ほ
か
の
浦
風
も
な
し
」
（
続
拾
遺
・
六
‐
四
二
六
、
平
宣
時
）
な
ど
。

※�

「
都
」
に
「
志
賀
」
も
勿
論
寄
合
で
あ
る
。
例
は
「
名
残
あ
る
都
の
山
を
か
へ
り
み
て
／
遠
ざ
か

り
ゆ
く
志
賀
の
浦
船
」
（
初
瀬
千
句
・
第
九
「
唐
何
」
一
一
／
一
二
）
な
ど
（
証
歌
省
略
）
。

　
　
　
　
　

春
深
き
志
賀
の
山
も
と
う
ら
さ
び
て

　
　

62　

霞
の
い
づ
く
渡
り
す
る
船

《
解�

釈
》
志
賀
の
山
も
と
の
里
は
、
春
深
く
な
っ
て
も
も
の
寂
し
く
、
た
だ
濛
々
た
る
霞
に
包
ま
れ

て
い
る
ば
か
り
。
湖
水
を
渡
る
船
も
あ
る
は
ず
だ
が
、
そ
れ
も
判
然
と
し
な
い
。

　
　
　
　
　

霞
の
い
づ
く
渡
り
す
る
船

　
　

63　

起
き
出
づ
る
遠
の
里
〴
〵
声
す
な
り

《
解�

釈
》
川
辺
に
旅
の
一
夜
を
過
ご
し
、
目
を
覚
ま
す
。
あ
た
り
は
一
面
の
厚
い
霞
で
遠
く
が
見
渡

せ
な
い
。
た
だ
、
川
向
か
い
の
里
の
方
か
ら
、
人
々
の
起
き
出
し
た
声
が
聞
こ
え
て
く
る
。
川

渡
し
の
船
は
、
ど
こ
に
い
る
の
だ
ろ
う
か
。

　
　
　
　
　

起
き
出
づ
る
遠
の
里
〴
〵
声
す
な
り

　
　

64　

身
は
蓬
生
に
明
か
す
夜
ぞ
憂
き

《
解�

釈
》
一
時
は
栄
達
を
夢
見
た
こ
と
も
あ
っ
た
が
、
時
流
に
外
れ
、
住
ま
い
も
、
今
は
蓬
が
生
い

茂
る
よ
う
に
な
っ
た
。
以
前
を
思
い
出
す
た
び
に
、
今
の
生
活
が
悔
し
く
、
情
け
な
く
、
床
に

つ
い
て
も
眠
る
こ
と
が
で
き
な
い
。
ど
う
や
ら
、
夜
を
明
か
し
て
し
ま
っ
た
よ
う
だ
。
離
れ
た

里
の
方
か
ら
、
人
々
の
起
き
出
し
た
声
が
聞
こ
え
る
。

※�

近
代
の
注
釈
は
、
こ
の
句
を
述
懐
と
し
、
第
五
九
句
と
間
隔
四
句
で
指
合
を
生
じ
て
い
る
と
述
べ

る
が
、
明
白
な
誤
り
で
あ
る
。
「
蓬
生
で
の
生
活
」
と
い
う
内
容
の
句
は
、
そ
れ
だ
け
で
は
述
懐

と
し
て
は
取
り
扱
わ
れ
な
い
。
一
例
を
挙
げ
れ
ば
、
寛
正
六
年
三
月
六
日
「
何
人
」
第
二
三
句
で

「
秋
を
こ
そ
身
に
わ
び
つ
る
に
老
の
来
て
」
と
述
懐
が
詠
ま
れ
た
後
、
二
句
隔
て
る
の
み
の
第

二
六
句
で
「
う
ら
枯
れ
わ
び
し
蓬
生
の
宿
」
と
詠
ま
れ
て
い
る
。
述
懐
同
士
な
ら
五
句
以
上
を
隔

て
ね
ば
な
ら
な
い
。
同
様
の
例
は
枚
挙
に
暇
が
な
い
。
実
際
に
調
査
す
れ
ば
簡
単
に
解
る
こ
と
で

あ
る
。
『
新
式
』
に
は
「
称
述
懐
詞
事
、
昔
・
古
・
老
・
生
死
・
世
・
親
子
・
苔
衣
・
墨
染
袖
・

隠
家
・
捨
身
・
憂
身
・
命
等
之
類
也
。
凡
、
雖
為
述
懐
之
意
、
不
露
顕
詞
者
、
述
懐
不
用
来
也
」

と
い
う
記
述
が
あ
る
。
こ
の
作
法
が
適
用
さ
れ
て
い
る
と
考
え
る
べ
き
で
あ
ろ
う
。

　
　
　
　
　

身
は
蓬
生
に
明
か
す
夜
ぞ
憂
き

　
　

65　

我
が
心
月
は
見
る
や
と
影
す
み
て

《
解�

釈
》
一
時
は
栄
達
を
夢
見
た
こ
と
も
あ
っ
た
が
、
時
流
に
外
れ
、
今
は
、
蓬
生
に
夜
を
明
か
す

身
の
上
。
そ
ん
な
私
の
心
を
、
月
は
見
て
く
れ
て
い
る
の
だ
ろ
う
か
、
た
だ
澄
ん
だ
光
を
地
上

に
投
げ
か
け
る
ば
か
り
で
あ
る
。

※�

こ
の
付
合
に
つ
い
て
、
古
注
は
「
我
が
心
な
ぐ
さ
め
か
ね
つ
更
科
や
」
云
々
の
和
歌
を
引
用
し
、

近
代
の
注
も
そ
れ
に
従
っ
て
解
釈
す
る
が
、
適
切
で
は
な
い
。
当
該
の
和
歌
は
、
後
の
第
八
一
／

八
二
句
の
付
合
で
本
歌
と
し
て
用
い
ら
れ
て
い
る
の
は
明
白
。
同
じ
和
歌
が
、
同
一
百
韻
の
二
度

の
付
合
に
繰
り
返
し
本
歌
と
し
て
用
い
ら
れ
る
な
ど
と
い
う
こ
と
は
、
あ
り
得
な
い
。
「
我
が
心
」

と
「
月
」
と
い
う
表
現
は
、
有
名
な
「
我
が
心
い
か
に
せ
よ
と
か
時
鳥
雲
間
の
月
の
影
に
鳴
く
ら

む
」
（
新
古
今
・
三
‐
二
一
〇
、
皇
太
后
宮
大
夫
俊
成
）
を
は
じ
め
と
し
て
普
通
に
数
多
く
用
い

ら
れ
て
お
り
、
「
な
ぐ
さ
む
」
と
か
「
姨
捨
」
と
か
と
組
み
合
わ
せ
ら
れ
な
い
限
り
、
「
我
が
心
な

ぐ
さ
め
か
ね
つ
」
云
々
の
和
歌
を
、
特
定
的
に
想
起
さ
せ
る
も
の
で
は
な
い
。

　
　
　
　
　

我
が
心
月
は
見
る
や
と
影
す
み
て

　
　

66　

風
ひ
や
ゝ
か
に
秋
更
く
る
頃

《
解�

釈
》
晩
秋
。
夜
風
が
冷
や
や
か
に
身
に
し
み
て
寂
し
さ
が
募
る
。
そ
ん
な
私
の
心
を
、
月
は
見

て
く
れ
て
い
る
の
だ
ろ
う
か
、
た
だ
澄
ん
だ
光
を
地
上
に
投
げ
か
け
る
ば
か
り
で
あ
る
。

※�

一
見
ど
う
と
い
う
こ
と
の
な
い
句
の
よ
う
だ
が
、
「
風
ひ
や
ゝ
か
に
吹
き
お
く
る
頃
」
（
難
波
田
千

27
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は
何
か
常
な
る
飛
鳥
川
き
の
ふ
の
淵
ぞ
け
ふ
は
瀬
に
な
る
」
（
古
今
・
一
八
‐
九
三
三
、
読
人
し

ら
ず
）
の
和
歌
に
依
拠
し
た
も
の
で
あ
る
。

　
　
　
　
　

憂
き
人
心
何
か
常
な
る

　
　

51　

い
た
づ
ら
の
言
の
葉
お
ほ
き
筆
の
あ
と

《
解�

釈
》
辛
い
こ
と
だ
が
、
人
の
心
が
永
続
す
る
こ
と
は
な
い
。
必
ず
い
つ
か
は
移
り
ゆ
く
も
の
な

の
だ
ろ
う
。
あ
の
人
か
ら
の
手
紙
も
、
最
近
は
す
ぐ
に
バ
レ
る
よ
う
な
言
い
訳
や
嘘
ば
か
り
。

も
う
、
あ
の
人
の
心
は
、
私
以
外
の
誰
か
に
移
っ
て
い
る
の
だ
。

　
　
　
　
　

い
た
づ
ら
の
言
の
葉
お
ほ
き
筆
の
あ
と

　
　

52　

つ
た
は
り
来
れ
ば
そ
の
法
も
な
し

《
解�

釈
》
釈
尊
の
教
え
も
、
イ
ン
ド
か
ら
日
本
に
伝
来
す
る
う
ち
に
、
本
質
が
失
わ
れ
て
し
ま
っ
た
。

多
く
の
経
典
が
伝
わ
っ
て
い
る
が
、
そ
こ
に
書
か
れ
て
い
る
の
は
、
本
来
の
仏
教
で
は
な
い
。

本
来
の
釈
尊
の
教
え
は
、
不
立
文
字
教
外
別
伝
で
あ
る
の
だ
。

※�

右
の
ご
と
く
解
釈
す
る
と
、
宗
祇
が
特
に
禅
的
な
思
想
の
持
主
で
あ
っ
た
が
ご
と
く
受
け
取
ら
れ

る
か
も
知
れ
な
い
。
彼
に
は
、
他
に
も
「
庭
前
柏
樹
子
」
の
公
案
を
踏
ま
え
た
「
こ
れ
や
こ
の
西

よ
り
来
た
る
法
の
道
／
庭
の
植
木
の
色
か
へ
ぬ
か
げ
」
（
三
島
千
句
・
第
六
「
初
何
」
五
一
／

五
二
）
の
ご
と
き
付
合
も
あ
る
。
た
だ
し
、
こ
の
程
度
の
仏
教
の
知
識
は
、
当
時
の
知
識
人
な
ら

常
識
の
範
囲
で
、
彼
に
は
、
西
方
浄
土
へ
の
往
生
を
願
う
句
や
、
弥
勒
出
世
を
待
つ
句
も
多
く
、

必
ず
し
も
そ
う
と
は
言
い
切
れ
な
い
と
い
う
の
が
現
在
の
私
の
考
え
で
あ
る
。
若
い
人
の
こ
れ
か

ら
の
研
究
の
指
針
と
な
れ
ば
と
、
敢
え
て
言
及
し
た
。

※�

前
句
の
「
言
の
葉
」
は
、
先
の
付
合
で
は
、
不
実
な
男
の
嘘
・
言
い
訳
。
そ
れ
を
経
典
の
言
葉
に

取
り
な
し
て
句
境
を
転
換
し
た
「
力
技
」
の
付
合
で
あ
る
。
こ
れ
も
宗
祇
の
一
体
。

　
　
　
　
　

つ
た
は
り
来
れ
ば
そ
の
法
も
な
し

　
　

53　

聞
く
や
誰
遠
山
寺
の
鐘
の
声

《
解�

釈
》
寺
の
鐘
が
衝
か
れ
る
と
、
そ
の
音
は
四
方
に
響
き
伝
わ
る
が
、
遠
く
な
る
に
従
っ
て
小
さ

く
な
り
、
や
が
て
誰
に
も
聞
こ
え
な
く
な
る
。
寺
の
鐘
は
、
聞
く
人
の
仏
性
を
覚
醒
さ
せ
る
も

の
と
言
わ
れ
る
が
、
誰
に
も
聞
こ
え
な
け
れ
ば
、
そ
の
教
え
（
法
）
も
な
い
の
と
同
じ
だ
よ
ね
。

※�

前
句
の
内
容
を
、
意
外
な
状
況
設
定
に
取
り
な
し
、
強
引
に
理
屈
づ
け
て
知
的
に
遊
ん
だ
俳
諧
性

の
強
い
付
合
で
あ
る
。
第
三
八
句
等
を
参
照
さ
れ
た
い
。

　
　
　
　
　

聞
く
や
誰
遠
山
寺
の
鐘
の
声

　
　

54　

暁
月
は
我
の
み
も
見
じ

《
解�

釈
》
遠
く
の
山
寺
の
鐘
の
音
に
目
を
覚
ま
す
。
暁
の
空
を
仰
ぐ
と
、
月
が
か
か
っ
て
い
る
。
あ

の
鐘
の
音
を
聞
い
た
の
は
、
他
に
誰
が
い
る
の
だ
ろ
う
か
。
今
こ
の
月
を
眺
め
て
い
る
の
は
、

私
だ
け
で
は
な
い
だ
ろ
う
け
れ
ど
…
…
。

※�

前
句
の
「
誰
」
に
対
し
て
「
我
」
と
付
け
て
い
る
の
が
、
ち
ょ
っ
と
し
た
ポ
イ
ン
ト
。
「
昔
の
夢

は
誰
に
見
す
ら
む
／
我
を
だ
に
忘
る
ゝ
ほ
ど
に
身
は
老
い
て
」（
延
文
五
年
十
一
月
十
三
日
「
何
船
」

一
六
／
一
七
）
な
ど
、
古
く
か
ら
あ
る
手
法
で
あ
る
。

※�

「
鐘
」
に
「
暁
」
が
寄
合
。
他
の
例
は
「
帰
る
さ
の
も
の
と
こ
そ
聞
け
鐘
の
声
／
逢
ふ
も
名
残
の

つ
ら
き
暁
」
（
応
永
三
十
一
年
二
月
二
十
五
日
「
唐
何
」
五
九
／
六
〇
）
な
ど
。
「
高
砂
の
尾
上
の

鐘
の
音
す
な
り
暁
か
け
て
霜
や
お
く
ら
む
」
（
千
載
・
六
‐
三
九
八
、
前
中
納
言
匡
房
）
が
有
名
。

　
　
　
　
　

暁
月
は
我
の
み
も
見
じ

　
　

55　

あ
や
に
く
に
秋
の
空
な
ど
時
雨
る
ら
む

《
解�

釈
》
暁
の
月
を
眺
め
て
い
る
と
、
あ
い
に
く
時
雨
が
降
っ
て
き
た
。
暁
の
空
、
時
雨
の
雲
間
に

薄
く
光
を
放
つ
有
明
の
月
の
凄
々
た
る
姿
。
今
そ
れ
を
見
て
い
る
の
は
、
私
だ
け
で
は
な
い
だ

ろ
う
け
れ
ど
…
…
。

※�

「
神
無
月
有
明
の
空
の
時
雨
る
ゝ
を
ま
た
我
な
ら
ぬ
人
や
見
る
ら
む
」
（
詞
花
・
九
‐
三
二
四
、

赤
染
衛
門
）
を
念
頭
に
し
た
付
合
で
あ
ろ
う
。
詞
書
に
「
思
ふ
こ
と
は
べ
り
け
る
頃
、
寝
の
ね
ら

れ
ず
侍
り
け
れ
ば
、
夜
も
す
が
ら
眺
め
明
か
し
て
、
有
明
の
月
の
く
ま
な
く
侍
り
け
る
が
、
に
は

か
に
か
き
暗
し
時
雨
れ
け
る
を
見
て
詠
め
る
」
と
あ
る
。

　
　
　
　
　

あ
や
に
く
に
秋
の
空
な
ど
時
雨
る
ら
む

　
　

56　

露
け
く
わ
く
る
野
辺
の
ゆ
く
す
ゑ

《
解�

釈
》
冬
が
来
る
ま
で
に
と
道
を
急
ぐ
旅
な
の
に
、
あ
い
に
く
の
時
雨
で
道
が
は
か
ど
ら
な
い
。

降
り
過
ぎ
た
あ
と
も
、
置
き
残
さ
れ
た
露
で
び
し
ょ
濡
れ
に
な
り
な
が
ら
、
私
は
野
を
分
け
て

行
く
の
だ
。

　
　
　
　
　

露
け
く
わ
く
る
野
辺
の
ゆ
く
す
ゑ

　
　

57　

故
郷
も
か
ゝ
ら
ば
よ
し
や
旅
の
暮

《
解�

釈
》
露
で
袖
を
び
し
ょ
濡
れ
に
し
な
が
ら
、
野
辺
の
道
を
行
く
。
も
う
夕
暮
だ
。
今
夜
は
ど
こ

を
旅
の
宿
り
と
す
る
こ
と
に
な
る
の
だ
ろ
う
か
。
故
郷
も
今
頃
は
、
同
じ
よ
う
に
夕
露
で
い
っ

ぱ
い
に
な
っ
て
い
る
こ
と
だ
ろ
う
。
し
か
し
、
故
郷
に
い
れ
ば
、
今
夜
の
宿
り
を
捜
す
必
要
は

な
い
の
だ
。
旅
の
辛
さ
が
改
め
て
身
に
し
み
、
私
の
袖
は
涙
で
更
に
露
け
く
な
る
。

※�

「
此
く
あ
る
」
の
「
か
ゝ
る
」
に
「
降
り
か
ゝ
る
」
の
「
か
ゝ
る
」
を
利
か
し
て
、「
露
」
に
「
か
ゝ

る
」
が
寄
合
。
他
の
例
は
「
忘
ら
れ
ぬ
露
の
な
さ
け
の
身
に
し
み
て
／
か
ゝ
る
思
ひ
を
い
か
に
か

も
せ
む
」
（
明
応
九
年
五
月
七
日
「
何
路
」
九
一
／
九
二
）
な
ど
。
た
だ
し
「
露
」
に
「
か
ゝ
る
」

と
付
け
る
の
は
用
付
で
、
後
の
連
歌
で
は
好
ま
れ
な
い
。

※�

「
旅
の
暮
」
と
い
う
表
現
か
ら
、
今
夜
の
宿
り
を
捜
し
て
い
る
状
況
を
想
起
で
き
る
か
ど
う
か
が

解
釈
の
ポ
イ
ン
ト
。
実
際
に
宗
祇
の
連
歌
を
真
摯
に
読
め
ば
、
そ
う
難
し
い
こ
と
で
は
な
い
。

　
　
　
　
　

故
郷
も
か
ゝ
ら
ば
よ
し
や
旅
の
暮

　
　

58　

誰
が
つ
ら
さ
と
か
身
の
憂
き
を
し
る

《
解�

釈
》
旅
中
の
夕
暮
。
今
夜
は
ど
こ
を
旅
の
宿
り
と
す
る
こ
と
に
な
る
の
だ
ろ
う
か
。
故
郷
に
い

た
ら
、
こ
ん
な
情
け
な
く
辛
い
思
い
を
し
な
く
て
も
す
む
の
に
、
一
体
誰
の
せ
い
だ
。
誰
の
せ

い
で
も
な
い
。
自
ら
の
意
志
で
故
郷
を
捨
て
た
私
自
身
の
せ
い
な
の
だ
。

※�

第
五
三
句
に
「
誰
」
が
用
い
ら
れ
て
お
り
、
同
字
が
間
隔
四
句
で
指
合
を
生
じ
て
い
る
。

28
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第
四
八
句
、
第
七
八
句
、
第
八
七
句
等
を
参
照
さ
れ
た
い
。

　
　
　
　
　

夢
に
な
さ
れ
ば
思
ひ
な
ら
め
や

　
　

39　

憂
か
れ
た
ゞ
さ
ら
ず
は
言
ひ
も
絶
え
つ
べ
し

《
解�

釈
》
こ
の
ま
ま
、
辛
く
て
も
か
ま
わ
な
い
。
そ
う
で
な
い
な
ら
、
一
切
関
係
が
切
れ
て
し
ま
っ

て
も
か
ま
わ
な
い
。
あ
な
た
と
出
会
っ
た
こ
と
を
夢
に
な
す
こ
と
が
で
き
る
な
ら
、
こ
ん
な
思

い
は
し
な
い
の
で
し
ょ
う
が
、
そ
ん
な
こ
と
は
で
き
ま
せ
ん
。
私
は
こ
れ
か
ら
も
、
あ
な
た
と

の
思
い
出
を
胸
に
し
て
、
生
き
て
ゆ
く
の
で
す
。

　
　
　
　
　

憂
か
れ
た
ゞ
さ
ら
ず
は
言
ひ
も
絶
え
つ
べ
し

　
　

40　

住
ま
じ
都
の
老
の
あ
ら
ま
し

《
解�

釈
》
都
で
の
生
活
は
、
私
に
と
っ
て
は
辛
い
こ
と
が
多
い
。
年
を
と
れ
ば
い
つ
か
閑
居
な
所
で

心
を
澄
ま
す
生
活
を
し
た
い
と
思
っ
て
は
い
る
が
、
中
々
そ
れ
が
果
た
せ
な
い
で
い
る
。
都
で

の
生
活
は
、こ
の
ま
ま
、
今
ま
で
ど
お
り
辛
い
こ
と
が
多
い
方
が
よ
い
の
だ
。
そ
う
で
な
け
れ
ば
、

心
を
澄
ま
す
暮
ら
し
が
し
た
い
と
も
言
わ
な
く
な
っ
て
し
ま
う
だ
ろ
う
。

　
　
　
　
　

住
ま
じ
都
の
老
の
あ
ら
ま
し

　
　

41　

つ
れ
な
く
や
人
ご
と
に
見
む
我
が
命

《
解�

釈
》
年
老
い
た
な
ら
、
都
に
は
住
ま
な
い
つ
も
り
だ
。
い
つ
ま
で
も
都
に
い
た
ら
、
誰
も
か
れ

も
が
、
老
い
さ
ら
ば
え
て
い
る
私
を
無
慈
悲
に
見
る
こ
と
だ
ろ
う
（
そ
れ
よ
り
は
、
人
離
れ
た

地
で
、
孤
独
に
耐
え
て
暮
ら
す
ほ
う
が
マ
シ
だ
）
。

　
　
　
　
　

つ
れ
な
く
や
人
ご
と
に
見
む
我
が
命

　
　

42　

惜
し
み
か
な
し
む
春
秋
の
空

《
解�

釈
》
老
い
さ
ら
ば
え
た
こ
の
身
。
誰
も
か
れ
も
が
、
そ
れ
を
無
慈
悲
に
見
て
い
る
こ
と
だ
ろ
う
。

こ
の
あ
と
、
何
度
の
春
秋
を
送
り
迎
え
る
こ
と
が
で
き
る
だ
ろ
う
か
。
そ
ん
な
に
多
い
は
ず
は

な
い
。
そ
う
で
あ
る
か
ら
こ
そ
、
春
秋
の
空
が
、
と
て
も
愛
し
く
惜
し
く
眺
め
ら
れ
る
の
だ
。

　
　
　
　
　

惜
し
み
か
な
し
む
春
秋
の
空

　
　

43　

山
里
に
経
れ
ば
草
木
を
心
に
て

《
解�

釈
》
山
里
の
生
活
も
長
く
な
っ
た
。
何
よ
り
も
心
が
寄
せ
ら
れ
る
の
は
、
四
季
折
々
の
草
木
の

様
と
空
の
移
り
変
わ
り
。
そ
れ
ら
を
愛
で
惜
し
み
な
が
ら
一
年
が
過
ぎ
て
行
く
の
だ
。

　
　
　
　
　

山
里
に
経
れ
ば
草
木
を
心
に
て

　
　

44　

思
ふ
こ
と
な
き
身
ぞ
し
づ
か
な
る

《
解�

釈
》
山
里
に
長
い
間
暮
ら
し
て
い
る
と
、
人
の
心
も
、
自
然
と
所
与
の
所
の
ま
ま
に
生
き
る
草

や
木
の
心
に
近
づ
く
だ
ろ
う
。
そ
う
な
れ
ば
、
人
た
る
が
故
の
煩
悩
か
ら
解
放
さ
れ
、
心
静
か

に
生
き
る
こ
と
が
で
き
る
の
だ
（
私
も
い
つ
か
そ
の
よ
う
に
な
り
た
い
）
。

　
　
　
　
　

思
ふ
こ
と
な
き
身
ぞ
し
づ
か
な
る

　
　

45　

乱
れ
し
も
ま
た
治
ま
れ
る
君
が
代
に

《
解�

釈
》
乱
れ
て
い
た
世
も
聖
王
の
御
代
と
な
り
、
四
海
無
事
に
治
ま
っ
て
い
る
。
人
々
は
、
苦
し

み
思
い
煩
う
こ
と
な
く
静
か
に
暮
ら
す
こ
と
が
で
き
る
。
有
難
い
こ
と
だ
。

※�

同
折
の
第
二
三
句
に
「
世
」
が
詠
ま
れ
て
い
る
が
、
「
代
」
は
一
座
二
句
物
、
「
世
」
は
一
座
五
句

物
で
範
疇
を
異
に
す
る
の
で
、
支
障
は
な
い
。

　
　
　
　
　

乱
れ
し
も
ま
た
治
ま
れ
る
君
が
代
に

　
　

46　

今
よ
り
道
の
末
た
ゞ
し
か
れ

《
解�

釈
》
乱
れ
て
い
た
世
も
聖
王
の
御
代
と
な
り
、
四
海
無
事
に
治
ま
っ
て
い
る
。
政
の
道
が
、
今

か
ら
世
の
末
ま
で
正
し
く
あ
れ
と
、
祈
ら
ず
に
は
い
ら
れ
な
い
。

　
　
　
　
　

今
よ
り
道
の
末
た
ゞ
し
か
れ

　
　

47　

待
ち
〳
〵
し
日
よ
り
を
今
日
の
船
に
え
て

《
解�

釈
》
船
の
旅
。
天
候
に
恵
ま
れ
ず
港
を
出
る
こ
と
が
で
き
な
い
で
い
た
が
、
今
日
、
漸
く
天
候

が
回
復
し
た
。
こ
れ
か
ら
船
が
航
路
を
正
し
く
と
っ
て
、
目
的
地
に
無
事
に
着
き
ま
す
よ
う
に
。

※�

前
句
の
「
道
」
は
先
の
付
合
で
は
「
政
の
道
」
の
こ
と
。
そ
れ
を
「
船
の
道
」
（
航
路
）
に
取
り

な
し
て
の
句
境
の
転
換
が
鮮
や
か
で
あ
る
。
『
下
草
』
に
入
集
す
る
が
（
続
類
従
本
五
五
二
）
、
そ

こ
が
宗
祇
の
気
に
入
っ
た
所
で
あ
ろ
う
。

　
　
　
　
　

待
ち
〳
〵
し
日
よ
り
を
今
日
の
船
に
え
て

　
　

48　

波
馴
れ
衣
は
か
な
く
ぞ
干
す

《
解�

釈
》
天
候
に
恵
ま
れ
ず
ず
っ
と
漁
に
出
る
こ
と
が
で
き
な
い
で
い
た
が
、
今
日
は
漸
く
天
候
が

回
復
し
て
船
を
出
す
こ
と
が
で
き
る
。
常
は
波
に
濡
れ
て
よ
れ
よ
れ
に
な
っ
て
い
る
海
士
た
ち

の
衣
も
、
こ
の
悪
天
候
の
間
に
干
さ
れ
て
乾
い
た
よ
う
だ
が
、
ま
た
、
濡
れ
て
し
ま
う
の
だ
。

※�

「
は
か
な
し
」
は
、こ
の
場
合
「
手
ご
た
え
が
な
い
。
頼
り
な
い
。
む
な
し
い
」（
岩
波
古
語
辞
典
）

の
意
。
「
ど
う
せ
す
ぐ
に
濡
れ
る
の
に
、
干
し
て
も
空
し
い
よ
ね
」
と
、
こ
と
さ
ら
な
理
屈
で
面

白
が
っ
て
い
る
所
に
ち
ょ
っ
と
し
た
俳
諧
味
が
あ
る
。

　
　
　
　
　

波
馴
れ
衣
は
か
な
く
ぞ
干
す

　
　

49　

恋
は
淵
仮
の
あ
ふ
瀬
を
た
の
む
な
よ

《
解�

釈
》
恋
の
深
い
淵
に
落
ち
た
人
の
衣
は
、
い
つ
も
涙
で
び
し
ょ
濡
れ
。
そ
れ
は
、
ま
る
で
海
士

た
ち
の
波
馴
れ
衣
と
同
じ
。
恋
し
い
人
に
逢
う
時
は
干
さ
れ
て
乾
く
か
も
知
れ
な
い
が
、
そ
れ

も
所
詮
は
か
な
い
一
時
的
な
こ
と
。
別
れ
た
後
は
、
ま
た
涙
で
濡
れ
る
の
だ
。

※�

前
句
の
「
衣
」
は
、
先
の
付
合
で
は
、
字
義
ど
お
り
漁
り
の
際
の
波
に
濡
れ
た
衣
。
そ
れ
を
、
恋

の
涙
に
濡
れ
る
衣
と
し
て
、
優
美
な
表
現
で
、
鮮
や
か
に
句
境
を
転
じ
て
い
る
。

※�
第
四
七
句
か
ら
水
辺
が
三
句
連
続
。
よ
っ
て
体
用
の
沙
汰
が
必
要
だ
が
、
第
四
七
句
「
船
」
は
体

用
の
外
で
あ
る
の
で
、
問
題
は
生
じ
な
い
。

　
　
　
　
　

恋
は
淵
仮
の
あ
ふ
瀬
を
た
の
む
な
よ

　
　

50　

憂
き
人
心
何
か
常
な
る

《
解�

釈
》
辛
い
こ
と
だ
が
、
人
の
心
が
永
続
す
る
こ
と
は
な
い
。
必
ず
い
つ
か
は
移
り
ゆ
く
も
の
な

の
だ
。
そ
れ
を
カ
ン
違
い
し
て
、
一
時
的
な
逢
瀬
を
「
い
つ
ま
で
も
」
と
あ
て
に
し
て
は
い
け

な
い
。
流
れ
る
川
の
瀬
が
淵
に
な
る
よ
う
に
、
逢
瀬
は
、
す
ぐ
に
涙
の
深
い
淵
と
な
る
の
だ
。

※�

前
句
の
「
淵
」
「
瀬
」
に
対
し
、
「
何
か
常
な
る
」
と
付
け
た
所
が
ポ
イ
ン
ト
。
有
名
な
「
世
の
中

29
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共
に
憐
れ
む
契
り
な
ら
ば
や

　
　

31　

忘
る
と
て
そ
れ
に
倣
は
む
こ
と
も
な
し

《
解�
釈
》
仮
に
あ
な
た
が
私
の
こ
と
を
忘
れ
て
し
ま
っ
て
も
、
私
も
あ
な
た
に
倣
っ
て
あ
な
た
の
こ

と
を
忘
れ
て
し
ま
っ
た
り
は
し
ま
せ
ん
。
私
も
忘
れ
て
し
ま
え
ば
、
二
人
の
仲
は
そ
れ
切
り
で
す
。

で
も
、
私
が
忘
れ
ず
に
い
る
と
、
あ
な
た
が
私
の
こ
と
を
思
い
出
し
さ
え
す
れ
ば
、
ま
た
、
今

ま
で
と
同
じ
よ
う
に
、
互
い
に
思
い
あ
う
仲
と
な
る
こ
と
が
で
き
ま
す
。
私
た
ち
二
人
の
関
係
は
、

前
世
か
ら
そ
の
よ
う
に
決
ま
っ
て
い
る
の
で
す
よ
。

※�

『
下
草
』
に
入
集
す
る
（
続
類
従
本
七
一
二
）
。
仲
の
よ
い
夫
婦
の
戯
れ
の
会
話
と
し
た
付
合
で

あ
る
。
伝
統
的
な
「
恋
」
の
作
法
に
反
し
た
付
合
で
、
そ
こ
に
俳
諧
味
も
感
じ
ら
れ
る
が
、
そ
れ

も
宗
祇
連
歌
の
恋
句
の
一
体
。
「
ま
ば
ゆ
か
ら
し
な
さ
の
み
慕
ふ
な
／
契
り
来
し
中
の
年
月
つ
も

り
来
て
」
（
三
島
千
句
・
第
九
「
朝
何
」
四
〇
／
四
一
）
な
ど
も
こ
の
類
で
あ
ろ
う
。

　
　
　
　
　

忘
る
と
て
そ
れ
に
倣
は
む
こ
と
も
な
し

　
　

32　

恨
み
の
ほ
ど
は
知
ら
れ
こ
そ
せ
め

《
解�

釈
》
あ
な
た
は
私
の
こ
と
を
す
っ
か
り
忘
れ
て
し
ま
っ
て
い
る
か
も
知
れ
ま
せ
ん
が
、
私
は
、

あ
な
た
と
同
じ
よ
う
に
あ
な
た
の
こ
と
を
忘
れ
た
り
は
し
ま
せ
ん
。
忘
れ
よ
う
と
し
て
も
、
無

情
な
あ
な
た
へ
の
恨
み
が
、
心
に
思
い
知
ら
れ
る
か
ら
で
す
。

※�

「
知
ら
れ
こ
そ
せ
め
」
の
「
れ
」
が
、「
自
発
」
の
助
動
詞
で
あ
る
と
す
る
の
が
解
釈
の
ポ
イ
ン
ト
。

忘
れ
去
ら
れ
た
女
性
の
せ
つ
な
い
思
い
が
よ
く
表
現
さ
れ
た
好
付
合
で
は
あ
る
ま
い
か
。

　
　
　
　
　

恨
み
の
ほ
ど
は
知
ら
れ
こ
そ
せ
め

　
　

33　

大
淀
の
松
に
よ
る
波
さ
わ
ぐ
な
よ

《
解�

釈
》
大
淀
の
松
に
打
ち
寄
せ
る
波
よ
、
そ
ん
な
に
立
ち
騒
ぐ
な
。
お
前
が
「
恨
み
て
返
る
」
と

い
う
こ
と
は
、
わ
ざ
わ
ざ
騒
が
な
く
と
も
、
も
う
皆
に
知
ら
れ
て
い
る
こ
と
だ
ろ
う
か
ら
。

※�

「
大
淀
の
松
は
つ
ら
く
も
あ
ら
な
く
に
う
ら
み
て
の
み
も
返
る
波
か
な
」
（
新
古
今
・
一
五
‐

一
四
三
三
、
よ
み
人
し
ら
ず
）
の
和
歌
（
伊
勢
物
語
に
も
あ
り
）
に
依
拠
し
た
付
合
で
あ
る
。
古

歌
を
利
用
し
て
の
句
境
の
転
換
が
き
れ
い
に
決
ま
っ
て
い
る
。
な
お
、
前
句
の
「
知
ら
れ
」
の
「
れ
」

は
、
こ
の
付
合
で
は
受
身
の
助
動
詞
に
な
る
。

　
　
　
　
　

大
淀
の
松
に
よ
る
波
さ
わ
ぐ
な
よ

　
　

34　

見
る
目
も
く
る
し
風
に
ゆ
く
船

《
解�

釈
》
船
が
、
風
に
煽
ら
れ
な
が
ら
苦
し
げ
に
行
く
の
が
見
え
る
。
大
淀
の
松
に
打
ち
寄
せ
る
波
よ
、

そ
ん
な
に
立
ち
騒
ぐ
な
。
あ
の
船
が
転
覆
し
て
し
ま
う
で
は
な
い
か
。

※�

「
見
る
目
」
に
「
海
松
布
」
が
利
か
さ
れ
、
そ
れ
が
「
大
淀
」
「
波
」
と
寄
合
。
例
は
「
大
淀
や

波
さ
へ
帰
る
浦
さ
び
て
／
仮
の
見
る
目
に
の
こ
る
面
影
」
（
住
吉
千
句
・
第
一
「
何
船
」
六
九
／

七
〇
）
な
ど
。
証
歌
は
「
海
士
の
刈
る
み
る
め
を
余
所
に
大
淀
の
松
は
霞
み
て
か
へ
る
浦
波
」（
建

保
名
所
百
首
・
二
〇
九
、
俊
成
卿
女
）
な
ど
。
ま
た
「
波
」
と
「
船
」
が
寄
合
な
の
は
常
識
。

※�

近
代
の
注
は
、
こ
の
句
を
「
旅
」
と
す
る
が
、
「
行
く
船
」
だ
け
で
は
「
旅
」
と
し
て
取
り
扱
わ

れ
な
い
。
一
例
を
挙
げ
る
と
、
永
正
七
年
四
月
一
日
「
何
人
」
第
五
六
句
で
「
群
れ
つ
ゝ
越
え
る

関
の
旅
人
」
と
詠
ま
れ
た
後
、
第
六
〇
句
で
「
さ
し
て
行
く
〳
〵
船
見
え
ず
な
る
」
と
詠
ま
れ
て

い
る
。
も
し
「
旅
」
で
あ
る
な
ら
五
句
以
上
を
隔
て
ね
ば
な
ら
な
い
。
第
八
句
を
参
照
さ
れ
た
い
。

　
　
　
　
　

見
る
目
も
く
る
し
風
に
ゆ
く
船

　
　

35　

越
え
が
た
き
秋
の
山
路
に
や
す
ら
ひ
て

《
解�

釈
》
峻
嶮
な
山
を
越
え
て
行
く
途
中
、
眺
望
の
利
く
所
で
一
休
み
す
る
。
船
が
風
に
煽
ら
れ
な

が
ら
苦
し
げ
に
行
く
の
が
見
え
る
。
船
の
旅
は
楽
な
よ
う
だ
が
、
そ
れ
は
海
が
穏
や
か
な
場
合

だ
け
。
旅
が
苦
し
く
危
険
な
も
の
で
あ
る
こ
と
に
違
い
は
な
い
。

　
　
　
　
　

越
え
が
た
き
秋
の
山
路
に
や
す
ら
ひ
て

　
　

36　

仮
寝
の
袂
月
に
し
を
る
る

《
解�

釈
》
峻
嶮
な
山
を
越
え
て
行
く
旅
。
山
路
の
途
中
だ
が
、
今
日
は
も
う
こ
れ
以
上
行
く
こ
と
は

無
理
だ
と
考
え
、
こ
こ
で
仮
寝
す
る
こ
と
に
し
た
。
月
が
出
て
い
る
。
旅
の
辛
さ
が
身
に
し
み
、

こ
ぼ
れ
る
涙
で
袂
が
萎
れ
る
。

※�

第
二
八
句
で
「
月
」
が
詠
ま
れ
て
お
り
、
同
面
で
二
句
目
の
「
月
」
で
あ
る
が
、
「
月
」
各
面
一

句
の
作
法
が
絶
対
化
さ
れ
る
の
は
、
紹
巴
以
後
の
連
歌
。
宗
祇
の
時
代
の
連
歌
で
は
、
互
い
に
七

句
以
上
を
隔
て
て
さ
え
い
れ
ば
、
同
面
に
「
月
」
が
二
句
詠
ま
れ
よ
う
と
、
「
月
」
が
詠
ま
れ
な

い
面
が
あ
ろ
う
と
、
何
ら
問
題
に
な
る
こ
と
で
は
な
か
っ
た
。
実
際
に
調
べ
れ
ば
す
ぐ
に
明
ら
か

に
な
る
こ
と
で
あ
る
。
以
下
、
こ
の
点
に
つ
い
て
は
、
一
々
に
言
及
し
な
い
。

　
　
　
　
　

仮
寝
の
袂
月
に
し
を
る
る

　
　

37　

庵
近
く
虫
も
わ
び
つ
ゝ
明
か
す
夜
に

《
解�

釈
》
こ
の
茅
屋
に
一
夜
の
宿
り
を
よ
う
や
く
借
り
る
こ
と
が
で
き
た
。
寝
よ
う
と
す
る
と
、
月

が
出
て
い
る
。
様
々
な
思
い
が
胸
に
去
来
し
、
寝
付
く
こ
と
が
で
き
な
い
。
旅
の
辛
さ
が
身
に

し
み
、
こ
ぼ
れ
る
涙
で
袂
が
萎
れ
る
。
近
く
で
は
虫
が
鳴
い
て
い
る
。
虫
よ
、
お
前
も
、
私
と

同
じ
よ
う
に
、
こ
の
一
夜
を
侘
び
つ
つ
泣
（
鳴
）
き
明
か
す
の
か
。

　
　
　
　
　

庵
近
く
虫
も
わ
び
つ
ゝ
明
か
す
夜
に

　
　

38　

夢
に
な
さ
れ
ば
思
ひ
な
ら
め
や

《
解�

釈
》
草
庵
で
の
独
居
生
活
の
秋
の
夜
、
眠
ろ
う
と
し
て
も
、
様
々
な
過
去
が
胸
に
去
来
し
寝
付

く
こ
と
が
で
き
な
い
。
近
く
で
虫
の
鳴
く
声
が
す
る
。
虫
も
私
と
同
じ
よ
う
に
、
こ
の
一
夜
を

侘
び
つ
つ
泣
（
鳴
）
き
明
か
す
こ
と
だ
ろ
う
。
も
し
過
去
を
全
て
「
夢
に
な
す
」
こ
と
が
で
き

る
な
ら
、
こ
ん
な
思
い
は
し
な
い
の
だ
け
れ
ど
、
そ
れ
は
無
理
。
眠
れ
な
い
の
だ
か
ら
、
夢
を

見
る
こ
と
が
で
き
な
い
。
だ
っ
た
ら
、
「
夢
に
な
す
」
こ
と
な
ど
で
き
る
は
ず
が
な
い
で
は
な
い

か
。

※�

前
句
の
「
明
か
す
」
に
着
目
し
て
、
眠
ら
な
い
の
だ
か
ら
夢
は
見
な
い
と
い
う
理
屈
に
気
付
く
の

が
解
釈
の
ポ
イ
ン
ト
。
情
趣
的
な
表
現
に
包
ま
れ
て
い
る
が
、
意
表
を
突
い
た
論
理
を
主
眼
と
し

た
俳
諧
味
の
強
い
付
合
で
あ
る
。
こ
れ
も
宗
祇
連
歌
の
一
体
。
前
句
を
「
寝
で
明
か
す
恨
み
今
朝

な
ほ
残
り
け
り
」
な
ど
と
い
う
俗
流
な
句
に
置
き
換
え
れ
ば
、
こ
の
付
合
の
論
理
の
意
外
性
と
俳

諧
性
は
解
り
や
す
く
な
ろ
う
。
「
虫
も
わ
び
つ
ゝ
」
の
「
も
」
が
効
い
て
い
る
。
な
お
第
二
七
句
、

30
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冽
な
夕
波
が
打
ち
寄
せ
、
群
生
す
る
芦
が
風
に
揺
れ
て
い
る
。
上
空
は
ま
だ
霧
に
覆
わ
れ
て
い

る
の
で
姿
は
見
え
な
い
が
、
雁
が
渡
っ
て
行
く
の
で
あ
ろ
う
、
そ
の
鳴
く
声
が
聞
こ
え
る
。

※�
近
代
の
注
に
は
「
は
れ
の
ぼ
る
」
の
語
は
勅
撰
集
に
は
な
い
と
あ
る
が
、
「
外
面
な
る
楢
の
葉
し

を
れ
露
お
ち
て
霧
は
れ
の
ぼ
る
秋
の
山
本
」
（
玉
葉
・
五
‐
七
三
六
、
前
参
議
雅
有
）
な
ど
の
例

が
あ
る
。
連
歌
で
は
「
霧
は
れ
の
ぼ
る
四
方
の
大
空
」（
文
安
月
千
句
・
第
九
「
何
水
」
二
）
な
ど
。

　
　
　
　
　

晴
れ
の
ぼ
る
霧
の
む
ら
芦
風
見
え
て

　
　

22　

ま
た
か
き
乱
れ
時
雨
れ
て
ぞ
ゆ
く

《
解�

釈
》
時
雨
が
降
り
通
っ
た
後
の
海
辺
。
霧
が
立
ち
昇
る
に
つ
れ
て
、
下
の
方
が
次
第
に
晴
れ
て

行
き
、
風
が
、
群
生
し
た
芦
の
葉
い
っ
ぱ
い
に
置
か
れ
た
露
を
、
ま
る
で
も
う
一
度
時
雨
が
来

た
か
と
思
う
ほ
ど
に
吹
き
散
ら
し
て
い
る
の
が
見
え
る
。

※�

付
句
の
「
ま
た
」
と
い
う
措
辞
か
ら
、
時
雨
が
直
前
に
一
度
降
り
通
っ
て
い
る
こ
と
を
読
み
と
る

所
が
解
釈
の
ポ
イ
ン
ト
で
あ
る
。

※�

「
芦
」
に
「
乱
る
」
が
寄
合
。
他
の
例
は
「
穂
に
出
づ
る
芦
間
に
通
ふ
船
見
え
て
／
払
ひ
も
あ
へ

ず
露
乱
る
ら
む
」（
顕
証
院
会
千
句
・
第
二
「
何
人
」
三
一
／
三
二
）
な
ど
。
た
だ
し
「
芦
」
に
「
乱

る
」
は
所
謂
「
用
付
」
で
、
後
の
連
歌
で
は
好
ま
れ
な
い
。

　
　
　
　
　

ま
た
か
き
乱
れ
時
雨
れ
て
ぞ
ゆ
く

　
　

23　

ふ
り
す
て
し
袖
は
誰
が
世
に
引
か
る
ら
む

《
解�

釈
》
き
っ
ぱ
り
と
振
り
捨
て
た
は
ず
の
俗
世
。
そ
れ
な
の
に
、
私
の
心
は
時
に
激
し
く
乱
れ
、

袖
に
涙
の
時
雨
が
降
る
。
こ
れ
は
一
体
、
い
つ
の
過
去
世
の
誰
と
の
縁
に
引
か
れ
て
い
る
か
ら

な
の
だ
ろ
う
か
。

※�

前
句
の
「
時
雨
」
を
、
「
涙
の
時
雨
」
に
取
り
な
し
て
句
境
を
鮮
や
か
に
転
じ
て
い
る
。

※�

付
句
の
「
ふ
り
す
て
」
に
は
「
降
る
」
が
利
か
さ
れ
、
そ
れ
が
降
物
（
こ
の
場
合
は
、
時
雨
）
と

寄
り
合
う
。
他
の
例
を
あ
げ
る
と
、
「
あ
と
は
た
ゞ
振
り
捨
て
ゝ
ゆ
く
鈴
鹿
山
／
秋
の
時
雨
に
ぬ

れ
〳
〵
し
袖
」
（
氏
富
家
千
句
・
第
九
「
百
何
」
七
三
／
七
四
）
な
ど
。
「
古
る
」
「
経
る
」
も
同

じ
よ
う
に
用
い
ら
れ
、
稀
で
は
あ
る
が
確
立
さ
れ
た
テ
ク
ニ
ッ
ク
で
あ
る
。

　
　
　
　
　

ふ
り
す
て
し
袖
は
誰
が
世
に
引
か
る
ら
む

　
　

24　

身
は
し
の
ぶ
べ
き
い
に
し
へ
も
な
し

《
解�

釈
》
一
度
は
き
っ
ぱ
り
と
振
り
捨
て
た
は
ず
の
俗
世
。
そ
れ
な
の
に
、
時
に
袖
を
引
か
れ
る
よ

う
な
思
い
に
な
る
。
自
分
に
は
、
偲
び
た
く
な
る
よ
う
な
昔
の
懐
か
し
い
思
い
出
な
ん
て
何
も

な
い
の
に
、
こ
れ
は
一
体
、
い
つ
の
過
去
世
の
誰
と
の
縁
に
因
る
も
の
な
の
だ
ろ
う
か
。

　
　
　
　
　

身
は
し
の
ぶ
べ
き
い
に
し
へ
も
な
し

　
　

25　

い
づ
く
に
て
す
め
る
も
仮
の
草
の
戸
に

《
解�

釈
》
自
分
に
は
偲
び
た
く
な
る
よ
う
な
昔
の
懐
か
し
い
思
い
出
な
ん
て
何
も
な
い
。
ど
こ
で
住

も
う
と
、
所
詮
こ
の
世
は
仮
の
も
の
、
そ
う
思
い
き
っ
て
こ
の
草
庵
に
住
む
こ
と
に
し
た
の
だ
。

※�

解
釈
に
は
言
わ
な
か
っ
た
が
「
そ
れ
な
の
に
こ
の
寂
し
さ
は
何
な
の
だ
ろ
う
」
と
言
外
に
言
っ
て

い
る
と
受
け
取
る
の
が
、
宗
祇
流
連
歌
に
対
す
る
態
度
で
あ
る
。
若
い
人
の
た
め
。

※�

「
草
の
戸
」
の
「
草
」
は
、
植
物
と
し
て
取
り
扱
わ
れ
な
い
の
が
古
来
の
作
法
。
従
っ
て
、
第

二
一
句
の
「
芦
」
と
も
、
第
二
七
句
の
「
花
」
と
も
、
指
合
に
な
ら
な
い
。

　
　
　
　
　

い
づ
く
に
て
住
め
る
も
仮
の
草
の
戸
に

　
　

26　

心
と
ま
る
は
た
ゞ
山
の
陰

《
解�

釈
》
所
詮
こ
の
世
は
仮
の
も
の
、ど
こ
で
住
も
う
と
同
じ
だ
と
は
理
屈
で
は
解
っ
て
い
る
け
れ
ど
、

そ
れ
は
悟
り
き
っ
た
場
合
の
こ
と
。
自
分
の
よ
う
な
中
途
半
端
な
者
は
や
は
り
、
閑
寂
な
山
陰

で
暮
ら
し
た
い
と
思
わ
れ
る
の
だ
。

　
　
　
　
　

心
と
ま
る
は
た
ゞ
山
の
陰

　
　

27　

鳥
の
音
も
夕
暮
深
き
花
に
来
て

《
解�

釈
》
夕
暮
の
色
が
次
第
に
深
く
な
る
頃
、
私
は
山
陰
に
咲
く
花
を
な
が
め
て
い
る
。
帰
ら
ね
ば

と
思
う
が
、
中
々
こ
こ
を
離
れ
る
こ
と
が
で
き
な
い
。
鳥
も
塒
に
帰
る
は
ず
の
頃
な
の
に
、
わ

ざ
わ
ざ
や
っ
て
き
て
枝
に
止
ま
り
鳴
い
て
い
る
。
鳥
よ
、
お
前
も
こ
の
花
に
心
が
留
ま
る
の
か
。

※�

付
合
の
ポ
イ
ン
ト
は
、
前
句
の
「
心
と
ま
る
」
の
「
と
ま
る
」
を
、「
鳥
が
花
の
枝
に
来
て
止
ま
る
」

に
利
か
せ
て
い
る
所
で
あ
る
。
発
想
に
意
外
性
が
あ
り
、
そ
こ
に
俳
諧
味
が
感
じ
ら
れ
る
。
近
代

の
研
究
者
に
は
殆
ど
無
視
さ
れ
て
い
る
が
、
そ
れ
も
、
宗
祇
流
連
歌
の
一
つ
の
要
素
と
し
て
忘
れ

ら
れ
る
べ
き
で
は
な
い
。
『
下
草
』
に
入
集
（
続
類
従
本
一
〇
〇
〇
）
す
る
。
な
お
第
三
八
句
等

を
参
照
さ
れ
た
い
。

　
　
　
　
　

鳥
の
音
も
夕
暮
深
き
花
に
来
て

　
　

28　

霞
む
を
見
れ
ば
月
ぞ
仄
め
く

《
解�

釈
》
夕
暮
の
花
。
あ
た
り
は
次
第
に
暗
く
な
っ
て
行
く
が
、
鳥
は
ま
だ
帰
り
た
く
な
さ
げ
に
鳴

い
て
い
る
。
空
を
仰
ぐ
と
、
月
が
出
た
よ
う
だ
、
霞
の
向
こ
う
に
仄
か
な
光
が
見
え
る
。

　
　
　
　
　

霞
む
を
見
れ
ば
月
ぞ
仄
め
く

　
　

29　

春
の
夜
を
思
は
ぬ
人
や
待
た
る
ら
む

《
解�

釈
》
春
の
夜
の
空
は
薄
く
霞
が
か
か
っ
て
い
る
が
、
そ
れ
を
通
し
て
、
仄
か
に
月
が
光
を
放
っ

て
い
る
の
が
見
え
る
。
こ
の
春
の
夜
の
情
趣
に
惹
か
れ
て
、
あ
の
人
が
訪
ね
て
く
る
だ
ろ
う
と

期
待
し
て
い
ま
す
が
、
あ
の
人
は
ま
だ
来
な
い
の
で
す
。
ひ
ょ
っ
と
し
て
あ
の
人
は
、
こ
ん
な

素
敵
な
情
趣
も
理
解
で
き
な
い
人
な
の
で
し
ょ
う
か
。
い
や
、
そ
ん
な
こ
と
は
あ
る
ま
い
。

　
　
　
　
　

春
の
夜
を
思
は
ぬ
人
や
待
た
る
ら
む

　
　

30　

共
に
憐
れ
む
契
り
な
ら
ば
や

《
解�
釈
》
約
束
ど
お
り
、
あ
の
人
が
訪
ね
て
き
て
く
れ
て
、
二
人
で
、
こ
の
情
趣
深
い
春
の
一
夜
を

共
に
し
た
い
と
待
っ
て
い
ま
す
が
、
あ
の
人
は
ま
だ
来
な
い
の
で
す
。ひ
ょ
っ
と
し
て
あ
の
人
は
、

こ
ん
な
春
の
夜
の
情
趣
も
理
解
で
き
な
い
人
な
の
で
し
ょ
う
か
。
い
や
、
そ
ん
な
こ
と
は
あ
る

ま
い
。
き
っ
と
来
て
く
れ
る
は
ず
だ
と
思
っ
て
、
私
は
な
お
あ
の
人
を
待
っ
て
い
る
の
で
す
。

※�

前
句
の
「
春
の
夜
」
に
対
し
『
和
漢
朗
詠
集
』
「
春
夜
」
の
部
に
引
か
れ
て
有
名
な
「
背
灯
共
憐

深
夜
月
」
（
白
楽
天
）
の
詩
句
に
拠
っ
て
「
共
に
憐
れ
む
」
と
付
け
た
付
合
で
あ
る
。
な
お
、
詩

句
の
原
拠
は
『
白
氏
文
集
』
巻
十
三
「
春
中
与
廬
四
周
諒
華
陽
観
同
居
」
。

31
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の
里
は
、
ど
こ
だ
っ
た
の
だ
ろ
う
か
。
今
は
も
う
判
然
と
し
な
く
な
っ
て
い
る
。

　
　
　
　
　

見
る
が
う
ち
に
昔
と
も
な
き
夢
さ
め
て

　
　

12　

そ
の
人
な
ら
ぬ
面
影
ぞ
憂
き

《
解�

釈
》
あ
な
た
の
夢
を
見
ま
し
た
。
目
が
覚
め
て
も
、
そ
の
面
影
は
は
っ
き
り
と
残
っ
て
い
ま
す
。

で
も
そ
れ
は
、
今
の
あ
な
た
の
面
影
で
は
あ
り
ま
せ
ん
。
以
前
、
私
を
誰
よ
り
も
愛
し
て
く
れ

て
い
た
頃
の
あ
な
た
の
面
影
な
の
で
す
。
あ
の
頃
の
あ
な
た
は
、
ど
こ
へ
行
っ
て
し
ま
っ
た
の

で
し
ょ
う
か
。
私
は
辛
く
て
な
り
ま
せ
ん
。

※�

「
憂
し
」な
ど
と
い
う
主
観
的
な
語
を
用
い
て
、
あ
た
か
も
作
者
が
当
事
者
の
ご
と
き
立
場
に
な
っ

て
付
け
る
の
が
宗
祇
好
み
の
「
恋
」
の
手
法
。
「
心
変
は
り
し
人
の
面
影
」
な
ど
と
す
る
の
が
平

凡
で
普
通
。
「
人
の
心
の
変
は
る
世
の
中
」
な
ど
と
す
る
の
が
下
手
の
極
み
。
若
い
人
の
た
め
。

　
　
　
　
　

そ
の
人
な
ら
ぬ
面
影
ぞ
憂
き

　
　

13　

昨
日
今
日
な
れ
き
て
何
か
憎
か
ら
む

《
解�

釈
》
心
変
わ
り
を
し
て
、
あ
な
た
は
私
か
ら
去
っ
て
行
き
ま
し
た
。
そ
れ
で
も
、
私
は
あ
な
た

を
愛
し
て
い
ま
す
。
ほ
ん
の
少
し
前
ま
で
、
一
緒
に
時
を
す
ご
し
た
仲
で
す
。
あ
な
た
が
心
変

わ
り
し
た
か
ら
と
言
っ
て
、
急
に
あ
な
た
を
憎
む
こ
と
な
ど
で
き
な
い
の
で
す
。
今
で
も
、
あ

な
た
の
面
影
が
浮
か
び
ま
す
。
で
も
そ
れ
は
、
今
の
あ
な
た
の
面
影
で
は
あ
り
ま
せ
ん
。
以
前
、

私
を
誰
よ
り
も
愛
し
て
く
れ
て
い
た
頃
の
あ
な
た
の
面
影
な
の
で
す
。
私
は
辛
く
て
な
り
ま
せ

ん
。

※�

付
句
の
「
何
か
憎
か
ら
む
」
を
、
自
ら
に
対
す
る
自
問
自
答
の
上
の
反
語
と
し
て
解
釈
す
る
の
が
、

宗
祇
流
の
連
歌
と
し
て
正
し
い
。
こ
れ
は
、
宗
祇
の
連
歌
を
読
み
続
け
る
こ
と
に
よ
っ
て
、
お
の

ず
と
知
れ
る
所
で
あ
る
。
こ
れ
も
、
若
い
人
の
た
め
。
妄
言
多
謝
。

　
　
　
　
　

昨
日
今
日
な
れ
き
て
何
か
憎
か
ら
む

　
　

14　

思
ふ
あ
ま
り
の
恨
み
と
を
知
れ

《
解�

釈
》
あ
な
た
の
心
変
わ
り
が
恨
め
し
く
て
な
り
ま
せ
ん
。
け
れ
ど
、
私
が
あ
な
た
の
こ
と
を
何

と
も
思
っ
て
い
な
い
の
だ
と
し
た
ら
、
何
も
恨
め
し
く
は
思
わ
な
い
こ
と
で
し
ょ
う
。
あ
な
た

を
愛
し
て
い
る
か
ら
こ
そ
、
あ
な
た
が
恨
め
し
い
の
で
す
。
ほ
ん
の
少
し
前
ま
で
、
一
緒
に
時

を
す
ご
し
た
仲
で
す
。
あ
な
た
が
心
変
わ
り
し
た
か
ら
と
言
っ
て
、
急
に
あ
な
た
を
憎
む
こ
と

な
ど
、
で
き
る
は
ず
が
な
い
で
し
ょ
う
。

※�

第
一
〇
句
で
「
知
る
」
が
用
い
ら
れ
て
い
る
。
同
字
は
五
句
以
上
を
隔
て
ね
ば
な
ら
な
い
の
で
、

指
合
を
生
じ
て
い
る
。
後
の
紹
巴
時
代
の
連
歌
な
ら
、
そ
れ
だ
け
で
論
外
と
な
る
所
で
あ
る
が
、

宗
祇
の
連
歌
の
去
嫌
は
比
較
的
鷹
揚
で
あ
り
、
間
々
見
受
け
ら
れ
る
事
象
で
あ
る
。

　
　
　
　
　

思
ふ
あ
ま
り
の
恨
み
と
を
知
れ

　
　

15　

よ
し
や
花
散
ら
ば
そ
れ
と
も
打
ち
わ
び
て

《
解�

釈
》
「
花
よ
、
そ
ん
な
に
散
り
た
け
れ
ば
、
勝
手
に
散
れ
ば
い
い
。
私
は
そ
れ
で
い
い
の
だ
」
な

ど
と
、
お
前
に
対
し
て
私
が
言
う
の
も
、
本
当
は
、
お
前
が
散
っ
て
し
ま
う
の
が
、
余
り
に
惜

し
く
て
つ
ら
い
か
ら
な
の
だ
。
そ
ん
な
こ
と
ぐ
ら
い
、
解
っ
て
く
れ
よ
、
な
。

　
　
　
　
　

よ
し
や
花
散
ら
ば
そ
れ
と
も
打
ち
わ
び
て

　
　

16　

ひ
と
り
暮
ら
せ
る
古
里
の
春

《
解�

釈
》
古
里
で
の
独
居
生
活
。
普
段
は
訪
ね
て
く
る
人
と
て
な
い
。
そ
れ
で
も
、
春
に
な
っ
て
花

が
咲
け
ば
と
期
待
し
て
い
た
が
、
や
は
り
誰
も
来
な
い
。
も
う
い
い
、
花
よ
、
も
う
散
り
た
い

な
ら
散
っ
て
く
れ
。
寂
し
く
て
な
ら
な
い
が
、
変
に
甘
い
期
待
を
し
た
私
が
悪
い
の
だ
。

　
　
　
　
　

ひ
と
り
暮
ら
せ
る
古
里
の
春

　
　

17　

霞
む
な
よ
山
に
な
ぐ
さ
む
窓
の
前

《
解�

釈
》
古
里
で
の
独
居
生
活
。
春
と
な
っ
て
も
訪
ね
て
く
る
人
と
て
な
い
。
移
り
ゆ
く
山
の
姿
を

窓
の
外
に
眺
め
て
、
寂
し
さ
を
紛
ら
わ
せ
る
。
だ
か
ら
、
霞
よ
、
山
を
立
て
隔
て
な
い
で
く
れ
。

　
　
　
　
　

霞
む
な
よ
山
に
な
ぐ
さ
む
窓
の
前

　
　

18　

消
ゆ
れ
ば
月
を
灯
の
も
と

《
解�

釈
》
窓
の
外
が
ほ
の
か
に
明
る
く
な
っ
た
。
月
が
出
た
よ
う
だ
。
灯
火
を
消
し
て
、
窓
か
ら
山

の
端
の
月
を
眺
め
や
る
。
山
家
の
生
活
は
寂
し
い
も
の
だ
が
、
こ
ん
な
所
に
慰
め
が
あ
る
の
だ
。

月
よ
、
ど
う
か
霞
ま
ず
に
澄
ん
だ
姿
を
見
せ
て
く
れ
。

※�

前
句
の
「
山
に
な
ぐ
さ
む
」
は
、
先
の
付
合
は
、「
山
を
眺
め
て
慰
む
」
こ
と
。
こ
の
付
合
で
は
「
山

の
生
活
に
お
い
て
慰
む
」
こ
と
と
さ
れ
て
い
る
と
し
て
解
釈
し
た
。
如
何
。
な
お
灯
火
を
消
す
の

は
、
室
内
の
暗
い
方
が
、
月
を
美
し
く
眺
め
ら
れ
る
か
ら
で
あ
る
。

※�

「
窓
」
に
「
灯
」
が
寄
合
。
例
は
「
梅
が
香
ふ
か
き
窓
ぞ
こ
も
れ
る
／
灯
を
暮
る
ゝ
宿
り
の
し
る

べ
に
て
」
（
宝
徳
四
年
千
句
・
第
七
「
何
木
」
一
四
／
一
五
）
な
ど
。
証
歌
は
「
こ
れ
の
み
と
と

も
な
ふ
影
も
小
夜
ふ
け
て
光
ぞ
う
す
き
窓
の
灯
火
」
（
新
勅
撰
・
一
七
‐
一
一
八
二
、
入
道
二
品

親
王
道
助
）
な
ど
。

　
　
　
　
　

消
ゆ
れ
ば
月
を
灯
の
も
と

　
　

19　

釣
船
も
心
や
や
ど
す
秋
の
海

《
解�

釈
》
漁
り
の
火
が
消
さ
れ
る
と
、
あ
た
か
も
月
が
灯
火
で
あ
る
か
の
よ
う
に
秋
の
海
を
一
面
に

照
ら
す
。
こ
の
情
景
に
は
、
釣
船
に
乗
っ
て
い
る
海
士
た
ち
も
心
を
留
め
る
こ
と
だ
ろ
う
。

　
　
　
　
　

釣
船
も
心
や
や
ど
す
秋
の
海

　
　

20　

夕
波
き
よ
く
雁
わ
た
る
空

《
解�

釈
》
秋
の
海
辺
。
夕
方
に
な
り
、
清
冽
な
波
が
打
ち
寄
せ
、
空
を
雁
が
鳴
き
つ
つ
渡
っ
て
ゆ
く
。

こ
の
情
景
に
は
、
釣
船
に
乗
っ
て
い
る
海
士
た
ち
も
心
を
留
め
る
こ
と
だ
ろ
う
。

※�

「
船
」
に
「
雁
」
が
寄
合
。
他
の
例
は
「
霧
く
ら
き
湊
に
船
や
か
ゝ
る
ら
む
／
声
ま
づ
落
つ
る
雁

の
一
つ
ら
」
（
顕
証
院
会
千
句
・
第
十
「
二
字
反
音
」
三
五
／
三
六
）
な
ど
。
「
秋
風
に
声
を
ほ
に

あ
げ
て
来
る
船
は
天
の
と
わ
た
る
雁
に
ぞ
あ
り
け
る
」
（
古
今
・
四
‐
二
一
二
、
藤
原
菅
根
朝
臣
）

の
和
歌
が
有
名
。
「
海
」
に
「
波
」
が
寄
合
で
あ
る
こ
と
は
、
指
摘
す
る
ま
で
も
な
い
。

　
　
　
　
　

夕
波
き
よ
く
雁
わ
た
る
空

　
　

21　

晴
れ
の
ぼ
る
霧
の
む
ら
芦
風
見
え
て

《
解�

釈
》
霧
が
立
ち
昇
る
に
つ
れ
て
、
下
の
方
が
次
第
に
晴
れ
、
海
辺
の
状
景
が
見
渡
さ
れ
る
。
清

32

- 3 -

宗祇独吟「小松原独吟百韻」注解

奈良工業高等専門学校　研究年報　第２号（2025）



※�

「
大
原
や
小
塩
の
山
の
小
松
原
は
や
木
高
か
れ
千
代
の
か
げ
見
む
」
（
後
撰
・
二
〇
‐
一
三
七
三
、

つ
ら
ゆ
き
）
を
本
歌
と
し
て
い
る
。

※�
『
宇
良
葉
』
に
入
集
（
二
二
一
）
、
『
自
然
斎
発
句
』
に
入
集
（
八
三
二
）
。

　
　
　
　
　

陰
涼
し
な
ほ
木
高
か
れ
小
松
原

　
　

02　

風
し
づ
か
な
る
夕
立
の
あ
と

《
解�

釈
》
暑
い
一
日
だ
っ
た
が
、
夕
立
が
通
り
過
ぎ
て
涼
し
く
な
っ
た
。
と
り
わ
け
群
生
す
る
小
松

の
原
の
木
陰
は
本
当
に
夏
を
忘
れ
る
ほ
ど
で
あ
る
。
風
は
静
か
に
樹
間
を
吹
き
す
ぎ
て
行
く
。

こ
れ
か
ら
も
、
こ
の
小
松
原
は
年
ご
と
に
木
高
く
な
り
、
涼
し
い
影
を
広
げ
る
こ
と
だ
ろ
う
。

※�

「
涼
し
」
に
「
夕
立
」
、
「
松
」
に
「
風
」
が
寄
合
。
た
だ
し
、
ど
ち
ら
も
指
摘
に
及
ば
な
い
レ
ベ

ル
で
あ
ろ
う
。
こ
の
レ
ベ
ル
の
寄
合
を
一
々
指
摘
し
て
い
て
は
キ
リ
が
な
い
。
以
後
、
寄
合
の
指

摘
は
、
必
要
と
思
わ
れ
る
範
囲
に
と
ど
め
る
。

　
　
　
　
　

風
し
づ
か
な
る
夕
立
の
あ
と

　
　

03　

待
ち
出
づ
る
外
山
の
月
に
雲
き
え
て

《
解�

釈
》
夕
立
の
あ
と
、
涼
し
い
風
が
静
か
に
吹
き
過
ぎ
て
行
く
。
待
っ
て
い
た
月
が
、
よ
う
や
く

外
山
の
向
こ
う
に
姿
を
あ
ら
わ
し
た
。
夕
立
の
雲
は
、
ど
こ
か
に
行
っ
て
し
ま
っ
た
よ
う
だ
。

　
　
　
　
　

待
ち
出
づ
る
外
山
の
月
に
雲
き
え
て

　
　

04　

深
き
峰
さ
へ
秋
ぞ
知
ら
る
ゝ

《
解�

釈
》
覆
っ
て
い
た
雲
が
消
え
、
待
っ
て
い
た
月
が
よ
う
や
く
外
山
の
向
こ
う
に
姿
を
見
せ
た
。

そ
の
月
の
光
に
照
ら
さ
れ
て
、
奥
深
い
峰
ま
で
も
秋
の
色
と
な
っ
て
い
る
こ
と
が
知
ら
れ
る
。

　
　
　
　
　

深
き
峰
さ
へ
秋
ぞ
知
ら
る
ゝ

　
　

05　

す
さ
ま
じ
き
流
れ
や
滝
の
末
な
ら
む

《
解�

釈
》
山
間
の
渓
流
。
冷
や
や
か
な
水
は
激
し
い
音
を
た
て
て
滔
々
と
流
れ
て
行
く
。
そ
の
水
の

色
と
音
に
秋
の
来
た
こ
と
が
実
感
さ
れ
る
。
こ
の
水
は
、
あ
の
奥
の
峰
の
滝
か
ら
流
れ
落
ち
て

き
た
も
の
だ
ろ
う
。
そ
こ
で
は
、
秋
が
更
に
深
く
実
感
さ
れ
る
に
違
い
な
い
。

※�

前
句
の
「
さ
へ
」
の
処
理
に
迷
っ
た
が
、
右
の
ご
と
く
で
あ
る
。
「
そ
の
上
…
ま
で
」
と
現
在
あ

る
作
用
・
状
態
の
程
度
が
加
わ
っ
た
り
、
範
囲
が
広
ま
っ
た
り
す
る
意
を
表
す
（
岩
波
古
語
辞
典
）
。

※�

第
三
句
か
ら
山
類
が
三
句
連
続
。
よ
っ
て
体
用
の
沙
汰
が
必
要
と
な
る
が
、
第
三
句
の
「
山
」
は

体
、
第
四
句
の
「
峰
」
も
体
、
第
五
句
の
「
滝
」
は
、
水
辺
と
し
て
は
体
で
あ
る
が
山
類
と
し
て

は
用
で
、
問
題
は
な
い
。

　
　
　
　
　

す
さ
ま
じ
き
流
れ
や
滝
の
末
な
ら
む

　
　

06　

音
は
埋
も
れ
ぬ
岩
の
下
水

《
解�

釈
》
滝
か
ら
流
れ
落
ち
た
水
は
、
そ
の
ま
ま
岩
の
下
を
潜
っ
て
流
れ
て
ゆ
く
。
水
流
は
一
時
的

に
視
界
か
ら
消
え
る
が
、
そ
の
音
は
、
埋
も
れ
る
こ
と
な
く
聞
こ
え
続
け
る
。

　
　
　
　
　

音
は
埋
も
れ
ぬ
岩
の
下
水

　
　

07　

降
る
も
ま
だ
凍
る
ば
か
り
の
雪
な
ら
で

《
解�

釈
》
普
段
な
ら
岩
根
の
あ
た
り
を
流
れ
て
い
る
水
が
降
る
雪
に
埋
も
れ
て
見
え
な
く
な
っ
て
い

る
。
し
か
し
、
ま
だ
そ
う
寒
く
は
な
い
の
で
、
雪
の
下
で
は
、
水
は
凍
り
つ
く
こ
と
な
く
流
れ

続
け
て
い
る
よ
う
だ
。
そ
の
音
が
聞
こ
え
る
。

※�

前
句
の
「
音
は
埋
も
れ
ぬ
」
の
「
は
」
を
、
ど
う
理
屈
づ
け
る
か
と
い
う
付
合
で
あ
る
が
、
見
事

に
処
理
し
て
い
る
。
「
岩
の
下
水
」
は
、
先
の
付
合
で
は
、
岩
の
真
下
を
滔
々
と
潜
り
流
れ
る
水
。

こ
の
付
合
で
は
、
岩
根
の
あ
た
り
を
流
れ
る
細
流
が
イ
メ
ー
ジ
さ
れ
る
。

※�

「
埋
も
る
」
に
「
雪
」
が
寄
合
。
他
の
例
は
「
つ
ひ
に
そ
の
名
の
埋
も
れ
は
て
め
や
／
通
ひ
路
の

雪
う
ら
め
し
く
立
ち
別
れ
」
（
因
幡
千
句
・
第
五
「
山
何
」
三
〇
／
三
一
）
な
ど
。

　
　
　
　
　

降
る
も
ま
だ
凍
る
ば
か
り
の
雪
な
ら
で

　
　

08　

枯
葉
ぞ
か
ゝ
る
笹
分
く
る
道

《
解�

釈
》
笹
の
群
生
を
分
け
つ
つ
道
を
行
く
。
す
ぐ
に
凍
り
つ
く
程
で
も
な
い
薄
雪
が
笹
の
葉
に
降

り
つ
も
る
。
そ
れ
は
ま
る
で
、
白
く
褪
せ
た
笹
の
枯
葉
が
落
ち
か
か
っ
て
い
る
よ
う
だ
。

※�

近
代
の
注
釈
は
こ
の
句
を
「
旅
」
と
す
る
が
、
何
か
の
カ
ン
違
い
で
あ
ろ
う
。
「
野
を
分
く
る
道
」

は
「
旅
」
で
あ
る
が
、
「
笹
分
く
る
道
」
は
「
旅
」
で
は
な
い
。
解
り
や
す
い
例
を
挙
げ
る
と
、

元
亀
二
年
千
句
・
第
一
「
何
路
」
第
一
二
句
で
「
踏
み
分
け
出
づ
る
道
の
笹
原
」
と
詠
ま
れ
た
後
、

第
一
五
句
で
「
い
づ
く
に
か
結
び
も
よ
ら
む
仮
枕
」
と
「
旅
」
が
詠
ま
れ
て
い
る
。
も
し
「
旅
」

で
あ
っ
た
な
ら
、
五
句
以
上
隔
て
ら
れ
る
は
ず
で
あ
る
。

　
　
　
　
　

枯
葉
ぞ
か
ゝ
る
笹
分
く
る
道

　
　

09　

朝
た
て
ば
風
は
袖
ふ
く
野
を
遠
み

《
解�

釈
》
朝
、
旅
の
宿
り
を
出
る
。
風
が
強
く
私
の
袖
を
翻
す
。
笹
の
群
生
を
分
け
つ
つ
行
く
と
、

風
に
煽
ら
れ
た
枯
葉
が
降
り
か
ゝ
る
。
野
の
道
は
、
遥
か
に
続
く
。

※�

前
句
の
「
枯
葉
」
は
、
先
の
付
合
で
は
笹
に
降
り
か
か
る
雪
の
こ
と
。
そ
れ
を
、
風
に
吹
き
煽
ら

れ
た
笹
の
枯
葉
と
し
た
付
合
で
あ
る
。
付
句
の
「
風
は
袖
ふ
く
」
と
い
う
表
現
か
ら
、
笹
の
枯
葉

が
吹
き
煽
ら
れ
る
様
を
想
起
で
き
る
か
ど
う
か
が
解
釈
の
ポ
イ
ン
ト
。
蛇
足
だ
が
、
笹
の
群
生
は
、

下
に
枯
葉
が
落
ち
敷
か
れ
て
い
る
も
の
。
そ
れ
が
風
で
煽
ら
れ
て
降
り
か
か
る
の
で
あ
る
。

※�

「
笹
分
く
る
」
に
「
朝
」
「
袖
」
が
寄
り
合
う
。
「
秋
の
野
に
笹
分
け
し
朝
の
袖
よ
り
も
逢
は
で
こ

し
夜
ぞ
ひ
ぢ
ま
さ
り
け
る
」
（
古
今
・
一
三
‐
六
二
二
、
な
り
ひ
ら
の
朝
臣
）
の
歌
が
有
名
。
連

歌
で
の
例
は
「
笹
分
け
く
れ
ば
霰
ち
る
音
／
し
を
れ
け
り
逢
は
で
帰
さ
の
朝
の
袖
」
（
永
原
千
句
・

第
九
「
何
袋
」
八
八
／
八
九
）
な
ど
。

　
　
　
　
　

朝
た
て
ば
風
は
袖
ふ
く
野
を
遠
み

　
　

10　

寝
し
里
い
づ
く
跡
も
知
ら
れ
ず

《
解�

釈
》
朝
、
旅
の
宿
り
を
出
て
、
遥
か
な
野
を
行
く
。
風
が
袖
を
吹
き
過
ぎ
て
行
く
。
昨
夜
寝
た

里
は
ど
の
辺
り
な
の
だ
ろ
う
か
、
も
う
判
然
と
し
な
い
。

　
　
　
　
　

寝
し
里
い
づ
く
跡
も
知
ら
れ
ず

　
　

11　

見
る
が
う
ち
に
昔
と
も
な
き
夢
さ
め
て

《
解�

釈
》
こ
の
旅
の
途
中
、
ど
こ
か
の
里
に
一
泊
し
た
夜
、
昔
自
分
が
若
か
っ
た
頃
の
夢
を
見
た
覚

え
が
あ
る
。
た
だ
途
中
で
目
が
覚
め
て
し
ま
っ
て
、
そ
こ
に
い
た
の
は
年
老
い
た
我
が
身
。
あ
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宗
祇
連
歌
中
、
中
期
の
重
要
作
品
の
一
つ
と
さ
れ
て
い
る
「
小
松
原
独
吟
百
韻
」
に
対
し
、
現

在
の
研
究
レ
ベ
ル
に
則
っ
た
新
た
な
注
解
を
施
す
。

　

本
稿
が
取
り
扱
う
連
歌
は
、
宗
祇
が
延
徳
四
年
六
月
一
日
に
独
吟
し
た
と
伝
え
ら
れ
る
も
の
で
あ

る
。
本
作
品
の
注
解
と
し
て
は
、
現
在
も
な
お
『
宗
祇
名
作
百
韻
注
釈
』
（
昭
和
六
〇
年
）
が
流
布

し
て
い
る
が
、
以
後
の
連
歌
研
究
の
進
展
の
結
果
と
し
て
、
今
で
は
さ
す
が
に
不
十
分
な
所
の
多
い

も
の
と
な
っ
て
い
る
。
本
稿
は
、
そ
れ
に
対
し
、
今
日
の
研
究
レ
ベ
ル
に
則
し
た
新
た
な
注
解
を
提

供
し
よ
う
と
す
る
も
の
で
あ
る
。

　

テ
キ
ス
ト
は
『
宗
祇
名
作
百
韻
注
釈
』
所
載
の
も
の
を
基
礎
と
し
、
諸
本
と
校
合
し
て
、
仕
立
・

付
合
・
去
嫌
の
面
で
も
っ
と
も
問
題
が
な
い
と
思
わ
れ
る
も
の
を
私
に
設
定
し
て
用
い
た
。
た
だ
し
、

紙
幅
の
都
合
上
、
そ
の
設
定
の
過
程
に
つ
い
て
具
体
的
に
述
べ
る
こ
と
は
省
略
せ
ざ
る
を
得
な
か
っ

た
。
ま
た
、
寄
合
の
指
摘
も
連
歌
の
注
解
で
は
重
要
で
あ
る
が
、
こ
れ
も
必
要
と
思
わ
れ
る
範
囲
に

と
ど
め
た
。
去
嫌
に
つ
い
て
は
、
末
尾
に
一
覧
表
の
形
で
示
す
こ
と
と
し
た
。
そ
れ
に
つ
い
て
は
、

拙
稿
「
連
歌
去
嫌
の
総
合
的
再
検
討
」
（
奈
良
工
業
高
等
専
門
学
校
「
研
究
紀
要
」
第
五
二
号
）
を

参
照
し
て
い
た
だ
き
た
い
。
ネ
ッ
ト
上
で
見
る
こ
と
が
で
き
る
。
一
覧
表
の
「
凡
例
」
も
、
そ
こ
に

譲
る
。
以
上
、
各
点
、
了
解
さ
れ
た
い
。

　

本
百
韻
に
は
、
陽
明
文
庫
に
蔵
さ
れ
る
古
注
が
一
種
存
在
し
（
宗
牧
注
と
伝
え
ら
れ
る
が
、
後
人

の
手
も
加
え
ら
れ
て
い
る
よ
う
で
あ
る
）
、
そ
れ
が
『
宗
祇
名
作
百
韻
注
釈
』
中
に
収
載
さ
れ
て
い
る
。

大
い
に
参
考
と
さ
せ
て
い
た
だ
い
た
。
学
恩
に
深
く
感
謝
す
る
も
の
で
あ
る
。

　
　
　
　
　

延
徳
四
年
六
月
一
日

　
　
　
　
　
　
　

賦
何
路
連
歌

　
　

01　

陰
涼
し
な
ほ
木
高
か
れ
小
松
原

《
解�

釈
》
夏
の
日
差
し
は
強
い
が
、
群
生
す
る
小
松
の
木
陰
に
入
る
と
涼
し
さ
が
感
じ
ら
れ
る
。
こ

れ
か
ら
も
、
こ
の
小
松
原
は
年
ご
と
に
木
高
く
な
り
、
涼
し
い
影
を
広
げ
る
こ
と
だ
ろ
う
。

※
賦
物
は
「
何
路
」
、
「
陰
」
に
よ
っ
て
「
陰
路
」
と
賦
さ
れ
て
い
る
。

※�

表
面
上
の
意
味
は
、
解
釈
の
と
お
り
。
後
援
者
で
あ
る
紀
州
・
小
松
原
館
を
本
拠
と
す
る
湯
川
氏

一
族
が
ま
す
ま
す
繁
栄
す
る
よ
う
に
と
い
う
の
が
、
こ
の
発
句
に
込
め
ら
れ
た
メ
ッ
セ
ー
ジ
で
あ

る
。
な
お
、
湯
川
氏
は
清
和
源
氏
で
甲
州
武
田
家
流
と
伝
え
ら
れ
る
。
当
時
、
紀
州
国
人
衆
の
旗

頭
的
存
在
で
、
日
高
・
牟
婁
地
方
に
勢
力
を
張
っ
た
。
小
松
原
は
そ
の
居
館
の
地
。
現
在
の
御
坊

市
湯
川
町
小
松
原
付
近
が
そ
の
故
地
と
推
定
さ
れ
て
い
る
。
こ
の
時
の
館
主
は
政
春
。
長
享
二
年

四
月
五
日
の
宗
祇
の
北
野
会
所
宗
匠
始
め
の
百
韻
「
何
路
」
等
に
一
座
し
て
い
る
。
源
政
春
の
名

で
『
新
撰
菟
玖
波
集
』
に
五
句
入
集
。
な
お
、
延
徳
四
年
に
は
、
畠
山
基
家
を
討
つ
た
め
河
内
に

在
陣
し
て
い
た
（
公
開
シ
ン
ポ
ジ
ウ
ム
「
湯
川
氏
の
城
・
館
・
城
下
町
」
発
表
資
料
集
、
一
六
ペ
ー

ジ
）
と
の
こ
と
。
東
大
国
文
学
研
究
室
本
に
「
祇
公
独
吟
湯
川
河
州
戦
場
祈
祷
」
と
あ
る
の
は
、

そ
れ
と
関
係
す
る
か
も
知
れ
な
い
。

宗
祇
「
小
松
原
独
吟
百
韻
」
の
新
注
解

勢 

田　

勝 

郭

Commentary of Komatsubaradokugin ‐ Hyakuin

Katsuhiro SETA
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